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It’s easy enough to list your expenses in a spreadsheet, use =sum(A1:A20) to see how much you spent, and add
a graph to compare your expenses. It’s also easy to use a spreadsheet to deeply analyze your numbers, assist
in research, and automate your work—but it seems a lot more tricky.

Google Sheets, the free spreadsheet companion app to Google Docs, is a great tool to start out with spreadsheets.
It’s free, easy to use, comes packed with hundreds of functions and the core tools you need, and lets you share
spreadsheets and collaborate on them with others.

But where do you start if you’ve never used a spreadsheet—or if you’re a spreadsheet professional, where do
you dig in to create advanced workflows and build macros to automate your work?

Here’s the guide for you. We’ll take you from beginner to expert, show you how to get started with spreadsheets,
create advanced spreadsheet-powered dashboard, use spreadsheets for more than numbers, build powerful
macros to automate your work, and more. You’ll also find tutorials on Google Sheets’ unique features that
are only possible in an online spreadsheet, like built-in forms and survey tools and add-ons that can pull in
research from the web or send emails right from your spreadsheet.
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Chapter 1: Google Sheets 101—The Beginner’s
Guide to Online Spreadsheets

A

GOOGLE

E SHEETS
101

Humans are great at processing images, making connections between words and concepts, and remembering
obscure trivia. But we’re bad—really bad—at mentally processing and storing accurate, easy-to-use data sets.

Data Tables—more commonly known today as spreadsheets—were invented to organize arrays of information
that our brains can’t recall. Spreadsheets help us sort and label in a way that makes sense, so we can reference
it and perform calculations later.

The practice actually dates back thousands of years, to the papyrus spreadsheets in the diary of Merrer, an
Egyptian Old Kingdom official involved in the construction of the Great Pyramid of Kufu.



https://en.wikipedia.org/wiki/Wadi_al-Jarf
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Back then, paper was one of your only options for cataloguing huge amounts of data. Now, we’'ve got
computers to do the work for us.

When VisiCalc, the first digital spreadsheet, was released in 1979, it eliminated the need to physically write
data, calculate values, and store paper spreadsheets. As our tools evolved, programs like Excel (the most
popular spreadsheet software of the last 30 years) made digital spreadsheets one of the most popular uses of
computers.

There was only one problem: these spreadsheets were tied to a single machine, which made it difficult to
share data. Plus, if your sheet was accidentally erased or lost due to computer failure, it was gone for good.
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And so, as the next evolution of the papyrus scratchpad, Google brought spreadsheets online in 2006 with
their Google Docs suite. Now in Google Sheets, you can create spreadsheets together with others online, and
crunch numbers from any internet-connected device.

Google Sheets is a spreadsheet app on steroids. It looks and functions much like any other spreadsheet tool,
but because it’s an online app, it offers much more than most spreadsheet tools. Here are some of the things
that make it so much better:

« It’s a web-based spreadsheet that you can use anywhere—no more forgetting your spreadsheet files at
home.

« It works from any device, with mobile apps for iOS and Android along with its web-based core app.

« Google Sheets is free, and it’s bundled with Google Drive, Docs, and Slides to share files, documents,
and presentations online.

« It includes almost all of the same spreadsheet functions—if you know how to use Excel, you’ll feel at
home in Google Sheets.

+ You can download add-ons, create your own, and write custom code.

« It’s online, so you can gather data with your spreadsheet automatically and do almost anything you
want, even when your spreadsheet isn’t open.

Whether you're a spreadsheet novice or an Excel veteran looking for a better way to collaborate, this book
will help you get the most out of Google Sheets. We’ll start out with the basics in this chapter—then keep
reading to learn Google Sheets’ advanced features, find its best add-ons, and learn how to build your own.

Interested in writing your own scripts for Google Sheets? We'll dig into those in chapter 8 with
tutorials on writing Google Apps Script.



https://en.wikipedia.org/wiki/VisiCalc
https://sheets.google.com/
https://zapier.com/blog/google-apps-script-tutorial/
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Getting Started with Google Sheets

The best way to learn a tool like Sheets is to dive straight in. In this chapter, you’ll learn how to:

Create a Spreadsheet and Fill It With Data
Format Data for Easy Viewing

Add, Average, and Filter Data with Formulas
Share, Protect, and Move Your Data

Common Spreadsheet Terms

To kick things off, let’s cover some spreadsheet terminology to help you understand this the terms in this

book:

Cell: A single data point or element in a spreadsheet.

Column: A vertical set of cells.

Row: A horizontal set of cells.

Range: A selection of cells extending across a row, column, or both.

Function: A built-in operation from the spreadsheet app, which can be used to calculate cell, row,
column, or range values, manipulate data, and more.

Formula: The combination of functions, cells, rows, columns, and ranges used to obtain a specific result.
Worksheet (Sheet): The named sets of rows and columns making up your spreadsheet; one spreadsheet
can have multiple sheets

Spreadsheet: The entire document containing your worksheets

Tip: If you’ve never used Google Sheets—or, especially if you’ve never used a spreadsheet before—
be sure to check out Google’s Getting Started Guide for Sheets. You may also want to bookmark
Google’s spreadsheet function list as a quick reference.

With that knowledge in hand, let’s dive in and start building our own spreadsheets.

1. Create a Spreadsheet and Fill It With Data

The best part about Google Sheets is that it’s free and it works on any device—which makes it easy to follow
along with the tutorials in this book. All you’ll need is a web browser (or the Google Sheets app on your
iOS or Android device), and a free Google account. On your Mac or PC, head over to sheets.google.com, and
you’re ready to get started.

There are 3 ways to create a new spreadsheet in Google Sheets:


https://support.google.com/docs/topic/20322
https://support.google.com/docs/table/25273?hl=en
https://www.google.com/sheets/about/#section-download
https://sheets.google.com/
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1. Click the red “NEW” button on your your Google Drive dashboard and select “Google Sheets”
2. Open the menu from within a spreadsheet and select “File > New Spreadsheet”
3. Click “Blank” or select a template on the Google Sheets homepage
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This will create a new blank spreadsheet (or a pre-populated template if you choose one of those). For this
tutorial, though, you should start with a blank spreadsheet.

The Google Sheets interface should remind you of at least one other spreadsheet app you’ve seen before, with
familiar text editing icons and tabs for extra sheets.
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https://drive.google.com
https://sheets.google.com/
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The only difference is that Google has reduced the clutter and number of displayed interface elements. So
your first task should be obvious: Add some data!

Note: Many of the images in this chapter are actually animations—be sure to check out the online
copy of this chapter to see the original GIFs.

Adding Data to Your Spreadsheet

Look around the white-and-grey grid that occupies most of your screen, and the first thing you’ll notice is a
blue outline around the selected cell or cells.

As soon as you open a new spreadsheet, if you just start typing you’ll see that your data starts populating
the selected cell immediately—usually the top left cell. There’s no need to double click cells when you add
information, and not much need to use your mouse.

Tip: An individual square in a spreadsheet is called a cell; they’re organized into rows and
columns with number and letter IDs, respectively. Each cell should contain one value, word,
or piece of data.

Feel free to select any cell you’d like, then go ahead and type something in. When you’re done entering data
into a cell, you can do one of 4 things:

. Press ENTER to save the data and move to the beginning of the next row

. Press TAB to save the data and move to the right in the same row

. Use the ARROW KEYS on your keyboard (up, down, left, and right) to move 1 cell in that direction
. Click any cell to jump directly to that cell

BN W N =

If you don’t want to type in everything manually, you can also add data to your Sheet en masse via a few
different methods:

. Copy and paste a list of text or numbers into your spreadsheet
. Copy and paste an HTML table from a website
. Import an existing spreadsheet in csv, xls, xlsx and other formats

N W N

. Copy any value in a cell across a range of cells via a click and drag

Copy & Paste is pretty self-explanatory, but there are times when you’ll try to copy a “spreadsheet-y” set of
data from a website or PDF, and it will just paste into one cell or format everything with the original styling.
Try looking for data that’s actually in an HTML table (like movie data from IMDB, for example) to avoid
getting funky pasted data in your spreadsheet.

Note: Make sure you only click once on a cell before pasting data, so Google Sheets will turn it
into a list with each item in its own cell. If you double-click on a cell, Google Sheets will paste
all the data into one cell which is likely not what you want.


https://zapier.com/learn/google-sheets/google-sheets-tutorial/
https://zapier.com/learn/google-sheets/google-sheets-tutorial/
https://support.google.com/docs/answer/40608?hl=en
http://www.imdb.com/
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If you do end up with oddly formatted data, don’t worry: we’ll fix that in the next section!

Importing a file is simple as well. You can either import directly into the current spreadsheet, create a new
spreadsheet, or replace a sheet (i.e. an individual tab) with the imported data.

The most common files you’ll import are CSV (comma separated values) or XLS and XLSX (files from
Microsoft Excel). To import a file from outside of your Google Drive, go to the FILE > IMPORT > UPLOAD
menu.
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Import file

Importing: Untitied spreadsheet - Sheat!.csv

Import action
Create new spreadsheet

(@ Insert new sheet(s)
X Replace spreadsheet
Replace current sheet
Append rows to current sheet
Replace data starting at selected cell
Separator character
@ Detect automatically
Tab
Comma

Custom:

m i

Untitied spreadsheet -...csv * =, Copy-and-paste-data-i....gif ~ 4 Show All X

I prefer to import the data into a new sheet every time to keep my old data and new imported data separate.
Alternatively, if you have a Google Sheet (or a CSV, XLS, or other spreadsheet file) saved in your Google
Drive account, you can import that directly into your spreadsheet using the same process—just search your
Drive from the import window.

Dragging to copy a cell value needs a bit of explanation, because you’ll use this one a lot once you’ve set
up formulas in your spreadsheets.

By dragging the small blue dot (pictured below) in the bottom-right corner of a highlighted cell across or
down a range of cells, you can perform a number of different functions.

— Drag this to copy a cell to
others quickly

There are a number of ways you could use this feature:

1. Copying a cell’s data to a number of neighboring cells (including formatting)

2. Copying a cell’s “Formula” to neighboring cells (this is an advanced feature, and we’ll cover it in detail
later)

3. Creating an ordered list of text data

Here’s an example of how to creating an ordered list might work: Try adding the text Contestant 1 to Cell
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A1, then clicking and dragging the little blue dot in the bottom-right corner of the highlighted cell either
down or across any number of neighboring cells.

Spreadsheet Basics Tutorial ]
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If there was no number after Contestant, this dragging action would simply copy “Contestant” to any cells
you drag over. But because the number is there, Sheets knows to increment the next cell +1.

Let’s assume that you have either copied, pasted, imported, or typed-in a good chunk of data, and that your
spreadsheet is looking pretty healthy.

Now, How can we use this data?

2. Format Data for Easy Viewing

Whether you’re tracking expenses, recording students’ grades, or keeping track of customers in a homebrew
CRM (as we’ll build in chapter 3), you’ll want to manipulate and format your data.

The basic formatting options in Google Sheets are available above your first cell. They’re labeled in the image
below, but for quick reference while you’re working on a sheet, just hover over an icon to see its description
and shortcut key.


https://zapier.com/learn/google-sheets/spreadsheet-crm/
https://zapier.com/learn/google-sheets/spreadsheet-crm/
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Copy Cell Advanced
Print  Formatting Font Settings Cell Outlines (Explained Later)
1 L I n
& o~ T s % .0 00123  Anal 1 e T S S A R T E -l coBMMY-Z
I | | — 1
Undo / Redo Format Font Styling Cell Data
Number as... Alignment

Print, Undo / Redo, and the Font Settings / Styling function similarly to what you’d expect from your favorite
word processor. The shortcut keys are the same as well, so just treat it like you're editing any other document!

As for everything else, the best way to show you how everything works is to dive right into an example.

I’'m going to create a quick list of potential breakfast options for tomorrow morning, along with their
ingredients, counts, prices, and links to YouTube videos for how to make them (who knew you could make a
3-minute video about scrambled eggs?).

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive

Spreadsheet Basics Tutorial ]
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f\
A B c D E F G
1
Ingredient List Scrambled Eggs French Toast Cereal Muffin Doughnut

2  Eggs 4 2 1 1
3 Bread 2
4 Milk 2
5 Cereal (or Flour) 2 3 3
8  Butter 1 1 2 2
7 Salt 1
8  Sugar 2 3 4
8 Total "Parts" Needed -] 7
10 Number of Ingredients 3 4 2 4 4
11 Avg Price / Serving 0.8 0.99 0.75 1 1.25
12 Tutorial Link https:/fwww.youtube.com/wal hitps://www.youtube.com/wa hittps:/iwww.youtube.comf https:/iwww.youtube.con https://www.youtube.comiwatch?v=itdza8kY0zY
13
14 . . . .
s You can easily create something like this... But let's
16 . J
" clean it up and make it awesome!

It’s functional, enough that you could use this very easily to keep track of information. In fact, a vast majority
of my own spreadsheets look like this—Google Sheets makes it so simple to capture information, share it, and
return to it later for reference that it acts as my highly-structured note-taking tool.

But let’s assume that you have to deal with dozens of spreadsheets per day (or worse, that you have to share
spreadsheets back-and-forth) and this is what someone sends you. It’s really boring, and if it was a large data
set it would be painful to skim through.

For the simple example above a lack of significant formatting is “okay.” It does the basics, storing my
information and allowing me to save it. But it’s not something I would want to come back to each day.

Since I eat breakfast every morning, let’s take some time to make this spreadsheet more user-friendly with
some formatting!
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First we’ll “Freeze” the first row in place. That means if we scroll down the spreadsheet, the first row will
still be visible, no matter how much data lies below it. This allows you to have a long list and helps to keep
tabs on what you’re actually looking at.

There are two ways to freeze rows:

1. Click VIEW > FREEZE > 1 ROW in the navigation bar to lock the first row in place
2. Hover the dark grey bar in the top left of the spreadsheet (until it becomes a hand) and drag between
rows 1 and 2

= Spreadshe‘Basics Tutorial [ ]
File Edit View Insert Format Data Add-ons Help  All changes saved in Drive
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7
Full screen
8 _ 2 3 4
9 "Harts" Needed [ 7
10 Numberf Ingredients 3 4 2 4. 4
11 Avg Pricey Serving 0.8 0.99 0.75 1 1.25

https://www.youtube.comiwa' hitps:/iwww.youtube.comiwa hitps:/iwww youtube.comi hitps:/iwww.youtube.con hitps:iwww.youtube.comiwateh?v=itdza8kY0zY

s Or grab this dark grey bar and drag it between row 1 and 2

17

Freezing my header row is the first thing I do in every sheet I make.

Now, let’s make the header text pop with some simple text formatting (remember, the text formatting tools
are in the toolbar, just above your first row):

Drag to select the cells you want to format
Bold the text

Increase font size to 12pt

Center-align the whole row

A e

Give give your cells a grey fill
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File Edit View Insert Fommat Data Tools Add-ons Help All changes saved in Drive
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The next thing I'll do to clean this up a bit is format my “Average Price / Serving” to be a dollar value. Here’s
how things look at first:
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v | Avg Price / Serving

A c D E F G

1 Scrambled Eggs French Toast Cereal Muffin Doughnut

Ingredient List
2  Eggs 4 2 1 1
3 Bread 2
4 Mik 2
5  Cereal (or Flour) 2 3 3
& Butter 1 1 2 2
7 Salt 1
8  Sugar 2 3 4
8 Total "Parts” Needed 8 7 Befo re
10 Number of Ingredients 3 4 2 4 4
11 |Avg Price / Serving 1 0.8 0.99 0.75 1 1.25 |
12 Tutorial Link https:/iwww youtube.com/wal https:www.youtube comiwa https:/fwww.youtube.comiv https:/fwww youtube.con https:/iwww.youtube.com/watch?v=itdzaBkY0zY

Now, let’s clean that up with the “Format as $” button for the specific values (or entire row) highlighted.

¢  Total "Parts" Needed 6 7

10 Number of Ingredients 3 4 2 4 4

11 |Avg Price / Serving | $0.80 $0.99 50.75 §1.00 $1.25 |

12 Tutorial Link https:/iwww youtube.com/wai https://www youtube comiwa hitps:/\www.youtube.com/w hitps://www.youtube.con hitps:/iwww.youtube.com/watch?Pv=itdza8kY0zY
13

14 -

C After Currency Formatting

You’ll see that your selected cells are now displayed as a dollar amount, rather than a regular number.

Note: if you perform this operation with the whole row / column highlighted, future values will
take the formatting as well!

Now that you’ve got the hang of inserting and formatting your data, it’s about time we start actually
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calculating some sums, averages, and more from your data!

3. Add, Average, and Filter Data with Formulas

Google Sheets, like most spreadsheet apps, has a bunch of built-in formulas for accomplishing a number of
statistical and data manipulation tasks. You can also combine formulas to create more powerful calculations
and string tasks together. And if you’re already accustomed to crunching numbers in Excel, the exact same
formulas work in Google Sheets most of the time.

For this tutorial, we’ll focus on the five most common formulas, which are shown in the formula drop down
menu from the top navigation.

Spreadsheet Basics Tutorial [ ] michael@michaelgrubbs.com ~
File Edit View Insert Format Data Tools Add-ons Help Lasteditwas yesterday at 6:39 PM \ Comment ts m
& AT 8 % o0 0123 Adal -t B ZsA. B E-f-lb- co B Y A|E-
SuM
. s ¢ e E b AVERAGE H
1 Scrambled Eggs French Toast Cereal Muffin Doughnut | COUNT

Ingredient List
Ingredient List MAX

Eggs 4 2 1
99 MIN

Bread 2
Milk 2
Cereal (or Flour) 2 3

o oe N

More functions.

You can click a formula to add it to a cell, or you can start typing any formula with a = sign in a cell followed
by the formula’s name. Sheets will auto-fill or suggest formulas based on what you type, so you don’t need
to remember every formula.

The most basic formulas in Sheets include:

« SUM: adds up a range cells (e.g. 1+2+3+4+5 = sum of 15)

« AVERAGE: finds the average of a range of cells (e.g. 1,2,3,4,5 = average of 3)

« COUNT: counts the values in a range of cells (ex: 1,blank,3,4,5 = 4 total cells with values)
« MAX: finds the highest value in a range of cells (ex: 1,2,3,4,5 = 5 is the highest)

« MIN: finds the lowest value in a range of cells (ex: 1,2,3,4,5 = 1 is the lowest)

« Basic Arithmetic: You can also perform functions like addition, subtraction, and multiplication directly
in a cell without calling a formula

We’ll explore these formulas by improving our breakfast spreadsheet.

Using the SUM Formula

Let’s start with adding up the total number of ingredients required for each recipe. I'll use the SUM formula
to add each value in the recipes and get a total amount.

There are three ways to use the basic formulas accessible via the top navigation:
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1. Select a range then click the formula (this will put the result either below or to the side of the range).

2. Select the result cell (i.e. the cell where you want the result to appear), then click on the formula you
want to use from the toolbar. Finally, select the range of cells to perform your operation on.

3. Type the formula into the result cell (don’t forget the = sign) then either manually type a range or
select the range

I’ll demonstrate all three methods in the gif below. First, I'll sum my ingredients by selecting a range, and
clicking SUM from the formula menu. Second, I'll select a result cell and highlight the range of cells to be
summed together. Finally, I will demonstrate typing a formula and range manually.

Spreadsheet Basics Tutorial |

File Edit View Insert Format Data Tools Add-ons Help Saving..

& e P s % 0 00123 Aral . 0 - B I 5 A. - M- =-1-|-+- coHmYT-Z
A B c D E F G

1 Ingredient List Scrambled Eggs French Toast Cereal Muffin Doughnut L°f:;ﬁ::t“er
2 Eggs 4 2 1 1 0.33
3 Bread 2 0.1
4 Milk 2 0.5
5  Cereal (or Flour) 2 3 3 0.2
8 Butter 1 1 2 2 0.25
7 Salt 1 0.05
8  Sugar 2 3 4 0.1
% Total "Parts” Needed

6 7 4
10 Number of Ingredients
11 | Avg Price / Serving
12
13 | |

L ]

Note: In order to select a range of cells, click the first cell and hold SHIFT then click the last cell
in the range. So if you want A1 through A10, click A1 then hold SHIFT and click A10.

When you’ve finished selecting the cells that you want to add together, press ENTER.

In my example, you see a grey help section pop up when I start typing the formula. When you create a formula
for the first time, you’ll instead notice a blue highlight and a question mark next to the cell.

You can click the question mark to toggle help context for formulas on or off. These tips will tell you what
type of information can be used in each formula, and will make your formula creation (especially when you
start combining formulas) much easier.

Now that we have a formula set up to SUM all of the ingredients together, let’s make sure that it applies to
all of the cells in that row. I'll select my formula cell and drag the blue dot across the other cells to copy the
formula to those cells.
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= Spreadsheet Basics Tutorial ]
File Edit View Insert Format Data Tools Add-ons Help  Saving.

& e o~ T § % 0 00123 Anal 5 ° - B I 5 A. ®.-MH-B8- = %'—:' By - -I-
=SUM(E 3
A ] c D E F G

1 Scrambled Eggs French Toast Cereal Muffin Doughnut

Ingredient List
2 Eggs 4 2 1 1
3 Bread 2
4 Mik 2
5  Cereal (or Flour) 2 3 k)
&  Butter 1 1 2 2
7 Salt 1
8 Sugar 2 3 4
9 Total "Parts” Needed 6

(Y

10 Number of Ingredients
11 Avg Price / Serving $0.80 $0.98 $0.75 §1.00 $1.25
12 Tutorial Link https:/iwww youtube.comiwal https:/www.youtube.comiwa hitps:/iwww.youtube.com/v https:/iwww.youtube.con hitps:iwww youtube.comiwatch?v=itdza8kY0zY

You’ll notice that when you copy the formula to a neighboring cell, it shifts the range that the new formula
is referencing. For instance, in the “Scrambled Eggs” column it was SUM(B2:B8) but in “French Toast” it’s

SUM(C2:C8).

Using the COUNT formula

Now that we know how many parts are needed for each recipe, I'd like to know how complicated it is to
make. I’'ve simplified this by assuming that fewer ingredients means that the recipe is less complicated.

In order to count the number of ingredients in each recipe, I'll use the COUNT formula.

The count formula essentially checks to see if the cells in a range are empty or not, and returns the total that

are filled.

This formula will be set up in my spreadsheet the same way as my SUM row.

All changes saved in Drive

Spreadsheet Basics Tutorial ]

e AT 0§ % 0 00 123-  Adal - 1 - B 7 5 A. ¥-{H- %v%rl—lh co B[V - X
=COUNT ()
A B8 c D E F G

1 Scrambled Eggs French Toast Cereal Muffin Doughnut k Price per Unit

Ingredient List
2 Eggs 4 2 1 1 0.33
3 | Bread 2 0.1
4 Mik 2 0.5
5 | Cereal (or Flour) 2 3 3 0.2
&  Butter 1 1 2 2 0.25
7 Salt 1 0.05
8 | Sugar 2 3 4 0.1
8  Total "Paris” Needed 6 7 4 9 10
10 Number of Ingredients =COUNT(| 3 I
11 Avg Price / Serving COUNT(valuel, [valuez, ...1)
12 Tutorial Link Example fwa hitps:/iwww.voutube.com/v hitps:/iwww.voutube.con hitps://www.youtube comiwatch?v=itdzaBkY0zY
1 COUNT(AZ2:AT8@, B2:8188)
14 Summary

Returns the a count of the number of numeric values ina
15 dataset.
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Here’s a trick we didn’t cover in the previous section, though: highlight the cell range that you’re trying
to count and checking in the bottom right corner of your spreadsheet. If you've highlighted a pure list of
numbers, Sheets will automatically SUM them for you and display the result. If you’ve highlighted a mixed
range of numbers and text, it will COUNT the values.

You also have the option to perform any of the five number-based operations on a range of numbers by
clicking the suM button in the bottom right and selecting the new default formula from the pop-out menu.
From then on, anytime you highlight a range it will perform the last-selected formula.

=] Spreadsheet Basics Tutorial | michael@michaelgnibbs com =
File Edit View Insert Format Data Tools Add-ons Help All changes saved in Drive Comments m
o T o5 % 0_ 00, 123+ Arial - 10 - B I 5 A. -H-BFH- =~ L1 | co BHm 7 -Z

4

A B ¢ ] E F (<]

1 Scrambled Eggs French Toast Cereal Muffin Doughnut Price per Unit

Ingredient List
2  Eggs 4 2 1 il 0.33
3  Bread 2 01
4 Mik 2 05
5  Cereal (or Flour) 2 3 3 0.2
&  Butter 1 1 2 2 0.25
7 Salt 1 0.05
&  Sugar 2 3 4 01
§  Total "Parts” Needed 6 7 4 9 10
10 Number of Ingredients 3 4 2 4 4
11 Avg Price / Serving
12 Tutorial Link hitps:/Awww youtube.comiwal hitps:/iwww youtube com/wa https://www.youtube.comi hitps:/www.youtube.con’ hitps:/iwww.youtube. comiwatrhu=itdznRLV V.
13 Sum: 6
i Avg: 2
15 )
18 Min: 1
17 Max: 4
Fi Count: 3

+ = Sheet1 Sheet2 Making Breakfast

v CcuntNumhers:@

So according to my spreadsheet, “Cereal” is the least complicated breakfast, but I'm still not convinced that
an easy breakfast is worth it.

What if it costs too much? What if the extra effort of cooking another meal saves me money?

Let’s refine our decision by figuring out the average cost per serving of the breakfast choices by using the
AVERAGE formula.

Using the AVERAGE formula

I've added some faux minimum and maximum prices per unit on my ingredients list to the right of my
breakfast options. We’ll want to get an average price for each ingredient using the low and high rates, then
multiply the resulting average price of the ingredient by its respective unit count in each recipe.

I'll start by highlighting the range of values (in this case it’s two side-by-side rather than a vertical range) and
selecting the AVERAGE formula from the toolbar.

This will drop the result into the column to the right of the maximum price column. Next, I drag the formula
down to apply it to the other min and max price combinations.
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File Edit View Insert Format Data Tools Add-ons Help Al changes saved in Drive

Spreadsheet Basics Tutorial |

S e T s % g 00123~ Anal - 0 - B Z 5 A. .- H-BH- =E-4-|4- coBMY-Z-
L X
0.33 SUM
A 8 c D E F _ H 1 J
1 Ingredient List Scrambled Eggs French Toast Cereal Muffin Doughnut ~ COUNT H‘“:‘::;:’;& P
MAX
2 Eggs 4 2 1 1.33 05/
MIN  d
3 Bread 2 0.1 0.2
4 Milk 2 0.5 0.75
More functions.
s Cereal (or Flour) 2 3 02 05
6  Butter 1 1 2 2 025 05
7 Salt 1 0.05 0.15
8 Sugar 2 3 4 04 02
9 Total "Parts’ Nesded 6 7 4 9 10
10 Number of Ingredients 3 4 2 4 4
11 Avg Price / Serving
12 Tutorial Link stube.com/wa' hitp outube.comiwa outube.com! outube.con hitps:/A outube v=itdzaBkY0zY

I'll label my column “Average Unit Cost” so we know what we’re looking at. Then, let’s move on to calculating
the cost of the breakfast using simple arithmetic.

Using Simple Arithmetic Formulas
We need to calculate the total cost of the breakfast by multiplying the average price of each ingredient by its
unit count in the recipe. To accomplish this, manually type a formula into the “Avg Price” row.

Our basic arithmetic formula would look like this for the “Scrambled Eggs” column:
=$12*B2+$13*B3+$14*B4+$I15*B5+$16*B6+$I7T*BT+$18*B8

The $ symbol before column I (the average prices) tells Sheets that no matter where we put the formula in our
spreadsheet, we always want to reference the I column.That way, if we copy the formula to the other recipes,
it will always use the average unit cost column rather than shifting the reference to the next column over
when you drag to copy (like it did in the SUM and COUNT examples).

Spreadsheet Basics Tutorial [ |

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive

W e oW TS %000 123~ | Adal e H F S Ao s =-4 |- BMY-=-
| =5124B2+$1 3483+ S Laws S InB5+STowsces 7w 4516488 Yol | yOU Click @ cell, it will show the underlying formula here
A B c D E F [

1 Ingredient List Scrambled Eggs French Toast Cereal Muffin Doughnut L“‘T:;:e':'ii::‘per
2 Eggs 4 2 1 1 0.33
3 Bread 2 0.1
4 Milk 2 0.5
5  Cereal (or Flour) 2 3 3 0.2
&  Butter 1 1 2 2 0.25
7 Salt 1 0.05
8  Sugar 2 3 4 0.1
¢  Total "Parts” Needed B 7 4 9 10
10 Number of Ingredients 3 4 2 4 4

11 Awg Price / Serving

52.14
L]

12 Tutorial Link https://www.youtube.comiwal hitps://www.youtube.com/wa https:/www.youtube.comi hitps://www.youtube.com hitps:/iwww.youtube.comiwatch?v=itdza8kY0zY
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If you don’t want to type those values in manually, there are cleaner ways to perform this type of formula:
You could accomplish the same price calculation by using this advanced formula:

=SUM(ARRAYFORMULA(B2:B8*$12:$18))
There are many formulas in Sheets that take care of complex tasks for you, many of which we’ll dig into in

the next chapters.

Now that we have some working data and calculations, perhaps my coworkers (who are likely planning to
eat breakfast tomorrow) might benefit from this sheet.

Let’s prepare to share our spreadsheet, and invite some collaborators to view, edit, and use our data.

4. Share, Protect, and Move Your Data

What makes Sheets so powerful is how “in sync” you’ll feel with your coworkers. Jointly editing a spreadsheet
is one of the critical functions of Sheets, and Google has made it a seamless experience.

Here’s how it works:

1. Click either FILE > SHARE or use the blue “Share” button in the top right
2. Click “advanced”, then enter emails of who can view or edit your spreadsheet
3. Select any other privacy options and hit done

Sharing settings

Link to share {only accessible by collaborators)

| dsheetsid TKyVrFelas3xasdjeDgWXyd7IJcSR1uPQSYKSAQ48AQ/ed it Pusp=sharing

Whe has access

8  Private - Only you can access Change...
ich (
! Michasl Grubbs (you) ——
y michael@michaslgrubbs.com
Invite people:
# Canedit - |

Owner seffings Leam more
Prevent editors from changing access and adding new people

Disable options to download, print, and copy for commenters and viewers




Chapter 1: Google Sheets 101—The Beginner’s Guide to Online Spreadsheets

When you open the “advanced” sharing panel, you’ll see a number of options.

Who has access to
the spreadsheet

Make it so no-one can
modify these sharing ™
settings

Sharing settings

Link to share (only accessible by collaborators;

https:i/docs.google.comiaimichaelgr cOot

Link copied to
)/clipboard by default

Whe has access

B  Private - Only you can access

Michael Grubbs (you)
michael@michaelgrubbs.com

Invite people:

\Dwncrselllngs Leam mare

Prevent editors from changing access and add

/==

/

Disable options to download, print, and copy for commenters and viewers

leDc

reetsid/1 7Ky VI

Change.

Is owner

# Canedit ~

\

ing new people

N

N\

If you're sharing your spreadsheet
publicly and don't want people copying it

Change the spreadsheet
permissions from private to
public or "only your
organization"

Change what they
can do to your
spreadsheet

18

The default functionality when you click the “Share” Button is to copy a link to the spreadsheet to your

clipboard.

When you share this link with someone via a messenger or email, if they click the link it will bring them to
the spreadsheet. However, unless you’ve invited them via email (in the email field) and selected “Can Edit”,
they will still need to request permission to make changes.

If you’d like to give anyone within your organization or company editor-level access, click the “change...”
button in the “Who has Access” section and select “On - (Your Organization Name)**”. (Note: this option will
only appear if you're using Google Apps for Work.)


https://apps.google.com/pricing.html
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Link sharing

] On - Public on the web

Anyona on the Intermet can find and access. No sign-in required.

On - Anyone with the link

A nyo n e |n yo u |" CO m pan y = Anyone who has the link can acoess. No sign-in required.

W hO Can acce SS the fOIder ' — Sr:;r?;crll:zlfurib:ia can find and access.
HY
W h ere It S Sto red can fm On- Anyone at MichaglGrubbs with the link

- Anyona al MichaalGrubbs who has the link can access
access ’ '

Off - Specific people

Shared with specific people.

Mote: ltems with any link sharing option can still be published to the web. Learn more

“ Cancel Learn more about link sharing

Someone is “In your organization” when they have an email address and Google account for your company.
In this case, I've named by “company” MichaelGrubbs, so everyone in my organization has an @michael -
grubbs.com email address and anyone signed in to one of those accounts can access the spreadsheet.

You can learn more about sharing and permissions here—you’ll want to make sure you are using
the right permissions for the audience you’re sharing with.

Sharing Spreadsheets with Your Devices and Apps

Even though Google Sheets and Drive are built for sharing between users, you’ll notice that many times your
spreadsheets are created as internal documents, and sharing is secondary to actually getting work done.

You can streamline your spreadsheet workflows and real-time data-sharing by taking advantage of these

helpful add-ons:

1. The Google Docs mobile apps. You can use the Google Sheets mobile app to view and edit your
spreadsheets, share links on the go, and add users. It’s a solid companion to—but not a replacement
for—the web app.

2. Google Drive sync to your desktop. Google Drive allows you to easily upload files from your local
desktop environment to your online Drive. This makes them accessible to your collaborators and also
allows you to quickly import them into spreadsheets and other documents.

3. A Third-Party tool like Zapier. You can use Zapier to automatically add data to your spreadsheets,
send files to your Google Drive account, alert you of change to your Sheets... you name it

Let’s continue working on our spreadsheet example to demonstrate using Zapier, an app integration tool, to
make Google Sheets even more powerful.

Rather than hitting the “Share” button on my spreadsheet to send it to my colleagues, I'd like to send a Slack
message alerting them that I've created this new spreadsheet.


https://support.google.com/drive/answer/2494886?hl=en&p=visibility_options
https://support.google.com/a/answer/6022363?hl=en
https://support.google.com/a/answer/2490101?hl=en
https://zapier.com/zapbook/google-sheets/
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You can automatically send a message to a Slack channel with Zapier’s Google Sheets Trigger and Slack
Action.

Zapier Integration:
« Share new Google Sheets spreadsheets to Slack

I’ve set my Zap up to look for new Spreadsheets in my Google Drive then post the file name and a link to the
spreadsheet in a Slack Channel.

Google -l v 0@ Michael Grubbs testfeed 1 @ Qsea @ % -
& Drive My Drive > Zapier v Q = iz @ & CHANNELS
general
random
» B3 MyDrive Za
2% Shared vithme == s T DIRECT M
2 lackb
% Google Photos T
©  Recent s There e
& sired E—-»- = , . + Invite People
W Trash
28 MB of 30 GB used
= Upgrade storage #testfeed
This is the very beginning of the #testfeed channel, which you
created today. The purpose of this channel is: Send any and all
automated tests from integrations! (edit).
+ Add aservice integration & Invite others to this channel
Zapier monitors my Google Drive for new
Spreadsheets Today
" Sheets Bot
If a new spreadsheet is found, it posts the W& Michael has created a new Sp named " Basics
Tutorial” - Click here to edit:
custom message to Slack! hitps://docs google.com/a/michaelgrubbs.com/spreadsheets/d/17KyViF
elas3xas4jeDaWXyd71JcSR 1uPQSYK5AQ49AQ/edit?usp=drivesdk

This is great for updating your team when you create new documents that you’d like to quickly loop everyone
in on.

You can set up filters and conditions to decide when to post, and you have complete control over what
information you’d like to include in your message. You can also trigger messages based on different actions
in Google Sheets—like when someone a new row or changes the data in a cell. Check out the Zapier’s Google
Sheets page for more information on supported data and triggers.

Now let’s switch the direction of the data-flow and consider how our colleagues would interact with our
Spreadsheet.

I’d like to allow myself and my team to interact with my spreadsheet and keep track of what they had for
breakfast in a breakfast log. Without an automation tool like Zapier, tasks like this quickly become the reason
that people fail to collaborate successfully using spreadsheets.

Think about it, if this were a normal spreadsheet without any automation, you’d be asking someone to:

1. Break out of their current activity

2. Track down the spreadsheet

3. Fill in a few pieces of potentially inconsequential data

4. Save and re-share this file (if it’s not already an online and synced document)


https://zapier.com/zapbook/google-sheets/
https://zapier.com/zapbook/slack/
https://zapier.com/zapbook/slack/
https://zapier.com/app/min/9367/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/zapbook/google-sheets
https://zapier.com/zapbook/google-sheets
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5. Repeat for any number of tasks / documents

This is where automating tasks becomes so vital.

Let’s set up our spreadsheet so that it has a clean sheet to receive some automated data. I'll create a new
worksheet using the + button in the bottom left.

Spreadsheet Basics Tutorial [ ] michael@michasigrubbs.com ~

File Edit View Inset Format Data Tools Add-ons Help  Saving. ‘Commants.
& oo~ P s % 0 00123 Adal - w . B I EA. B-H- E.l.|4- coEHMY- X
A B c o E F e H J K L M N
1 Iii
2
3
4
5
8
7
e
s
0
11
12
13
14
15
16
4+ = Making Breakfast Breakfast Log

Now, I’ll use Zapier again and make Slack the triggering action with Google Sheets on the receiving end of
the automation (the “Action” side of the Zap).

Zapier Integration:
+ Add Slack messages to a Google Sheets spreadsheet

I've set up my Zap to instantly take a Slack message posted into a dedicated channel and create a new row in
the breakfast log along with the time and user who posted it.

Spreadsheet Basics Tutorial ] : 5
= ftzapier 10 @ W% -

File Edit View Inset Format Data Tools Add-ons Help Al changes saved in Drive

S e~ T s % 0 00123 Adal - w0 - B I SsA_ ._@- More -

A a c o 2
Person Breakfast Timestamp

N ] # zapier
3 micheel Scrambled Eggs 1449197844
4 michael French Toast 1448197847
5 michael Cereal 1449197850
¢ michael OMG THIS IS GOOL 1449197855
2
s T vet
2 TG peiehs
® Invite People #zapler

This is the very beginning of the #zapier channel, which you created
today.

& Setapurpose  + Add a serviceir n & Invite others to this channel

Today

H michael

michael

Scrambled Eggs
French Toast

Cereal

OMG THISISCOGL

+ = |Breadastlog - | Making Breakfost



https://zapier.com/app/min/9368/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
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And this can work for hundreds of other applications that you can use as Triggers or Actions with Zapier.
You can send information to your spreadsheet via email, monitor your social channels, set it on a schedule;
there are dozens of different ways to accomplish any given task with the apps you’re already using.

Zapier Integrations:

« Save new Typeform entries to a Google Sheets spreadsheet

« Save Gmail emails matching certain traits to a Google Spreadsheet
+ Save Twitter mentions to a Google Sheets spreadsheet

+ Add new FullContact business cards to a Google Sheets spreadsheet

Downloading Your Data

If you need to send your files to external collaborators, upload a file into another system, or just like having
backups for posterity, then turn towards one of Google Sheets’ many data export options.

= Spreadsheet Basics Tutorial ]
File Edit View Inset Format Data Tools Add-ons Help  All changes saved in Drive

Share... il - 10 - B I S5 A. %.@- = L|3|=IDEIEIYZ
New *
c o E F G
Open... #®O
Rename... Timestamp
2 Make a copy..
3 |y [l Move to folder... 1449167844
4 1@ Move totrash 1449197847
5 r 1449197850

Import...

1449197855
! See revision history #+Option+Shift+G

8 Spreadshest settings...

10 Download as v Microsoft Excel (.xlsx)

n Publish to the web... OpenDocument format (.ods)

Email collaborators. PDF document {.pdf)

14 Email as attachment... Comma-separated values (.csv, current sheet)

15 & Print sep Tab-separated values (.tsv, current sheet)

Web page (.zip)

The most common exports will be either .xls (Excel document) or .csv (comma-separated values). If you’re
not sure which format to use, a .csv is usually the best bet.

Use Your Spreadsheet in Offline Mode

If you love what you’ve seen so far but were worried that you wouldn’t be able to use Sheets without a
connection, then fear not. Google Sheets has an “Offline Mode” that will automatically sync your changes
to the document when you reconnect to the internet.

This is useful for any situation where you’d need to treat Google Sheets like a desktop application—on a flight
or a road trip, for example.

Here’s what you’ll need:


https://zapier.com/zapbook/apps/
https://zapier.com/app/min/111/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/2618/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/135/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/1884/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
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1. Google Chrome
2. Google Drive Chrome Web App
3. Google Drive Sync

Instructions for setting up your offline sync are really straight-forward, but the bulk of the process is just
downloading and using the three core components above.

Actually turning it on looks like this (get ready to be amazed):

Settings

Language
English

Always show right-to-left controls

Offline sync
Ti on offline sync so that you can edit while offline

And just like that, you can use Google Sheets even when you’re offline—no WiFi necessary.

Note: For more tips on using Google Sheets offline, jump to the end of chapter 6.

That's All For Now

You’ve done it: you learned how to make new spreadsheets, add data and format it, use formulas to calculate
values, share your spreadsheet, and collaborate on it with others.

Google Sheets is a powerful tool—it’s everything you’d expect from a spreadsheet, with the extra perks of an
online app. While the example spreadsheet that we created may have been a bit silly, the practical applications
of using Sheets for your workflows (both business and personal) are limitless.

Whether you need to make a budget, outline your next proposal, gather data for a research project, or log
info from any other app that connects with Zapier, a Google Sheets spreadsheet can bring your data to life.


https://www.google.com/chrome/
https://chrome.google.com/webstore/detail/google-drive/apdfllckaahabafndbhieahigkjlhalf
https://www.google.com/drive/download/
https://support.google.com/drive/answer/2375012?hl=en
https://zapier.com/learn/google-sheets/best-google-sheets-addons/
https://zapier.com
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And with everything stored in Google Drive, you’ll never worry about losing your files again—even if your
computer dies.

Now that you know how to make a spreadsheet, it’s time to fill your spreadsheet with data. The best way to
do that in an online spreadsheet is with a form—and in chapter 2, we’ll look at the free Google Forms tool
that can help you gather data and save it directly to your spreadsheet.

Enjoy? Read and share this chapter online: zpr.io/uB9n

Written by freelance writer Michael Grubbs.

Image Credit: AP Photo/Egypt’s Supreme Council of Antiquities


https://zapier.com/learn/google-sheets/how-to-use-google-forms
http://zpr.io/uB9n
https://twitter.com/MichaelDGrubbs

Chapter 2: Google Forms Guide—Everything
You Need to Make Great Forms for Free

Forms are among the internet’s most versatile tools. Whether you need a contact form or a checkout page, a
survey or a student directory, a form is all you need to easily gather that information. With Google Forms, it
only takes a few minutes to make one for free.

Google Forms—along with Docs, Sheets, and Slides—is part of Google’s online apps suite of tools to help you
get more done in your browser for free. It’s easy to use and one of the simplest ways to save data directly to
a spreadsheet, and it’s the best sidekick to Google Sheets’ spreadsheets.

When you need to gather data for your spreadsheets, a form is your best friend. In this chapter, let’s take an
in-depth look at Google Forms’ features, hidden tools, and add-ons to help you make the forms you need in
minutes.

Tip: Want a handy reference of the Google Forms tips from this chapter? You can download a
copy of it for free from our site.

25


https://zapier.com/zapbook/google-forms/review
https://zapier.com/zapbook/learn/google-sheets
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A Tour of Google Forms

Start a new form

_|_

Event Registration Order Form Job Application

Recent forms Owned by anyone =

Stuff and other stuff Event Registration Quiz Untitled Form
B Opened 2:53 PM B Opened 3:52 PM B Opened 2:57 PM i=] Opened 2:41 PM

Google Forms started life as a Google Sheets feature in 2008, two years after Sheets’ original launch. You could
add a form to a spreadsheet, format it in a separate sheet, and see your form responses in another sheet. It
was basic, but it got the job done.

Google added more features to Forms over time, then finally turned it into its own standalone app in early
2016. Today you can make and manage forms at docs.google.com/forms, with templates and quick access to
all your forms in one place.


http://googlesystem.blogspot.com/2008/02/add-data-to-google-spreadsheets-using.html
http://googleappsupdates.blogspot.com/2016/02/new-google-forms-now-default-option.html
http://googleappsupdates.blogspot.com/2016/02/new-google-forms-now-default-option.html
https://docs.google.com/forms/
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Event Registration

QUESTIONS RESPONSES

Event registration

Event Timing: January 4th-6th, 2016
Event Address: 123 Your Street Your City, ST 12345
Contact us at (123) 456-7890 or no_reply@example.com

Name = Short answer
Tr
Short answer text
L]
o
|—D (] Required . —

Email *

(]

Google Forms is now a full-featured forms tool that comes free with your Google account. You can add
standard question types, drag-and-drop questions in the order you like, customize the form with simple photo
or color themes, and gather responses in Forms or save them to a Google Sheets spreadsheet.

Let’s start out by making a quick contact form so you can see how easy it is to use.

Building Your First Google Form

Testsheet [ |
File Edit View Insert Format Data Tools Form Add-ons Help Last edit was yesterday at 3:08 PM
e o R TR e .0_ -00 123~ Create a form B 7 5 iv & - H -
fx .
Script editor...
A B E F G
1 |:|Name Spelling... or: Pricing from: Centralized Da
2
3 | Task Lists v" Enable autocomplete
4 KA ADD:ASANE  \okeeok e S $5/mo./user |V
5 @ App: DAPUL ogress wil $25/mo. for 5 ug v
Protect sheet...
6 s App: INSIGF s $12/mo.user ¥
7 @ App: TOODLEDC Outline everythi « private tasks ' $14.99/yr./user |

The simplest way to start building a form is right from the Google Forms app. Go to docs.google.com/forms,
then either choose a template or start a blank form.

There’s also a link to Google Forms in Docs, Sheets, and Slides: click File -> New -> Form to start a new


https://docs.google.com/forms/

Chapter 2: Google Forms Guide—Everything You Need to Make Great Forms for Free 28

blank form. Or, in Google Sheets, click Tools -> Create a Form to start a blank new form that’s automatically
linked to that spreadsheet. That’s the quickest way to get data into a new or existing spreadsheet: open the
spreadsheet where you want the data, start a form, and the form responses will automatically be saved there
without any extra clicks.

< Untitled form

QUESTIONS RESPONSES

Untitled form

Form description

Untitled Question (® Muttiple choice
Tr
Option 1
L]
Add option or ADD "OTHER" D
-
-
rD i Required

e

The Forms editor is straightforward. Your form fills the center of the screen, with space for a title and
description followed by form fields. Click a form field to edit it and add a question. Use the dropdown box
next to the field to choose the field type, such as multiple choice, checkboxes, short answer, and so on.

Google Forms offers several settings options. The floating toolbar on the right lets you add more form fields.
On the top right menu you can change the form’s color scheme, preview the form, use the Send button to share
the form, and access other extra options, including installing add-ons for Forms. Switch from the Questions
tab to the Responses tab in your form editor to see current responses to your form and link it to a spreadsheet.

All you need to do is add your questions and send the form out, so let’s look at the form options and what
you can do with each.
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Google Forms Field Options

QUESTIONS RESPONSES

Short answer

Paragraph

©

Multiple choice

Untitled Question

8 @®
5

Option 1 Checkboxes

) Dropdown
Add option or ADD "OTHER"

!

Linear scale

0

@ Multiple choice grid

(3 Date

Option 1
@ Time

Google Forms includes 12 field types: 9 question types, along with text, photo, and video fields. Just click the
+ icon in the right sidebar to add a new question, or click the text, photo, or video icons to add media to your
form.

Each field includes a copy button to duplicate the field, for a simple way to add similar questions to your
form. There’s also a delete button, options to make the field required, and a menu with extra options on the
right side. You can switch question types at any time, though do note that your field settings and questions
will reset if you switch from multiple choice, checkbox, or menu to any of the other question types. And, to
quickly fill in questions in fields, just press enter to start adding another one.

Quick Tip: Accidentally remove a form element or add one too many? Just tap CMD + Z or Ctrl
+ Z to undo, just as you would in a document.

Here’s what each field type offers:
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A TSR\ N =z P WY e T
! QUESTIONS rResponses (Rl

-~

Workgroup Feedback

The following 10 questions are to help us continue to improve our courses and workgroups. To refresh your memory about
our automation training, be sure to check the Zapier Learning Center first: zapier.com/learn.

-
T
Thanks for being part of our workgroup this week! E
[ > ]
-
—

Title and Description: The title and description fields are added automatically to every form and field—
though the description is hidden by default on most fields—and you can add an extra title block anywhere
with the Tt button. You can leave the title and description blank on questions, but the main form title must
be filled in.

The description doesn’t include formatting options—though you can include links (in shortened format, like
zapier.com, or as the full length style like https://zapier.com/), and form readers can click those to see
your site or related material.

©

What's your email address? = Shortanswer
T
Text Contains u
Doesn't contain =
Email address I_D -i Required .
ui ) H
URL

Short Answer: This field is perfect for asking for small bits of text: names, email addresses, values, and more.
You get one line of text to answer the question—though your users could actually enter as much text as they
want.

To make sure you get the answers you need, this field includes number, text, length, and regular expression
data validations. Number validations help you watch for ranges of values, while text validations are perfect
to watch for email addresses or links.

Paragraph: Much the same as the short answer field, this is a field for text—long-form text. Length and regular
expression are the only data validations available here, so only use it when you want detailed feedback or
longer notes in the answer.
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©

What's your favorite notes app? @® Multiple choice
T
Evernote
M
OneNote u
|
Apple Notes -

Add option or ADD "OTHER"

O ® Required :

Multiple Choice: The default field for new questions in a Google Form, multiple choice lets you list options
and have users select one. You can then have the form jump to another section based on the answer or have
the answer options shuffled to prevent bias.

Checkboxes: Similar to multiple choice, this field lets you list answers and have users select as many as they
want. It also includes data validation to require users to select a specific number of options. It doesn’t include
section jumps, however.

Dropdown: Want all of the answer options in a menu? This field’s for you. It’s the exact same as the multiple
choice field—with the same section jump and shuffle options—only this time the answers are in a menu. This
is useful for keeping your form compact when there are many answer options.
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How much do you like Zapier === Linear scale
Tr
]
>
]
L]

1 to 5
1 2
5 @
I_|:| (] Required | :

Linear Scale: The field to let people select a number in a range, linear scale lets you set a scale from 0 or 1 to
2-10 with labels for the lowest and highest options. And yes, emoji work for labels, too.

©

What are your thoughts on the following items? BH Multiple choice grid
Tr
Row 1. iPhone Column 1. Hate it !
Row 2. Tesla Model S Column2. It's ok o
-
Row 3. Zapier Column 3. Love it -
Row 4. Milk| Column 4. Add option

Row 5. Add option

|_|:| [] Require one response per row :

Multiple Choice Grid: This is perhaps the most confusing field, as the fields are displayed in a list rather than
in the grid as they’ll appear to readers. Essentially, you’ll add questions as rows, and options about them as
columns.

You can include as many rows and columns as you want, though do note that readers will have to scroll right
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to see more than 6 columns on desktop browsers or just 3 columns on mobile. You might want to keep the
form preview open while setting up grid questions—just tap the eye icon on the top right, and refresh that
page to see your changes.

Also, in addition to the standard option to require responses, the grid lets you require a response per row and
can also limit users to only one response per column.

©

When would you like to visit the White House? (5] Date .
T

B s

h o

]

|

I_D i Required S

Date: Want to ask for a specific date or time, perhaps to schedule an event or log an activity? The date field
is the one you want to select. It can ask for a date and month and, optionally, the year and time as well.

Do note that the date format will be shown in the default format for your location. If your Google Account is
set to US English locale, dates will be formatted as MM/DD/YYYY; UK English accounts, on the other hand,
will show dates as DD/MM/YYYY. Your users will see the date options in your locale’s date format, unless
they’re logged into their Google Account, so be sure to keep that in mind when creating forms.

Tip: You can change your Google Account locale along with your account language at myac-
count.google.com/language.

Time: Time lets you request a length of time in hours, minutes, and (optionally) seconds, for a way to log
how long an activity took.


https://myaccount.google.com/language
https://myaccount.google.com/language
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< Untitled form  aiichanges saved in Drive

Insert image

Upload Take a snapshot By URL I Your albums Google Drive Search

Google ~  london Q

ayee - [P EEEE ]

Results shown are labeled for commercial reuse with modification. Learn more

Cancel Only select images that you have confirmed that you have the license to use.

(2]

Image: Google Forms lets you upload an image, insert one from a link or Google Drive, or take a photo
from your own webcam (as long as you have Flash installed). Or, you can search Google Images for photos,
including royalty free stock photo and images from LIFE that are licensed to use inside Google Drive.

Video: Google Forms only supports YouTube videos, which you can add either through search or with a link.

Whether you’ve added images or videos, your form entry will have the standard title and description, along
with options to resize and show the video or image centered, left, or right aligned.

With the questions out of the way, let’s pull them together and make a complete form with sections and logic
to route users to the correct questions.
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Form Sections and Logic

Gluten-free

After section 1 Continue to next section

Go to section 1 (Event registration)

P v
Sectiol Go to section 2 (Untitled Section) A 0
U Submit form Tr
nt m
>
-
—]

Simple contact forms only need a few fields, but longer surveys can quickly get overwhelming with dozens
of questions on one page. That’s where sections come in handy: They let you break your form up into chunks
to answer one set of questions at a time.

Just click the last button the right toolbar to add a section below the current question. Each section includes
its own title and description, along with an arrow button at the top to show or hide questions and keep your
form editor tidy.

You can drag-and-drop questions between sections, but you can’t rearrange full sections. You could, instead,
move the questions out and then delete that section. Or, if you want to reuse a section, just click the section’s
menu and select Duplicate section for another copy of those questions.
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©

Dietary restrictions @® Multiple choice
Tr

None Continue to next section !
Vegetarian Continue to next section [ » ]

Go to section 1 (Event registration) =
Vegan

Go to section 2 (Untitled Section)
Kosher

Submit form
Gluten-free

Add option or ADD "OTHER"

|_|:| [] Required . :

After section T Continue to next section

That’s a perfect way to start a form with logic jumps. Say you want to ask some a respondent followup
questions based on their answer—perhaps to ask which meat an event attendee wants, but only if they’re not
vegetarian.

Just add sections with the optional questions, and then either add a section jump to the individual multiple
choice, checkbox, or menu questions, or to the section itself. Make sure to think through where people who
shouldn’t see those questions are sent, too, perhaps with alternate questions in a separate section. Or, you can
send them straight to the end of the form to submit their answers, if there’s nothing else to ask.

Be creative: Form sections and jumps let you turn your form into a mini-app, and they can be a great way to
condense detailed surveys down into only the most important questions for each person.

Quick Tip: Be sure to not select your current section’s name, or you’ll end up making a loop
where respondents can never get to the end of your form.


https://zapier.com/learn/ultimate-guide-to-forms-and-surveys/simple-database-app-builders/
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Build a Quiz

Settings
QUIZZES

. Make this a quiz
Assign point values to questions and allow auto-grading.

Quiz options

Release Grade:

@ Immediately after each submission

O Later, after manual review
Sending grades to respondents requires email addresses. To collect emails,
restrict to Zapier users in the "General" tab.

Respondent can see:

Missed questions @)

Correct answers @)

Point values @)

CANCEL SAVE

Another way to make an interactive form is with Google Forms’ Quiz mode. Inside your form settings, you’ll
find a Quizzes tab. Select Make this a quiz, and then choose whether to show the results immediately after
the form is submitted or later once you review the answers. If you choose the latter, your form will need to
require respondents to sign in with their Google account.

You can then choose to show missed and correct answers, as well as a value for each option if you’d like.


https://docs.googleblog.com/2016/06/give-feedback-faster-with-quizzes-in.html
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Choose correct answers: o
Tr
. . o
What's the square root of 4 4 = points
]
[
[ |
®?2 v
3
4
8
16
Jl ADD ANSWER FEEDBACK
2 EDIT QUESTION

With that enabled, you’ll see a new Answer Key button on the bottom left of each question. Click it, then select
the correct answer for the question. You can optionally add answer feedback both for correct and incorrect
answers, with a link for respondents to view more info if you’d like.

Note: Quizzes only work with multiple choice, checkbox, and drop-down questions.
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Design Your Form

< Event Regis‘tra‘tion All changes saved in Drive

QUESTIONS RESPONSES

Event registration C W) o
Event Timing: January 4th-6th, 2016

Event Address: 123 Your Street Your City, ST 12345 . ‘ . @
Contact us at (123) 456-7890 or no_reply@example.com

Name *
Short answer text
Email *
Tr
Short answer text !

There’s one spot where you don’t have much option: your form’s design. Google forms include a header color
or image, along with lighter accent color as the background. By default, new forms come in purple, while
template forms often include an image.

Click the color palette icon in the top right to tweak your design, if only a little. You can choose from 15 colors,
each a darker color for the header with a complimentary background shade.
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Select Theme x

I Work and School
lllustrations
Birthday
Food and dining
Party
Just kids
Wedding
Night out
Sports and games
Travel

Other

Upload photos

Your albums [Ty PR RN ST R BT P 1 ]

m ca nce'

CTYUT ST roTT

Click the photo icon to select a photo or Google Doodle-style drawing from Google’s library as your form’s
header photo. Or, select one of your photos from Google Drive or upload a new one and crop it to fit in as a
form header. Forms will then automatically select a background color that matches your photo.

Some of the included header images are animated GIFs with burning candles, moving balls, and more.
Unfortunately, if you add them to your form, they appear as a standard still image. Perhaps in the future
Google Forms will get GIF support—for now, images and colors are the only design options in Forms.

Note: If you add your own photo as a header, Google will only saved the cropped version of it
to Drive.
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Store Form Responses in a Spreadsheet

(2 responses)
Jan1,2016 1:01 AM
Mar 3,2016 3:03 AM

What's your favorite name for random things? (7 responses)

@ bob

42.9% @ stuff
Thing 1

i

@ Option 1

42.9% @

Once you've created the form, you don’t need to do anything extra to store respondents’ answers in Google
Forms. By default, it’ll save each answer in the Responses tab, showing summary graphs and lists of answers.
An individual response view shows the live form along with the results from each respondent.

That’s great for quick form results, but for more tools to analyze answers, you can link your form to a Google
Sheets spreadsheet. Just click the green Sheets icon in the Responses tab or click Select Response Destination
in the menu, then create a new spreadsheet or select an existing one to store the answers.

Note: You can store results from multiple forms in one spreadsheet; each form’s responses will be
saved to a separate sheet. You cannot, however, save multiple forms’ responses to a single sheet.
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Contact Form Responses il e R pece. =
Fie Edit View Insed Formal Data Tools Fg Comments .
&/ o P s % o0 00 123- A - More -
A 8 e o
1 Timestamp Email Message
2 6/24/2016 18:00:37 bob@techinch com Hi
3
]
4
Contact Form :
L]
Your response has been recorded. 7
L}
9
Submit another responsa )
"
12
13
~ 1s
This form was created using Google Farms. Create your own by
15
16
7
18
9
o0
2
z
+ = Form Respont
 Waiting for docs.google.com... L

One great thing about saving Google Forms entries to a Google Sheets spreadsheet: It’s fast. Change your
form field names, and they’re automatically updated in your spreadsheet. Get a new entry, and it’ll show up
in the spreadsheet as soon as your recipient clicks Submit.

Note: You can change form questions and answer options at any time, but if you do, it won’t
change entries that have already been added to your spreadsheet.

Google Forms always keeps a full copy of all your form data, so if you accidentally delete something from
your spreadsheet, don’t worry. Just open your Form response settings and unlink it from your spreadsheet, or
click Form -> Unlink Form inside your spreadsheet. Then, reconnect the form to your spreadsheet, and Google
Forms will add all the form data back to a new sheet.
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= Contact Form Responses [} matthew.guay@zpier.corm ~
File Edit View Insert Format Data Tools Form Add-ons Help All changes saved in Drive Comments
Epnm-.—' $ % .0_ .00 123- Arial - 10 0 P D N N - 2 P More -~
A ‘ ' G
t  Timestamp ‘ Set notification rules .
2 6/24/2016 18:0
3 Help
4 Notify me at matthew.guay@zapier.com when...
5 Any changes are made
6
® A user submits a form
7
8 Notify me with...
9

(®) Email - daily digest

Email - right away

With your form data in the spreadsheet, you can use Google Sheets’ formulas to calculate values or make
custom graphs to visualize your data. Add conditional formatting to the spreadsheet, and you’ll be able to see
patterns in your form responses at a glance.

There’s one other handy extra with Sheets: notifications. Google Forms by default can email you whenever
the form is filled out, but click Tools -> Notification Rules in Google sheets for more detailed options. There,
you can choose to get emailed just once a day with a summary of all responses or whenever changes are made
to a form entry.

Tip: For more features, you can add Google Sheets add-ons to include formulas in survey
responses, send customized notifications, and more. We’ll look at those in-depth in chapter 6.

Share Your Form

You’ve made a form, and now it’s time to share it with the world and get responses to your questions. Or
perhaps you want to get feedback from your team on your form. Either way, here’s what you need to do in
Google Forms.


https://support.google.com/docs/answer/46977
https://support.google.com/docs/answer/190718?hl=en
https://support.google.com/docs/answer/190718?hl=en
https://support.google.com/docs/answer/78413
https://zapier.com/learn/google-sheets/best-google-sheets-addons/#forms
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Collaborate on Forms

Sharing settings

Link to share (allows editing)
hitps://docs.google.com/forms/d/1hAQ92tU_-rVSuzsRFUCatZJjQMhJQBXoLNra7Tk?

Note: editors will be able to view and delete form responses

| Who has access

cé: Anyone who has the link can edit Change..
[ = Matthew Guay (you) I owner
-ﬂi matthew.guay@azapier.com
Invite people:
# Can edit ~

Owner seftings Learn more
Prevent editors from changing access and adding new people

One of Google Forms’ best features is that you can share the core form with others to let them help you
build and edit the form. The same sharing features you’d expect in Google Docs and Sheets are included with

Forms.

Just open the Forms menu and select Add Collaborators, then enter individual collaborators’ email addresses.
Or click the Change... link to make the form public to the web or just inside your organization.

Tip: Want to make your own form template? Just make a form, then click the form’s menu and
select Make a copy. Or share your original form, and then everyone with the link can make their
own copy—an easy way to make shared team template forms.
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Form Sharing Settings

Settings
Anyone

Anyone in Zapier

D Automatically collect respondent's Zapier username

D Can submit only 1 response (requires login)

Confirmation page

Message for respondents:

We have received your registration.
Insert other information here.

Save the link below, which can be used to edit your
registration up until the registration closing date.

CANCEL SAVE

Once your form is finished, be sure to check the form settings before sharing it with the world. Click the gear
icon to open the settings, where you can add a confirmation page to your form. This works the same as the
form description field with no formatting but support for links.

You can also choose to share the form either only inside your organization or publicly with anyone who has
the link. There are also options to collect their username (their Google Apps email address) or only allow one
response (which requires respondents to log into their Google account).

In the response options, you can let users submit another response, edit their responses, or see a summary of
all responses. You can also have Google show a progress bar based on the number of completed sections or
shuffle the question order.
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A 31 “‘-JJ Event registration

Event Timing: January 4th-6th, 2016
Event Address: 123 Your Street Your City, ST 12345
Contact us at (123) 456-7890 or no_reply@example.com

*uilu

Name *

ANMBLPDIAM

Email *

ANMBLPDIAM

viwdesiarnulu Google Wasu

There’s one more thing to note: language. Google will show the form’s interface in the default language for
your recipients’ location. If your readers are in Japan, say, and your form questions are in English, the UI text
like Required and Submit will be in Japanese while your questions are in English. If that’s an issue, you can
add a note to the beginning of your form to remind people to set their Google language from google. com first.

Share Finished Forms Online

Send form

Automatically collect respondent's Zapier username

Send via

Email

Subject

Message

[:] Include form in email

Add collaborators CANCEL SEND
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Read to get responses to your form? Just click the Send button in the top right to share the form via email or
social networks, copy a link to the form, or get an embed code to add it to your site.

With the link, you can either copy a full-length link or get a shortened goo.gl/forms/ link to share more
easily on social networks. The embed option includes width and height options to fit the form within your
site’s design.

Mail - - a 0 [ ] .- ¥- More ~ 101 B ov Q-

< e GOOg|e Forms Related Google+ Page
I Inbox Zapier
Starred Having trouble viewing or submitting this form? Ll

Important
FILL OUT IN GOOGLE FORMS
Sent Mail

Drafts
[Gmail]Trash I've invited you to fill out a form:
Finance
Notes Event registration
+ Personal Event Timing: January 4th-6th, 2016

Event Address: 123 Your Street Your City, ST 12345
Contact us at (123) 456-7890 or no_reply@example.com

Techinch
Testing Accounts

+ Work Name *

More ~

Email *

Organization * I

Sharing the form via email includes an extra option: including the form in the email. This copies your actual
form options into the email, and if your recipient uses Gmail, they can fill out the form inside their Gmail
inbox, click Submit, and send in their answer without ever seeing your real form. That only works in Gmail,
though—Apple Mail shows the form fields but doesn’t send the answers to Google Forms, while Outlook.com
can’t even open the form—so you might want to include a note with your form for non-Gmail users.
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Share Pre-filled Form

Workgroup Feedback

What is your name?

How do you like our products?

Disike Ok Love

Soap O ® ©)
Towels @® O O
Bedding O O @

Want to get feedback with a form partly filled in? Perhaps a contact clicks a button on your site that says they
dislike one product, so you want the survey form to reflect that automatically. Or maybe you have a form
that needs to be filled out with similar info each week, and you don’t want to re-type it.

For cases like these, click the Get pre-filled link option in the Forms menu, then fill in the options you want
on the form. Click Submit at the end, and Google will give you a unique link to share that copy of the form
with the answers pre-filled.
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Print

Total: 1 sheet of paper

Cancel

o

Photosmart 5510 series

Destination HP Photosmart 55
Change...

Pages e All

Copies 1 +

Layout Portrait

Color Color

Options Simplify page

Share Paper or PDF Form

What is your name?

1. How do you like our products?
Mark only one oval per row.

Dislike Ok Love

Soap
Towels
Bedding
Hats

2. What's your favorite name for random things?
Mark only one oval.

) bob

) stuff
Thing 1
it

Send me a copy of my responses.

Powered by
B Google Forms

Need to gather responses offline? Google Forms can help with that too. Just click Print in your Forms menu,
and Google Forms will make a ballot-style copy of your form that you can print or save as PDF.

Grids and multiple-choice options show pill buttons to fill in, while text fields include blank lines for
answers. Once respondents have filled out your paper forms, just type their answers into your Google Sheets
spreadsheet to save them along with your other form entries.
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Google Forms Add-ons

Add-ons

Al ~

Form Notifications Choice Eliminator 2
333,628 users 80,292 users

New Visions ' New Visions
for Public Schools for Public Schools
5

FormPublisher =

Form Publisher formLimiter docAppender
Hekkk - (608) 108,467 users 40,151 users

'Nswvhlm
, for Public Schools

Google Forms is great on its own, but odds are it’s still missing some features you want. Forms add-ons let
you add extra features to your forms, get customized notifications, turn your form entires into documents,
and more.

There’s an entire library of add-ons tucked away in the Google Forms menu. Just click the menu, click Add-
ons..., then find an add-on you want an install it. You’ll then get a new puzzle piece icon in Google Forms,
with a menu that lists each of your add-ons.
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Name and attach values list

Which Sheet? Which data? Name the values list!
FORMRANGER X
Data preview... -
Zapbook 1A P
Name Assign Form questions to be populated from
Select Sheet values lists in a Sheet or student rosters created
Live Integrations with Categories + - in the Only multiple choice
Google Sheets checkbox, list, and grid type questions are
Select column header Trello supported
e i Google Calendar - \
Column must have a header Gmail Populate from values list
label in row 1. Slack
MailChimp
Evernote
Twitter
Refresh questions

— m Auto-repopulate questions...

On form submit  OFF

Every hour OFF

Most Google Forms add-ons run in a pop-over on the lower right side of your forms editor, and they may also
include an options pane that opens in the center of your editor. To open an add-on, just select it in the add-
ons menu, manage its settings from its add-on pop-over, and it’ll then run in the background automatically.
There’s no menu option to manage or remove add-ons; instead, just open the Add-ons pane again, find the
add-on you want to remove, click the green Manage button, and then select Remove in its menu.

Here are some of the best Forms add-ons to get started:

« All Questions Required? adds a simple toggle to make all questions required—or not—in a single click.

« CheckItOut lets you check in or out items with a form, essentially by rearranging data from one
category to another in a spreadsheet. It’s a great tool for managing inventory or shared items, or it
could be used creatively to, say, approve tasks or do other jobs where you need to move items between
two categories.

« Choice Eliminator 2 eliminates options from multiple-choice, list, or checkbox questions if they’ve
already been selected. It’s a great way to, say, make a signup form where respondents can each select
one day or an order form for limited quantity items.

« Data Director adds form responses to alternate sheets and sends email notifications based on
conditions. You could use it to sort all similar entries into different sheets automatically.

+ docAppender adds your form results to the end of a Google Docs document instead of a spreadsheet.
Each response can be added to unique documents based on form questions, or they each can be added
to the same document.

+ formLimiter limits how many times your form can be answered. It can watch for a number of responses,
a date and time, or a set value in your results spreadsheet, and then will disable your form once that’s
hit.

« Form Notifications sends custom email notifications to you and optionally to form respondents with
details about the form results and a thank you message.


https://chrome.google.com/webstore/detail/all-questions-required/hlocidcflddgoghedcdlgblfmdfdfnab
https://chrome.google.com/webstore/detail/checkitout/ociehaocmpicgbfmogelhdhgjjhjimpn?utm_source=permalink
https://chrome.google.com/webstore/detail/choice-eliminator-2/mnhoinjhhhafgieggnhjekliaodnkigj
https://chrome.google.com/webstore/detail/data-director-for-forms/bjlicikmbfbjckkgemmiddonmigijpbj?hl=en
https://chrome.google.com/webstore/detail/docappender/lijjbnggcpkhpkabahnebgdbnepdjhff
https://chrome.google.com/webstore/detail/formlimiter/clflahnkjeannplpafofekagclpmijkl
https://chrome.google.com/webstore/detail/form-notifications/bbpdeojefjfhaelgljjcadpcckdfcdod
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+ Form Publisher makes template Google Docs documents, PDF files, or unique spreadsheets for each
entry, and then share them via email.

+ Form Field Export turns your Google Forms fields into JSON data to import into other form apps.

» formRanger pre-populates choices in multiple choice or checkbox questions from a table in a
spreadsheet. That gives you an easy way to add questions about data you've already saved to a
spreadsheet.

« formRecycler imports questions from other forms to quickly reuse them without copying the entire
form.

« g(Math) adds graphs and functions to forms. Type your formula in LaTeX format, or add a function to
graph, then insert it as an image into your form.

Or, if you’re storing your form data in a Google Sheets spreadsheet, there’s a wealth of Sheets add-ons to do
more with your data, which we’ll look at in chapter 6.

Build Add-ons with Google Apps Script

Upload a file for 25th Anniversary

FILE

SUBMIT

Need to receive files in a Google Form? There’s no add-on for that, but you can use a Google Apps Script to
accept files in a secondary form and add them to Google Drive. That’s but one of the many things you could
do with Google Apps Script, the scripting language for building macros and add-ons in Google’s apps which
we’ll dive into in chapter 7 of this book.

Apps Scripts let you add form options, send notifications, and more with just a few lines of Javascript code.
You can find Google Apps Scripts online, or learn to build your own using Google’s tutorials for building
Forms add-ons.


https://chrome.google.com/webstore/detail/form-publisher/hgmhbdjdjoahflgfmfpjlgpplihlechm?hl=en
https://chrome.google.com/webstore/detail/form-field-export/ibhddnojgelmfpfdhahdndmpebdofooo?hl=en
https://chrome.google.com/webstore/detail/formranger/faepkjkcpnnghgdhiobglpppbfdnaehc?hl=en
https://chrome.google.com/webstore/detail/formrecycler/nomlphfjecjpcanpbfmpnkncpacjbkdl
https://chrome.google.com/webstore/detail/gmath-for-forms/pfpepkdookmfefmppcknaobckehpjgcj
https://zapier.com/learn/google-sheets/best-google-sheets-addons/#forms
http://www.labnol.org/internet/receive-files-in-google-drive/19697/
https://zapier.com/learn/google-sheets/google-apps-script-tutorial/
https://developers.google.com/apps-script/quickstart/forms
https://developers.google.com/apps-script/quickstart/forms
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Integrate Google Forms with MailChimp, Salesforce, Trello, and
More
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ACTION

)
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Updated Response in Spreadsheet

ACTION Save + Continue

» & 3. Send Outbound Email v

o

W Get Help R

Another way to do more with your forms is with Zapier integrations. With connections to over 600 apps,
Zapier can save your form data to other apps, send you customized notifications, and put forms at the center
of your workflows.

There’s only one catch: Your forms have to be connected to a Google Sheets spreadsheet to work with Zapier.
Just make sure your form entries are being saved to a spreadsheet, then connect it to Zapier, and build the
custom workflows you need to get work done directly from forms.

Here are some popular integrations to get started:

Get Notified When Your Form is Filled Out

Want to get notified whenever your form is filled out or when specific entries are added to your form? Zapier
can send you customized email notifications with filters that watch for the text you want. Or you can send
the notifications to Slack, SMS, or any other communications tool you want.

Zapier Integrations:

» Send email via Gmail for new Google Forms submissions
« Share Google Forms responses in a Slack channel
+ Send Twilio SMS messages with new Google Forms responses


https://zapier.com/app/min/11008/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11018/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11082/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
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Save Form Entries in a Database or Spreadsheet of Your Choice

For a more customizable way to save your form data, Zapier can route your form entries to multiple
spreadsheet sheets in any spreadsheet or database app you want. With your data sorted automatically, you’ll
be able to get work done with your form even faster.

Zapier Integrations:

» Update Google Sheets rows from new Google Forms responses
« Create MySQL rows from new Google Forms responses

« Create Airtable records from new Google Forms responses

+ Append new Google Forms responses to a text file on Dropbox

Save New Contacts to Your CRM

Make sure you can always get in touch with people who fill out your forms by logging their contact info to
your address book or customer relationship manager (CRM) app. Zapier can add new contacts to your CRM,
save a note with info about what they wrote in the form, and even update existing contacts to log every time
they fill out one of your forms.

Zapier Integrations:

+ Create HubSpot contacts from Google Forms responses
« Create Salesforce contacts from Google Forms responses
« Create contacts in Google Contacts from new Google Forms responses

Grow Your Email Newsletter List

Use your form to expand your marketing efforts and stay in touch with your fans. Just connect it to your
email newsletter app, and add everyone who fills out the form to your email newsletter list. Or, if you want
to add them to another list, you could use Zapier to remove them from one list and then add them to another.

Zapier Integrations:

+ Create MailChimp subscribers from Google Forms submissions
+ Create ActiveCampaign subscribers from Google Forms responses
+ Unsubscribe new Google Forms respondents from MailChimp

Turn Form Entries Into Tasks and Projects

Your team has stuff that needs done, and a form can be an integral part of your workflow when connected
to your to-do list or project management app. Zapier can then start new projects, add tasks and events, and
make sure everything’s in place to get your work done.

Zapier Integrations:


https://zapier.com/app/min/11111/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11080/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11046/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11065/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/learn/ultimate-guide-to-crm-apps/best-crm-app/
https://zapier.com/app/min/11028/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11030/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11034/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/learn/ultimate-guide-to-email-marketing-apps/best-email-newsletter-software/
https://zapier.com/app/min/11009/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11019/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11038/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/blog/best-todo-list-apps/
https://zapier.com/learn/ultimate-guide-to-project-management/best-project-management-software/
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« Create Trello cards from Google Forms responses

+ Create Google Calendar events from Google Forms submissions
« Create JIRA issues from new Google Forms responses

+ Create Asana tasks from new Google Forms responses

Create Documents from Form Entries

For more customized documents, template tools like WebMerge can take your form data, create PDF
documents from templates, and save or send them wherever you want. Or, you can create text files from
form entries for individual copies of each record.

Zapier Integrations:

+ Merge new Google Forms responses with a WebMerge document
+ Add new Google Forms responses to a WebMerge data route

Whether you need to make a simple poll or want a dynamic survey with customized questions for different
response types, Google Forms has the essential tools you need. It’s not the most powerful or customizable
form builder. Instead, it’s incredibly easy to use, right from your Google account.

And thanks to its deep integration with Google Sheets—and a wealth of add-ons—it can be a powerful tool to
gather data and mine it for insights without leaving Google Apps.

Next time you need a new form or survey, give Google Forms a try. With these tips and tricks, it just might
be the handy form tool you’ve always needed.

Learn more about the entire Google Apps suite:

« Gmail Review

+ Google Drive Review
« Google Docs Review
+ Google Sheets Review
+ Google Forms Review

Now that you’ve learned the basics of Google Sheets and know how to gather data in a form, let’s put it
together and build a quick app inside a spreadsheet. In chapter 3, you’ll learn how to build a full CRM app
inside a spreadsheet, one where you can pull in data from the web about your contacts and even reach out to
them with automated emails.


https://zapier.com/app/min/11016/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11015/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11098/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11035/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11088/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/11090/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/zapbook/gmail/review/
https://zapier.com/zapbook/google-drive/review/
https://zapier.com/zapbook/google-docs/review/
https://zapier.com/zapbook/google-sheets/review/
https://zapier.com/zapbook/google-forms/review/
https://zapier.com/learn/google-sheets/google-sheets-tutorial/
https://zapier.com/learn/google-sheets/spreadsheet-crm/
https://zapier.com/learn/google-sheets/spreadsheet-crm/
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Enjoy? Read and share this chapter online: zpr.io/uBof

Written by Zapier content marketer Matthew Guay.
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http://zpr.io/uB9f
https://twitter.com/maguay

Chapter 3: Spreadsheet CRM—How to Create
a Customizable CRM with Google Sheets

When VisiCalc came out as the first consumer spreadsheet software in 1979, it brought the number-crunching
capabilities of big business to everyone. It was the first time anyone could harness the power of automated
calculations to manage their own data.

Spreadsheets gave us the potential to input, modify, and calculate anything we wanted and store it digitally
for re-use. You could build anything from run-of-the-mill grocery lists to financial models that feed off of
massive data sets—the possibilities seemed endless. Spreadsheets were the original killer app, one of the main
reasons you’d want to own a computer.

And now, you can use spreadsheets to build your own apps. With internet-connect spreadsheets like Google
Sheets, you can format and analyze data with standard spreadsheet tools, and also pull in data from the web
and run complex workflows automatically.

We’ll learn how to do just that in this chapter, by building a full-featured, automated contact management
system (or CRM) with just a spreadsheet.

Tools to Build Your Google Sheets CRM

This tutorial tells you everything you’ll need to build each part of the spreadsheet. But sometimes, it’s easier
to follow along with a pre-made spreadsheet. For that, we’ve included a template with every example featured
in this tutorial—all you have to do is copy it to your account.

Just open the template in Google Sheets, then copy it to your own Google Drive account by clicking File and
selecting Make a Copy.
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https://archive.org/details/VisiCalc_1979_SoftwareArts
https://zapier.com/zapbook/google-sheets/review
https://zapier.com/zapbook/google-sheets/review
https://zapier.com/learn/ultimate-guide-to-crm-apps/what-is-a-crm/
https://docs.google.com/spreadsheets/d/1TOvmNLEhURU5YlVoL2wTJ6-LrXT4hco7gNKwW2a1Sh8/edit#gid=653774040
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You can also take this sheet, tear it apart, and modify it so it suits your needs. Each use case is implemented
in its own tab, so you can see how they would potentially interact to form a complete contact management
system.

I recommend either following along and tinkering with each element as it’s brought up. But if you’re feeling
brave, you could build your own spreadsheet from scratch. The latter will help you really get the feel for
creating in Google Sheets rather than just using it.

How To Build a CRM in Google Sheets:

Add a Form to Your Spreadsheet

One of the most significant “Aha” moments you’ll have with Sheets is realizing that your spreadsheets are
connected to the internet—which means they can do work for you online. Google Sheets can automatically
import data from other websites (something we’ll look at later on), and it also includes a form tool, Google
Forms, to gather data and save it directly to your spreadsheet.

We looked at Google Forms features and tools in chapter 2—jump back for a refresher if you haven’t made
your own forms in it yet. Now, let’s try it out by setting up a form to collect lead information from prospective
clients.

You could embed this form on your site, add it with button or link on your website, or share a link to the form
via social media or email. When people click on your link, they can fill out your questions, and the data will
be saved to your spreadsheet automatically.

1. Set up your form

First, you’ll want to add a form to your spreadsheet as a simple way to gather data. Here’s the Form example
I created—try it out and submit your (fake) data!


https://zapier.com/learn/google-sheets/how-to-use-google-forms/
http://goo.gl/forms/JufEqUgFcF
http://goo.gl/forms/JufEqUgFcF
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To implement your own form, you’ll first need a spreadsheet (of course).

If you didn’t copy the tutorial template, go to your Google Drive account and click New > Google Sheets as
in this screenshot.

L Drive My Drive > Zapier » Posts » Google Sheets Uses ~

Folder =

4
L]
i
i
b

> |

File upload

B

Folder upload

gle Docs Uses Sheets Business Te...
| B Google Docs
Google Sheets #
Google Slides
Maore b

Once you have a sheet open, click Insert > Form and a new window will pop open where you will start filling
out your form information.


https://docs.google.com/spreadsheets/d/1J6XCY50hNx45fKtak4qrLlfcclxKZcSCX2gYKkp2Mbw/edit?usp=sharing
http://drive.google.com/
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2. Change your form'’s settings

This section allows you to choose who can see the form, and how many responses each person is allowed to
submit. You can also customize a few aesthetic options, like question order and progress bars.

If you're using Google Apps for Work, you can set it to only allow users from your organization and
automatically collect their ID when they submit the form. This feature is especially useful for internal data
entry, or for outsourced freelancers entering data from assigned company accounts.


https://www.google.com/work/apps/business/
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Settings
GENERAL

Requires sign in:

Restrict to Zapier users
I:I Collect email address
D Limit to 1 response

Respondents will be required to sign in to Google

Respondents can:

D Edit after submit

[[] see a summary of responses (7]

CANCEL SAVE

For this form, I will leave all of the preferences blank so that it’s accessible to you (and everyone else), and
allows unlimited responses per person. If you’re making a generic contact form as an easy way for people to
get in touch with your team, you’ll likely want the same settings.

3. Add some questions

The questions you’ll add to your form will depend on the data you want to collect, so think through the
questions you’ll need for your own form. Try to collect data in a way that will make it easy for you to
manipulate it later—ask generic questions with each answer in its own field.

For example, rather than allowing a user to enter a free-form answer to a question, offer 3-5 fairly
comprehensive text-based choices in a multiple-choice question.


https://zapier.com/learn/ultimate-guide-to-forms-and-surveys/writing-effective-survey/
https://zapier.com/learn/ultimate-guide-to-forms-and-surveys/writing-effective-survey/
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Just enter the questions you want, pick the answer type, and Google will automatically create rows in your
spreadsheet for each of your form’s questions. You can also add some useful logic to the form with sections to
personalize the questions to a user’s responses. Jump back to Chapter 2’s Google Forms Logic Sections guide
if you need a refresher.

Here are some sample responses to my demo form for this tutorial:
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a 712412015 17:25:02 Johnny Lightning  Zapier Blog Zapier hitp:fhwww.z8pier.com jer.com 1 It connects my things to everything!  @ZapierTesting
5 712412015 18:02:31 Google Docs A Google Search Google hitp:fiwww google.com google@google.com 9998887777 100010000 Google<3Zapier @TheGooglator
5 712812015 10:55:57 Donald Duck Referral MeScrooge Corp http:fhwwwu. disney.com D om 1238664444 1000-1 Quack! @McSeroogeGeld
7 712812015 18:18:11 Benjamin Bulton __ Divine Inspiration Ageless Cream Inc hitpfhwww.ageless.com Bulton@Benjarmin.com 8881117777 500-1000 _It's evergreen! @BINJAMINGSY

I 8 7/29/2015 17:31:39 Mark Eterman A Google Search MarketerMan hitp:fiwww Marketer.com mark@eterman.com 8887774444 0-500 | don't know enough about it! I

9
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i
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" Responses are automatically placed after the last entry

As you can see, complicated text answers are difficult to read and also difficult to use in a meaningful way
without directly analyzing the content. Some situations make sense for long-form answers (like when you
expect only a few responses and have time to read them all). But when you’re expecting the system to run in
the background, you won’t want to analyze everyone’s submissions.

That’s why it’s best to make sure each question will only get a one-word answer—that gives you a lot more
flexibility.

So now you have some data, what do you do with it?


https://zapier.com/learn/google-sheets/how-to-use-google-forms/#sections
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Well, you can use it “as is” to get in touch with your new contacts, but let’s take it a step further.

4. Move your data to another sheet for processing

I'll start by re-naming my form response sheet. The form originally shows up as a sheet named “Form
Responses 1” but I renamed it “Customer Data” by double-clicking the name at the bottom of the worksheet.

24

2 Rename your responses with a double-click.

26

4+ = Form Responses 1 CRM Social Media

Once you have changed the Form Responses sheet’s name to something more appropriate, we can take the
information in that information and put it into another sheet. You can reference data from another sheet
quickly by using the =INDIRECT() function.

Here’s what the formula would look like for the form we just created:
=INDIRECT("Customer Data!A2:H")

+ Customer Data is where any new form submissions are saved.
« ! is used to reference another worksheet in the same spreadsheet.

« A2:H is the range of cells containing the data Id like to reference—and it will automatically include all
new data that comes in.

Alternately, if you want to keep responses separate from where you will perform data manipulation, you can
use the =IMPORTRANGE () function in a completely different spreadsheet (a different document).

The formula to import the data into a separate spreadsheet would look like this for my example:

=IMPORTRANGE ( ““4 TOVMNLEhURUS5Y1VoL 2wTJ6-LrXT4hco7gNKwW2a1Sh8”,’Customer
Data!A2:H”)"

« 1TOvm. . ..wW2a1Sh8 is the “Spreadsheet ID” located in the original spreadsheet’s URL (check the URL
bar in your browser—it’s the text after the /d/ in the address)
+ Customer Data!A2:H references the range of the original data to import.

When you enter this formula, you’ll have to authorize the new spreadsheet to access the data—just click the
“Allow access” button that’ll pop-up beside that cell.



Chapter 3: Spreadsheet CRM—How to Create a Customizable CRM with Google Sheets 64

=IMPORTRANGE ("1TOvmNLEhURUSY1VoL2WTT6-LrXT4hco7gNKwW2a1Sha" , "Customer Datal!A2:H")
A B C D E F G H

| #REF! 1 You need to connect these

sheets.

*—.-—-—- Allow Access if Prompted

=~ motn e R

Click “OK” and your data should show up after a few seconds.
Now you can access form submission data in any of your spreadsheets and worksheets!

From here, you can do all manner of things. I'll demonstrate a use case by creating a simple Customer
Relationship Management system (CRM) based on the form we just set up.

Create a Contact Management System

Managing customer and contact data in a spreadsheet is a time-tested business practice. You’ll often hear
modern data management solutions talk about “ditching spreadsheets.” But I love using Google Sheets for
managing this type of data: it makes moving and organizing data extremely simple.

If you don’t already have a contact management system in place, you’ll want to collect data like:

« Contact information, including each person’s name, phone number, email, company, website, and social
profiles.

« Source of the lead or customer (website signup, social media, paid advertising, etc)
+ A system or code for their lead nurture stage.

« Customer Value (single purchase, lifetime value, or whatever is appropriate).

« Information about interactions (dates, topic, significant notes, etc).

You’re probably already keeping track of some of this data, but a detailed spreadsheet CRM can help you store
more of it in a simpler format.

Google Sheets eliminates many of the distracting features of a full-fledged CRM while allowing for a level of
customization that you won’t find in an off-the-shelf solution.

The caveat, of course, is that you have to build it. But don’t worry: it’s easy and a great way to practice your
spreadsheet skills.

1. Label some columns

Be sure to add a column for any information you want to keep track of. Per my example bullets above, I've
gone ahead and labeled my columns as shown below:
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Google Sheets CRM Tutorial —~ ma
File Edt View Insen Format Data Tools Form  Add-ons  Help Al chanpes saved in Drive

& P 8 % oo 0. A w© B IS+ A_ |0 @ E-1-+- cocWEY- X
2 | D Audedl Name Source Company Website Email Phone Value z::.?;-? Twitter "Inh':';:ion Inh’:‘;‘;‘“n In';:::’“m Assigned  Notes J
= The basic information you /' Extra fields we will add #
2 want / collected in your form with Formulae later!

You may notice the “ID” and “Updated” columns I've created. The “Updated” column is automatically created
with every form entry, so I want to include that data in case I want to do something with the age of the data
in the future.

The “ID” column is a part of the next step...

2. Manually enter or import data

The point of a CRM is to track contact data and customer lifecycle changes in a format that you can query
later.

In the previous section, I showed how to set up a form to collect data from an outside source (rather than via
one of your team members or direct collaborators). The form we created was designed for prospective new
customers, though it can just as easily be used by myself or any member of my team to quickly input the data
in a structured way.

In this CRM example, I'll use the data entered into that form as the customer entries in my CRM sheet. Then
I’ll assign an ID to the imported customer and choose a team member to be assigned to the customer based
on their prospective monthly spend (a data point in the form).

We'll use 4 functions to accomplish this:

« =ARRAYFORMULA() - to automatically update the IDs when new entries are added.
« =CHOOSE() - to select a team member based on the monthly spend.

« =ROW() - to grab the number of the row where the data is located.

« =IF() - for setting conditions on when to make things happen.

In order to keep your functions separate from the data (which you might be copying and pasting in the future),
I recommend creating a row below your headers specifically for your formulas and hiding it when not in use.
(ve highlighted mine red.)

AQD:N.E!&
D Added Name Source Company  Website Email Phone Value z::a{? Twitter Meta Meta Meta | issigned | Notes
B o Timestamg Ful Hame  wisa you find his sure_ Company. Comeary Websi Enmail Fheea Warkiting Budonl | What's your fiwor What's Yeur Tatil rone Danry 1
A row specifically for formulae that will This keeps you from accidentally clicking
apply to every row underneath. a box with-a REALLY important formula

and messing everything up...
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You will hide this row by right-clicking on the gray area to the left with the row number on it, then selecting
Hide Row. If you need to add or tweak these formulas (which you will shortly), select a range of rows that
includes the hidden row and Right-Click > Unhide Rows.

Before I set up the ARRAYFORMULA( ), I'd like to make data ranges easy to reference in my formulas.

3. Name your data ranges
This allows you to use a short name like “name” instead of A: A every time you’d like to access that range of
cells.

You don’t have to do this; sometimes I prefer not to name ranges so I know exactly what data I'm looking at.
But, for times when you don’t plan to change the range very much, it’s a good practice that simplifies things.

To define and name an entire column, right-click on the gray box with the letter at the top of the column and
select Define Named Range. Click “Done” once you’ve ensured it’s the right range.

Google Sheets CRM Tutorial |

File Edit View Inset Format Data Tools Form Add-ons Help Al changes saved in Drive

e~ s % o0 0013 A -l -([B]lrsa. % .B-EE- EF-L-4-colEY-X-
+Add a range
A s c o 3 F s H J «
i ADD NEW Name Your Range!
2z ID Added Name Source Company Website Email Phone Value Z:;rileyr? Twitter
] 0 Timestamp Full Name w did you find this surv| Company Company Website Email Phone Marketing Budget |What's your favori witts m Cancel
"
= added
CRMIB3:B738
. 1
5 1.Sel e o~
P . e eCt a CRMIO3:0738
: R f Cell
a ange ol Lells CAmESEras
1 Cut
2 Copy email
CRMIG3:GT38
= Paste
2
H N Paste special » o o
a5 i |g t iC t en CRMIAZ:ATI8
»
- - n . Sort range. metainfo
1
= Click "Define Named
= " Insert link. name
= Ran g e \ nnnnn CRMIC3.C738
Bl
- - ~ notes
& = CRMIP3:PT38
)
a phone
2 Insert comment CRMIH3:H738
Insert note
B source
£l Clear notes CRMID3:D738
3
» Conditional formatting
CRMIK3 K738
L Data validation...
# value
= CRMUAIZ3E

+ = | CustomerData - | CRM ~ | Social Media o Sum: 36243461220 =

Do this for all of your main data ranges (in the image I just showed a large range of cells as an example). You
can now access those ranges simply by typing the short name you used when naming them (do note that it’s
case-sensitive).

4. Manipulate your data with formulas

To do that, let’s set up an ID for each new entry.

You might wonder why you need an ID when the row clearly has numbers next to it.
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I do this because if I ever want to filter the data and export a shortened list of specific entries, the row number
doesn’t stay with the data between sheets or exports to CSV files. So if you decide to upload this information
to a “real” CRM at some point, you normally wouldn’t be able to keep track of the customer’s entry number.

Having a dedicated ID for each entry solves that problem.

To add a Customer ID, use this formula in your “ID” column’s formula row (the one you’ll be hiding):
=ARRAYFORMULA(if(name<>"" ,ROW(name)-3,""))

« if(name<>"" checks to see if there’s a name in the “Name” column

« ROW(name) -3 returns the ID based on the row number -3 (this is to offset the number of header rows
that are used to title / hidden formula row).

« The "" in the 3rd argument of the formula is to avoid returning “FALSE” in every row below the most
recent entry. It’s purely aesthetic, but I find that I can recognize a blank cell more easily than sorting
through a bunch of “FALSE”s mixed with my data.

5. Assign your customers to sales reps

In the “Assigned” column’s formula row, we’ll insert the following:

=ARRAYFORMULA( IF (value<>"", IF(value = "0-500", "Mike", IF(value =
”5@@‘1@@@", ”Matt", "Danny”)),""))

« IF(value<>"", again checks if there’s a CRM entry by looking at the value column
o IF(value = "0-500", "Mike", returns “Mike” if the value is “0-500”,
« IF(value = "500-1000", "Matt", assigns anything that matches “500-1000” to “Matt”

1)

« "Danny")),"")) returns “Danny” as the default case and the last “” returns blank if nothing is in the

value column

Awesome! So now there is an agent assigned to each new, ID’d entry into your CRM.

Here’s what would happen if you add someone now:
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If you’d like to modify customer data, you would do so in the “Customer Data” sheet, rather than in your
CRM. This is because CRM sheet references the data from the “Customer Data” sheet via formulas. So rather
than changing the actual data, if you modified the information in the CRM sheet, you would break your
formulas!

If you want to add additional information manually, you can add more columns to the right of your last
data-filled column. That’s the best way to keep from breaking things. For example, you could create a “Notes”
column in column K to add additional information on any new customer.

6. Set up a way to add customers manually

You don’t want to manually enter each piece of contact information. Instead, let’s place a link directly to the
input form on your CRM sheet. This way, you can just click the link to pop open the form, fill in the data as
if you were a customer, and submit it.

I placed my form link in a new row at the top of my sheet using the =HYPERLINK() function.
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A B c [ E F G H
| .
ADDNEW | < ink t0 manually open the form
2 ID Added Name Source Company Website Email Phone
3 0 Timestamp Full Name id you find thiss  Company  lompany Websit Email Phone wlar
4
1 7/18/2015 12:09 Michael Grubbs ichaelGrubbs.co ichaelGrubbsCoww.michaelgrub :l@michaelgrubt 1234567890
5
7/18/2015 12:12  Mike Grubbs Referral Moblized  /fwww.moblized.hael@moblized.com 1
[ 3 7/24/2015 17:25 Johnny Lightning  Zapier Blog Zapier o:/lwww.zapier.c hnny@zapier.co 8004448888 1

-

To start, you’ll need the link you would share with someone who you wanted to fill in the form for this
spreadsheet, such as this link for this tutorial’s example form.

This sharing link can be found by clicking the “Send Form” button on your attached form’s editing screen or
by clicking Form > Go To Live Form from the worksheet’s toolbar and copying the URL.

Once you have the link, go back to your spreadsheet, select a cell that you want to place the formula in, and
make yours look like this (but with the URL for your form):

=HYPERLINK("https://docs.google.com/forms/
d/1zgH3WpmpUgXzal a440DfSEzIyeIm2 jOMEZRMXtbXuWI /
viewform?usp=send_form#start=invite", "ADD NEW")

o =HYPERLINK("https://docs.google. .. form#¥start=invite", is the URL to the form.
« "ADD NEW") is the text you want to show up in the cell.

To use the link, hover over the cell and the URL will pop up above it, allowing you to click it.

Go ahead and submit some information through your form and view the results in your CRM sheet—you
should see the new data show up almost instantly. It’s incredibly satisfying to have the ID and Team member
assignment happen automatically!

What about a more complex (and incredibly awesome) way to collect additional data about these new potential
customers?

Qualify Contacts with Web Scraping

Adding some automated data scraping—copying data from other websites automatically—to your sheets is as
easy as adding a few built-in functions. You can grab almost any data you want from most URLs by using the
IMPORT functions in Google Sheets. Those include:


https://docs.google.com/forms/d/1zgH3WpmpUqXzaLa44ODfSEzIyeIm2j0MEzRMXtbXuWI/viewform#start=invite
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« IMPORTXML() - Imports a site’s XML markup.

« IMPORTDATA() - Imports the content of a page saved as a .csv or a .tsv on a site’s directory.
+ IMPORTFEED() - Import an RSS or ATOM feed.

+ IMPORTHTML () - Imports a page’s HTML tables.

+ IMPORTRANGE() - Imports data from another Google Sheet.

Continuing along with our CRM example, let’s see if we can get some more information about these new
prospects automatically.

If you didn’t enter a valid URL for your contacts’ website into any of your form entries, you will want to either
change some URLs in your “Customer Data” sheet now, or enter in a few more manual form submissions with
valid links.

1. Choose data to scrape

You may not know this, but each website is coded slightly differently. There are loads of best practices and
shifting standards, but it’s pretty rare that the guts of one site are exactly the same as another.

This is especially true of elements within the <Body> tags of a webpage.

For example, the search bar on Google’s homepage is tagged and coded differently than the search bar in
Zapier’s help section. The HTML elements are different, the styling is different, and the scripts that power
their interactions with users are different (so they get lots of different tags applied to them).

These differences make the elements’ Extensible Markup Language (XML) paths different, too. The XPath
(shorthand terminology) helps you find each similar element on a given page based on its HTML structure
and tagging. Google Sheets can use this structural information to grab the contents of a webpage—so, for
example, if you have the XPath of the Twitter bio, and a link to each of your contacts’ Twitter page, Google
Sheets could import each person’s Twitter bio automatically. All you’ll need to do is find the XPath.

One easy way to see the XPath of any element on a page is to use Chrome’s Developer Tools (CMD+OPT+i
to open) or just right click and select *Inspect Element on whatever you want to see the path for. This will
first Open Dev Tools and then highlight that element in the “Elements” section.

Once you see the gray or blue highlighted element, right-click on it and select Copy XPath to copy the exact
XPath of that element to your clipboard.


https://zapier.com/help/
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Here’s what you’d get if you were to paste the results of the “Copy XPath” command from the Developer
Tools pane:

//*[@id="1st-ib"]

This is the super-specific, non-generalized way to reference that element, and it’s only really useful for that
specific element.

Depending on the element you are trying to scrape (and if you want to apply the formula to multiple sites)
there are some XPaths that are the same across most sites.

One example of these standard elements is site “Meta Tags”. These usually Search Engine Optimization (SEO)
elements like the Title, the Description, and Author of the page, and can hold a bunch of useful info. They’re
your best bet if you want to copy data from a wide range of different websites.

We'll use these Meta Tags to collect additional information about our leads’ website or service to help better
aid the sales representatives that we assigned in the CRM section above.

Tip: Want to learn more about tracking down XPaths? Read Google’s documentation for more
help getting started with Chrome Developer Tools.


https://developers.google.com/web/tools/setup/workspace/index?hl=en
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2. Scrape your data using Google Sheets

We're going to use the =IMPORTXML() function here (which is by far my favorite IMPORT() function).
=IMPORTXML () makes it easy to grab similar data from different pages without knowing exactly how they
are tagged or structured.

Another function we’ll be using is =IFERROR(). You can think of it as a traditional IF() that we used in the
example above, but instead of putting in your own condition statement (like “If this happens then do this”)
that statement will always be “Check to see if this formula results in an Error when you run it”.

You'll recognize when a formula is “throwing an error” when you see a #REF !, #ERROR!, #*NAME?, or #N/A as
the result. Sometimes this is because of a faulty formula, but other times it’s just the result of a formula not
grabbing any data. Google Sheets should tell you the source of the problem, though.

Common Error Examples

h ? h 1 | ]
#REF! #MNAME? #HNIA #ERROR! Error

Formula parse error.

Thankfully Sheets tells you what's wrong f
(mostly) if you highlight the cell with the error

This sometimes happens with IMPORTXML () because some sites block scraping. Or, the URL might be dead,
producing a 404 (page not found) error.

You can hide these error codes by wrapping our formula in the IFERROR() function, which shows a different
result if the cell runs into a problem.

One thing to note is that by doing this, you effectively silence any helpful errors that would let you know that
your formula is incorrect. I recommend only wrapping your function in IFERROR() once you’re sure that it
actually works the way you expect.

Here’s what the completed formula for scraping a page’s “Title” looks like:
=IFERROR( IMPORTXML (website,"//title"), "none"

+ =IFERROR( - wrapping our IMPORTXML ( function to check for an error

« website is the range where the URLs are located.

« "//title" is the XML reference for the “title” element in a webpage’s code.

¢ "none"' is the default result to IFERROR() if the IMPORTXML() function fails to find a “ti-
tle”.

Unfortunately, IMPORTXML () has a limit of 50 instances per worksheet (as in, 50 IMPORTXML() functions in
the entire document) so we need to be judicious in our application of the function.

To combat this limit, rather than creating a new IMPORTXML() for each of the Title, Meta Description and
Keywords, I'll go ahead and use the XPath “OR” operator which is | (a vertical line or “pipe”) to combine the
queries into a single function.
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Place the following XML paths after //title, with each separated by a |:

//meta[@name="description’']/@content
//meta[@name="keywords']/@content

As you may have noticed, the Description and Keywords XML paths are a bit more complicated because you
need to get more specific to reference the right elements.

Tip: You can read up on constructing XPath arguments from this Microsoft resource or use the
W3 XPath Syntax Guide to learn all things Xpath.

The completed formula will look like this:

=IFERROR( IMPORTXML (website,"//titlel|//meta[@name="description']/@content|//
meta[@name="keywords']/@content"), "none"

We want to list our results on the same row as our contact in the CRM (rather than spilling vertically into
the next contact). To fix this, we just wrap the whole formulas in a TRANSPOSE () function. This will take the
vertical data and flip it to spill into the cells to its right.

Here’s the final, FINAL version of the scraping formula:

=TRANSPOSE (IFERROR( IMPORTXML (website,"//titlel//
meta[@name="'description']/@content|//
meta[@name="keywords']/@content"), "none"))

And it will look like this in your formula box:

|_|}=TRANSPDSE(IFERRDR(IHPDRTXHL( L/ /title| //meta[@name="description’]/@content|//meta[@name="keywords']/@content”), "none")) |

NOTE: I'm still putting these functions in my 3rd row, which is acting as my hidden formula
TOW.

3. Copy your formulas down to any new contacts

We used ARRAYFORMULA( ) in the Form and CRM sections above to automatically apply formulas to new entries
in our CRM. That doesn’t work with IMPORTXML (), due to that “50 instances” limit mentioned above.

Because the ARRAYFORMULA( ) doesn’t actually create new formulas in subsequent rows (but rather just applies
the formula to the next row in the range), you MUST copy your formula down for each time you want to use
IMPORTXML ().


https://msdn.microsoft.com/en-us/library/ms256086%28v=vs.110%29.aspx?f=255&MSPPError=-2147217396
http://www.w3schools.com/xsl/xpath_syntax.asp

Chapter 3: Spreadsheet CRM—How to Create a Customizable CRM with Google Sheets 74

You can do this by grabbing the small box that shows up in the bottom right of any cell with your scraping
formula in it and dragging the box down over the new rows with contacts to be scraped.

Here’s what the process looks like:

Google Sheets CRM Tutorial =
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11 magic@kingdom.com 1234345555 0-500 Magical Stuff Hap @mrmickey1414 Mike
12 bill@ionnaire.biz BB84445565 1000-10000 | like to automate @InflateGate5 Danny

What happens when you hit your 50th contact? You can’t scrape anymore unless you remove some of the
old IMPORTXML() functions. I usually do this by highlighting all of the cells that receive results from the
IMPORTXML () formulas then right-clicking in the uppermost left cell of the highlighted range and selecting
Paste Special > Values Only.

If you try to paste normally, you will only paste the formula in each cell (which would definitely exceed
your 50 IMPORTXML () limit)—but pasting the values only just preserves the text you already copied from the
websites.
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Cut
Copy
Paste

, I "t e - Paste values only

Paste format only

Define named range...

Protect range... Paste all except borders

Insert camment Paste formula only

Insert note Paste data validation only

Clear notes Paste conditional formatting only

Paste transpose
Conditienal formatting...

Data validation...

>
"Paste values only" will avoid copying & pasting the

Formulae when you want to copy + paste a range of data

You shouldn’t see anything change once you paste, but you’ll notice that if you double-click any of those cells,
the formula is gone and only the text data remains.

This process is especially useful if you want to grab data that has been manipulated by ANY formula in your
sheet and paste it to another sheet or document altogether.

TIP: Leave the last row with the IMPORTXML () function out of this process. This way, the next
time you need to drag the formula down over “new” contacts, you can start the next scraping
at the most recent contact (rather than copying the formula from the hidden formula row and
pasting into the cell).

Think you might have a hard time knowing where the “last scraped contact” was? Let’s make it easier to see
where old contacts end and new ones begin with some highlighting via conditional formatting!

4. Highlight new contacts with a Conditional Formatting rule

You can use this trick to highlight any type of data you want in your sheet. In this case, it functions purely
as a boost to the usability of your CRM, but you could also use Conditional Formatting to quickly identify
VIP prospects based on any set of conditions like date created, keywords in a cell, or numeric comparisons.
You can also use this formatting to literally “format” your text with bold, colors, decoration, and a number of
other visual changes.

To start, in the top-left corner of your sheet, there is a gray box that is neither a row nor a column.
If you click this, it will highlight EVERYTHING in the sheet.

By using Right Click > Conditional Formatting on this box, you will both select the entire sheet as a selected
range and pop open the Conditional Formatting sidebar to the right.
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Here, you can define how you’d like to format based on a number of text-based conditional statements and
custom rules.

I'll use the “Custom Formula is” at the bottom of the first drop-down.

In the formula box, we’ll put this formula:
=AND($C:$C<>" ", $K:$K="")

« =AND( returns TRUE or FALSE based on both logic statements.
« $C:$C<>"" checks to make sure there’s a CRM entry by looking at the Name column.

+ $K:$K="" checks to see if that contact has had their Meta info scraped by looking at the first column in
the “Meta Information” columns.

Then you can select whichever color you want to use for the highlight!
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Because there's no data in the "Meta Information"
section, the entire row gets highlighted based on
the conditional formatting!

+ =  CuskomerData - | CRM - | Social Media - ©

You may notice that in the formula we had to use the actual column letters and Dollar $ signs in the Custom
Formatting formula. This is required to color the whole row rather than just a single cell. Check out Google’s
Conditional Formatting reference for more information on why this is.

One last thing to add is a column that will be used to simply know whether our agent made contact.

Create a column and label it however you want (mine is “Contacted”). Then decide how you’d like to “check
off” if the customer was contacted. I will use a simple code of Yes (y) / No (n).

Here’s how some example data may look in this field:


https://support.google.com/docs/answer/78413?hl=en
https://support.google.com/docs/answer/78413?hl=en
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So now we’ve captured a lead or customer, assigned them to a representative, and have qualified them with
some additional information. We’ve also set it up so that new entries will be highlighted, so we know to scrape
them right away when we load our CRM and have given our team a way to record if they’ve made contact.

The next phase of any good relationship is follow-ups! Why don’t we set up some social management and
outreach via Twitter?

Build an Outreach System with Social Media and Email

It’s pretty common to include social media profiles in your CRM. In the Form and CRM examples above, we
collected each prospect’s Twitter handle at the time of data entry. Let’s assume that everyone fills out their
handle correctly (and that everyone has a Twitter account) and set up a Twitter outreach tool to accompany
our CRM.

This sheet will be able to:

Automatically create Tweets addressed to the contact’s @TwitterHandle
Include a reference to their personal sales contact

Check to see how long ago the customer signed up

Send the Tweet to the prospect with 2 clicks

gk W

Automatically email the prospect as well, 3 days after your call

1. Import data into your Social Media sheet

We don’t need to use every data point from the CRM sheet. For this social media example, we’ll use the named
ranges added (date added), name (customer name), twitter (@handle), and assigned (the team member who
will get in touch).
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We need to target each range with a formula. Using ARRAYFORMULA( ) and setting its parameter to the Named
Ranges we set up earlier, we can quickly pull specific ranges.

We’ll begin by importing the ranges into the “Social Media” sheet:

Name:
=ARRAYFORMULA(IF (twitter<>"", name,""))

o =ARRAYFORMULA(IF(twitter<>"", checks to ensure the contact has a Twitter handle in the CRM and
makes it apply to all future rows.

€3

« name,"") returns the contact’s name if the IF () was true, otherwise it returns .
Twitter:
=ARRAYFORMULA(twitter)
« Returns the “twitter” named range.
Assigned:
=ARRAYFORMULA(IF (twitter<>"",assigned,""))

« Same explanation as the “Name” column, except it returns the assigned range, which was the team
member instead of the contact’s name.

Here’s what your “Social Media” sheet will look like at this point:

A B c D E
1 Name Twitter Assigned
2 Full Name What's Your Twitter Handle  Danny
3 Michael Grubbs @michaeldgrubbz Matt
4 | Mike Grubbs @moblized1234 Danny Still putting Formulae in a separate row.
5  Johnny Lightning @ZapierTesting Danny
6  Google Docs @TheGooglator Danny
7| Donaid Duck @McScroogeGold Danny The data is then imported into all of the rows
8 Benjamin Button @B3NJAMINGIY Matt k— .
8  Mark Eterman @médrke7erB989 Mike beneath it.
10 Mickey Mouse @mrmickey1414 Mike
11 Bill Gates @InflateGate59 Danny
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2. Combine your CRM data with a dynamic Tweet

With the basic CRM data imported, we need a Tweet that we can insert the data into.

In either your column header row or the dedicated formula row (the one highlighted in red), break your Tweet
into sections that would surround your imported name, twitter, and assigned data.

In this example, I break it down like this:

J K L M N (o] P Q

1 Don't forget punctuation!

Twitter Handle customer assigned to this customer

2 Tweet Parts (@Handle) Hey  (NAME) . Thanks again for connecting! How was your chat with (ASSIGNED) ?
3

4 PR }

5 1

: Customer's Name of the The person your CRM
7

8

9

(twitter) > Greeting > (name) > Main Text > (assigned) > Closing
Punctuation

You can structure this however you want, placing your dynamic content in any number of creative phrasings
that include links, hashtags, and more.

Now we need to combine all the parts into one cell. This happens in the “Tweet Copy” column.

Here’s what the completed formula looks like:
=ARRAYFORMULA(IF (twitter <>"", twitter&$J$2&name’$L $28assigned@$N$2, " "))

« =ARRAYFORMULA(IF (twitter<>"" checks to see if the customer has a Twitter handle on file and makes
the formula apply to all future rows.

« twitter&$J$2&name’$L$28assigned&$N$2 combines each of the CRM data points with the “chunked”
Tweet we created in the formula row. The & sign is for combining two text values with each other in
one cell.

Here’s an example of what you get:

@moblized1234 Hey Mike Grubbs, Thanks again for connecting! How was your chat with
Danny?
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[ o A G H J < L M N
Assigned Tweat Copy
Danny What's Your Twitler Handle? Hey Full Name, Thanks again for connecting! How was your chat with Danny’|  Tweet Parts (@Handle) Hey (NAME)onnecting! How\SSIGNEI ?
Matt @michaeldgrubbz Hey Michael Grubbs, Thanks again for connecting! How was your chat with Matt?
Danny @moblized 1234 Hey Mike Grubbs, Thanks again for connecting! How was your chat with Danny?
Danny @ZapierTesting Hey Johnny Lightning, Thanks again for connecting! How was your chat with Danny?
Danny @TheGooglator Hey Google Docs, Thanks again for connecting! How was your chat with Danny? The formULa W”l a | TO a” futu re rows
Danny @McScroogeGold Hey Donald Duck, Thanks again for connecting! How was your chat with Danny? pp y !
Matt @B3NJ4MINIEY Hey Benjamin Button, Thanks again for connecting! How was your chat with Matt? automa“ca”y Creat”’]g your TWEBtS'
Mike @mdrkeTerB989 Hey Mark Eterman, Thanks again for connecting! How was your chat with Mike?
Mike @mrmickey1414 Hey Mickey Mouse, Thanks again for connecting! How was your chat with Mike?
Danny @InflateGate58 Hey Bill Gates, Thanks again for connecting! How was your chat with Danny?
1]

You can either hide your “Tweet Parts” section or leave it unhidden so you can make quick changes.

Now, you can do one of two things:

1. Copy the text and paste it into your Twitter client of choice and send the Tweets one-by-one
2. Make your life easier and send your Tweets (nearly) directly from Google Sheets

Let’s do the latter!

3. Add a “Tweet This” link for each Tweet
Since we’re managing customer information from our sheets CRM, it makes sense that we could interact with
the customer directly from the spreadsheet.

We can accomplish this by using a Twitter “Intent” URL, which lets you pre-populate a Tweet with a string
of text in the URL.

A Twitter Intent URL is structured like this:
https://twitter.com/intent/tweet?text= + anything you want to say!

You could use this URL anywhere to quickly send Tweets without jumping into Twitter. Instead, what happens
is that when you click the link it will either pop-up a window or open a new tab to quickly publish your
Tweet—no typing required!
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What's happening? clicked, complete with your Tweet

@michaeldgrubbz Hey Michael Grubbs, Thanks again for connecting! How was your chat with Matt?

s

0‘0

Just click to Tweet!

TIP: You could also use this trick to create Tweet-able links in your blog posts for people to
“Tweet This” and help drive up engagement / shares.

In this example, we’ll wrap the Twitter URL with another HYPERLINK() function (just like the “Add New”
customer from the CRM section).

Here’s what the complete formula would look like:

=ARRAYFORMULA(IF(twitter<>"" HYPERLINK("https://twitter.com/intent/
tweet?text="8&E2:E, "Tweet This"),""))

o =ARRAYFORMULA(IF(twitter<>"", checks if the customer has a twitter in the CRM sheet.
o HYPERLINK("https://twitter.com/intent/tweet?text="8E2:E, adds our completed dynamic Tweets
in column E to the end of the Twitter Intent URL.

e "Tweet This"),"")) sets “Tweet This” as the text to show in the cell, and “” is what is returned if there
is no twitter account for that contact row.

One of the most frustrating things about trying to automate any Twitter task is the character limit. Especially
when you are dynamically generating Tweets in this way, you’ll want to know how many characters are in
your Tweets so that you can try to account for the variability of the input data.

4. Add a character counter to monitor Tweet length

This counter serves 2 purposes:

« To let you know how long your dynamic tweets are on average (to adjust your Tweet parts to be more
forgiving of long client names, hashtags, etc).
« To use as a point of verification before automatically sending the Tweet.
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First, define the Tweet Copy column as “tweets” using the Right Click > Define Named Range function with
rows D2:D highlighted. Now you can reference it just by typing “tweets” in your formulas.

The formula for counting the length of our completed dynamic Tweets will look like this:
=ARRAYFORMULA(IF (twitter<>"" LEN(tweets),""))

o =ARRAYFORMULA(IF(twitter<>"", checks to see if the customer has a twitter in the CRM sheet
« LEN(tweets),"")) uses the LEN(), or length, function to count the number of characters in the tweets
column and “” is what is returned if there is no twitter account for that contact

Here’s what you’ll get:

D E F
Tweet
Tweet Copy Length Tweet Button
What's Your Twitter Handle? Hey Full Name, Thanks again for connecting! How was your chat with Danny 101 Tweet This
@michaeldgrubbz Hey Michael Grubbs, Thanks again for connecting! How was your chat with Matt? 93 Tweet This
@moblized1234 Hey Mike Grubbs, Thanks again for connecting! How was your chat with Danny? 89 Tweet This
@ZapierTesting Hey Johnny Lightning, Thanks again for connecting! How was your chat with Danny? 95 Tweet This
@TheGooglator Hey Google Docs, Thanks again for connecting! How was your chat with Danny? 89 Tweet This
@McScroogeGold Hey Donald Duck, Thanks again for connecting! How was your chat with Danny? 90 Tweet This
@B3INJAMINGYY Hey Benjamin Button, Thanks again for connecting! How was your chat with Matt? 91 Tweet This
@mdrke7er8989 Hey Mark Eterman, Thanks again for connecting! How was your chat with Mike? 89 Tweet This
@mrmickey1414 Hey Mickey Mouse, Thanks again for connecting! How was your chat with Mike? 89 Tweet This
@InflateGate59 Hey Bill Gates, Thanks again for connecting! How was your chat with Danny? 89 Tweet This

data affecting the length.

NOTE: If you put a URL into your dynamic Tweets it will always count as 22 characters, no
matter how long it is. Twitter treats every URL as if it were shortened, so you may need to tweak
your LEN() formula to account for this.

5. Automatically Send Followup Emails

Tweets are a great way to remind your contact about the call, but an email is an even better way to follow
up and continue the conversation in-depth. Let’s have our spreadsheet automatically send an email to our
contacts the 3rd day after they have been contacted by our sales representative.

A simple way to do this is via a Zapier Google Sheets integration. The logic behind the Zaps will be:

*When the Contact has been contacted, wait 3 days then email them™*


https://zapier.com/zapbook/google-sheets/
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We'll use a multi-step Zap for this that watches Google Sheets for a new entry, then waits for 3 days and
creates the email.

One preliminary step we must take is to bring our “Contacted” column into our Social Media sheet via an
ARRAYFORMULA( ).

In this case, =ARRAYFORMULA(contacted) imports the named range contacted from the CRM sheet.

D E F G
Tweet
Tweet Copy Length Tweet Button | Contacted

What's Your Twitter Handle? Hey Full Name, Thanks again for connecting! How was your chat with Danny” 101 Tweet This ¥
@michaeldgrubbz Hey Michael Grubbs, Thanks again for connecting! How was your chat with Matt? 93 Tweet This y
@moblized1234 Hey Mike Grubbs, Thanks again for connecting! How was your chat with Danny? 89 Tweet This y
@ZapierTesting Hey Johnny Lightning, Thanks again for connecting! How was your chat with Danny? 95 Tweet This ¥
@TheGooglator Hey Google Docs, Thanks again for connecting! How was your chat with Danny? 89 Tweet This ¥
@McScroogeGold Hey Donald Duck, Thanks again for connecting! How was your chat with Danny? a0 Tweet This n
@B3NJ4M1N999 Hey Benjamin Button, Thanks again for connecting! How was your chat with Matt? 91 Tweet This n
@mdrke7er8989 Hey Mark Eterman, Thanks again for connecting! How was your chat with Mike? 89 Tweet This
@mrmickey1414 Hey Mickey Mouse, Thanks again for connecting! How was your chat with Mike? 89 Tweet This
@InflateGate59 Hey Bill Gates, Thanks again for connecting! How was your chat with Danny? 89 Tweet This

Imported from the CRM Sheet

This is important for the next step, which relies on changes to the Contacted column to trigger our Zapier
automation. You’ll also need one more thing: email addresses. So repeat that step, and add another new column
with =ARRAYFORMULA(email) to pull in each contact’s email address.

Now it’s time to make our Zap. If you’ve never set up a Zap or don’t have a Zapier account, sign up for free,
then run through the setting up your first Zap guide.

Once you’ve got the hang of the interface, create a new Zap, select Google Sheets as the Trigger app, and
choose Updated Spreadsheet Row as the trigger.


https://zapier.com/sign-up/
https://zapier.com/help/creating-zap
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Now you’ll need to connect your Google Sheets account if you haven’t already. Then, select the spreadsheet
and worksheet you want to watch—in this case, select your CRM spreadsheet, and the Social Media sheet.

You can then specify which column to watch for changes, and we want to watch the Contacted column for
that. Click the down arrow under Zapier’s Trigger Column field, and find the column which should be labeled
gsx$contacted.

Dashboard — Set Up Trigger Options - vour zar1s @) oOFF

Name your Zap...

TRIGGER Set U_:_-' CTOC"%LD Sheet
~
1. Updated Spreadsheet Row I Sieindsiicit i

B Google Sheets - .
Google Sheets CRM Tuterial demo A4
# Updated Spreadsheet Row

Zapier Sheet
: apler sheets ﬂWorkshEet:u-.-q:;ruh

= Edit Options
Social Media v
>
B Trigger Column (opt
ACTION
f 2. Set up this step hd
gsx$contacted ~
W GetHelp R

For the next step of your Zap, you’ll add an action, select the Delay by Zapier app, and then choose Delay
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For. Then, tell the Zap to delay for 3 days by entering 3 in the Time Delayed For (value) field and then select
Days in the (unit) field.

Dashboard — Set Up Delay For Template 3 Your zapis @ oFf

& Zzapier Sheets
= Edit Options

A Testthis Step

+ C  Malavs b s - Tirmo
Set up Delay by Zapier Time
ACTION Z| Time Delayed For (value) (required)
2, Delay For A
Delay by Zapler 3 %
# Delay For
= Edit Template Z| Time Delayed For (unit) (required
Days v
X Delete

2 Refresh Fields

W GetHelp Respons

Now we’re ready to make our email. Add one more step to the Zap, and this time either select the Email
by Zapier or the Gmail app to send your message. Select the account, as normal, then you can setup your
automated email template.

Click the + icon beside the To field, and select your Email column from Google Sheets. Add a subject, then
write the body of your email message. You can include your contact’s name in the body—again, using the +
icon on the right to copy the field from Google Sheets—and add any other personalizations you want.
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Name the Zap and save it to turn it on. Then, you’re done: when your sales team marks someone as “contacted,”
the Zap will notice the change to your Contacted column value and set your email to be sent in 3 days.

With this new CRM, you can now add contacts to your CRM from a form, import data about them from the
web, and automatically reach out via Twitter and email.

Pretty cool right?

And that’s just the tip of the iceberg. You can take what you’ve learned from this tutorial to create your own
Google Sheets systems.

Whether you are trying to replace an existing workflow, or just can’t find a tool that does quite what you
need, Google Sheets is flexible enough for the job.

Connect Google Sheets to Your Other Apps

Web scraping and adding data with forms can make some powerful-yet-simple apps to manage contacts—or
anything else you want. And with Zapier’s Google Sheets integrations integrations, you can make your app
do more work on its own automatically.

Say you want to also add followup tasks to your project management tool, or want to add contacts to your
email marketing app. Just link your spreadsheet to Zapier, and it can watch for new entries and add those to
any other app.



https://zapier.com/zapbook/google-sheets/
https://zapier.com/learn/ultimate-guide-to-project-management/best-project-management-software/
https://zapier.com/learn/ultimate-guide-to-email-marketing-apps/best-email-newsletter-software/
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Beyond using Google Sheets with Zapier, you can also custom code your own scripts to build advanced
functions, connect with web services, and turn your spreadsheets into nearly-full-fledged custom applications.

We’ll dig into some of those possibilities in later chapters. But first, let’s take a side-step and look at some
of Google Sheets’ best hidden features for importing text, formatting and translating it, and turning it into
outlines, HTML tables, and more so you can create even more advanced apps on your own.

Enjoy? Read and share this chapter online: zpr.io/uB9j

Written by freelance writer Michael Grubbs.


http://zpr.io/uB9j
https://twitter.com/MichaelDGrubbs

Chapter 4: Write Faster with
Spreadsheets—10 Shortcuts for Composing
Outlines, Research, HTML Tables and More

ht=

fifty three $53.00
http://fiftythree.com/

If numbers are involved, a spreadsheet’s the tool for the job. But spreadsheets can also be used for so much
more: storing contacts, compiling research, organizing outlines, and more.

With the right functions, you can use spreadsheets to quickly craft HTML, format links in Markdown, translate
text, clean up copy, or perform any other bulk text editing task where you just might need a bit of automation
help.

To take your spreadsheet-powered CRM further, or to make your own spreadsheet tools, here are the best
text-focused features built into Google Sheets.

89


https://zapier.com/learn/google-sheets/spreadsheet-crm/
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Maintain an Editorial Calendar
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If there’s one part of the writing process that seems obvious for a spreadsheet, it’s the editorial calendar. With
dates, word counts, topics, status, and budget to manage, a spreadsheet’s unlimited columns and number-
centric tools seem perfect.

And they are. Just take a bit of time to add columns for everything you want to track, something that will be
a bit different for every blog, newsletter, or online publisher. You might not need to fill in each column for
each piece: I've used a Month column that only gets filled in once to group articles by months, something that
could work equally well to organize a blog’s articles by day or a publisher’s content by author.

Then, if you want to hide old items, you could select the rows under that month or another category, right-
click and select Hide Rows. In Smartsheet, another spreadsheet app with more project-centric tools, you could
indent the rows under that category—select the rows, then click the Indent button—and view or hide them
with a click.

S e T s % .0 .00 123+ Aral - 10

c
Post Title

Screenshot Tools, Tips and Shortcuts
How to Pick Project Management Software
Best Outline Apps

Infusionsoft Everything

Manage Multiple Accounts

Wel ing Busi Develop t Leader Cody Jones

The Best Project Management Software

How to Manage Personal Tasks with a Project Management App
Spreadsheets for Wiriting

Zapier Tips

=
o
da

s} E
Status

5 | Published
Published
To Update
Published
Draft
Total:
6 Published
6 Published
4/7/2016 | Published
6
6

4/10/2016 | Draft
4/13/2016 Draft

Price

$100
$80
$60
3110
$30

| - More -

A- -

G 1
Budget
$300

Add another rule

Minpaint

Number 2 200 2.-
—

Number 2 300 2. -
“ Cancel


http://help.smartsheet.com/customer/portal/articles/504734-hierarchy-indenting-outdenting-rows
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Have to keep this month’s content within budget? Just add a column to track how much each article costs,
along with perhaps another column to track this month’s budget. You can then easily use =sum() and =Cel1-
Cell functions to see how close you are to your budget. Or, add conditional formatting from Format ->
Conditional Formatting... to have Google Sheets change the color of your budget cell once you’ve gone over
budget.

Track Published Items

Once you’ve planned the content you’ll publish, it’s time to turn those ideas into new posts. There’s no reason
to paste your titles into WordPress manually; app integration platform Zapier can watch for new rows—or
newly updated rows, to watch for only article ideas that are Approved, say—and turn them into new draft
posts in WordPress.

Another step on the Zap could then add the link to the draft post back to the spreadsheet. All you’ll have to
do is paste in your article content and hit Publish.

Zapier Integrations:

+ Create new WordPress posts from new Google Sheets rows
+ Log WordPress posts to a Google Sheets spreadsheet

Or, you could link your spreadsheet to your productivity app. Say you use Trello to manage your article ideas
and editorial process—the way the Zapier team manages our blog queue. Whenever a Trello card gets moved
to the Published list, a Zapier automation could log that published article to your spreadsheet for a record of
what’s been published, including information such as word count and author.

Zapier Integration:
« Save new or moved Trello cards to a Google Sheets spreadsheet

If you use the spreadsheet to manage your blog’s schedule and editorial workflow, a Zapier automation could
create events in your calendar app or tasks in your to-do list app so you remember to edit and publish articles
on time.

Zapier Integrations:

« Create Google Calendar events from new Google Sheets spreadsheet rows
« Turn Google Sheets rows into Todoist tasks
» Turn Google Sheets spreadsheet rows into Wunderlist tasks

No matter what you want to track about your editorial process, a spreadsheet can be a valuable tool since it’s
so flexible. Then, just open another sheet, and it’s time to start outlining the content you’ve planned.

Related: For inspiration about your editorial calendar, check out Zapier’s Guide to Writing and
Publishing with a look at how we manage our editorial calendar and turn our blog posts into
eBooks like the one you're reading right now.


https://zapier.com/
https://zapier.com/app/min/3150/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/9354/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/blog/how-to-publish-ebook/#blog
https://zapier.com/app/min/1887/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/138/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/8649/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/8650/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/blog/how-to-publish-ebook/
https://zapier.com/blog/how-to-publish-ebook/
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Build Detailed Outlines

A B Cc
Spreadsheets for Writers Notes:

Maintain an Editorial calendar in Google Sheets
list articles
organize by month, book, category, ete. perhaps add exira row on left for organization
add fees and calculate budget mention simple math functions for this
possibly share spreadsheet for public editorial calendar

Outline in a spreadsheet
indent for sub-points, or add them in seperate column

Use Google Translate to identify text or translate directly

Pull in data from websites and RSS

Create links automatically

Combine text from various cells

Display images from a URL

Combine cells to make complex HTML tables

© o N e s W N =
[N}

L
== T = S

Once you’ve planned your content strategy, it’s time to start turning those ideas into reality. First, outline
your thoughts to make sure your articles and chapters flow in a logical order.

There are tons of outlining apps designed to organize ideas into detailed blueprints, and they’re great. But so
is your spreadsheet.

Just type each idea you want to cover in its own row—or if you’ve already typed it in a list, just paste the
whole list and the spreadsheet app will add each to a new row automatically. Then, click and drag on the
left-hand row number to rearrange ideas into the flow your piece needs.

With that done, it’s time to flesh out the points with sub-points and notes. Perhaps add a new column for
point numbers on the left, then add new rows for each sub-point with spaces or dashes to indent sub-points
and make them stand out. Alternately, you could add sub-points in the next columns on the right, though that
might be a bit harder to read.

You might not even need to type in your outline ideas. Spreadsheet integrations could bring in ideas from
blog posts you read and notes you take. Perhaps favorite relevant tweets or add ideas to a project notebook,
then have Zapier add those as new rows in your outline spreadsheet. All you’ll have to do is organize the
ideas once you’re ready to write.


https://zapier.com/blog/best-outline-software/
https://zapier.com/zapbook/google-sheets/
https://zapier.com/zapbook/zaps/191/save-my-favorite-tweets-to-a-google-spreadsheet/
https://zapier.com/zapbook/zaps/9987/create-new-rows-on-google-sheets-for-new-notes-on-evernote/

Chapter 4: Write Faster with Spreadsheets—10 Shortcuts for Composing Outlines, Research, HTML Tables and More 93
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Single color Color scale
A B (o]
1 Spreadsheets for Writers Notes: Apply o range
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4 list articles
5 organize by month, book, category, efc. perhaps add extra row on left for organization Eomsticaisl
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16
17

Want to make sub-points stand out even more, without adding formatting by hand every time? Just
standardize the way you list sub-points—here, I've added four spaces before sub-points, but you could use
a dash or other symbol instead. Then, add Conditional Formatting as above, only this time, apply it to your
entire outline and have it watch for those spaces, dash, or other symbols. The formatting could add a new
color, make the text italicized or bold, or add a background color.

For notes, those right-hand columns are a handy place to write extra text, list links that need to be mentioned,
and gather anything else that your piece requires. You can then hide columns or sub-rows as needed to focus
on your core outline—or, use conditional formatting again to make certain notes stand out from the others.

Import Data From Websites and Feeds

Most Recent Articles on Techinch Most Recent Zapier Blog Post Top Hacker News Articles
The Best Pn
Howto T

ect Management Apps

hots Anywhere | b T
How Suppart 1; ake 3 E My friend wiho mad
Would You Ride a
How to Edit Anything on Any Webpage

nch.comfead

ject Management Apps

11 How to Take Great Screenshots Anywhere
12 How to Do Great Customer Support

3 Markdown for Beginners
14 How to Edit Anything on Any Webpage

5

6

7

edpress me&utm_camp:
mpaign=Feedi3,

jpress. me&utm_campaign=Fead%3A+techinch

Want to pull articles and research into your spreadsheet? Google Sheets can import data from the web,
automatically, right into your spreadsheet. You’ll never have to open a new tab to research again.

Start off by adding links to your ideas. Just select a cell in your spreadsheet, and press CMD+K or Ctrl+K
to add a link. Google Sheets will search Google for that item, and return the first two search results for that
phrase. You can then open the search result in a new tab, or just select the result to link that text to the site.
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19 | Typeform Review
2(
2° Text Typeform Review
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= Link Typeform Review ‘ m

24 B Typeform Review: Pricing, Feat...

25 https://zapier.com/zapbook/typefarm. ..

26 B Typeform Review 2016 | Best S... https://zapier.com/zapbook/typeform/review/
7 http://survey-software-review.toptenr...

28

Or, you can import the most recent articles from an RSS feed right into your spreadsheet. Just enter your RSS
feed in a cell, such as https://zapier.com/blog/feeds/latest/ for the Zapier blog. Then, in the next cell,
enter this formula to import the titles of the five most recent articles (change A1 for the cell you entered the
feed link in, and 5 for the number of results you want to import):

=importfeed(A1,"items title", false, 5)
Then, to get the links to those articles, enter this in the next column:
=importfeed(A1,"items URL", false, 5)

Now you’ve got the links and titles of posts. To turn them into linked text, enter this in another column,
changing B2 for the cell with your article link and A2 for the cell with your article title.

=hyperlink(B2,A2)

With a bit of tweaking, that’ll give you an RSS feed reader right inside Google Sheets, much like in the
screenshot at the start of this section. You could use the IMPORT functions in Google Sheets to also import
HTML, XML, or data from another spreadsheet. Jump back to the guide on scraping data with Google Sheets
in Chapter 3 for more details on how to import specific data directly from links, and more.


https://zapier.com/learn/google-sheets/spreadsheet-crm/#scraping

Chapter 4: Write Faster with Spreadsheets—10 Shortcuts for Composing Outlines, Research, HTML Tables and More 95

Spreadsheets for Writers

Add-ons

“ -

Twitter Archiver
Twitter sffered by hitps:ctrig.org e

Archi\r'er Twitter for any keywor I t. n " " Weets ir t v R
Knoema Data Finder m

) dusdbyivomacon i

B y Ak
Advanced Find and Replace m
affered by waw.ablebits.com factivit

Random Generator m
Random affered by waw.ablebits.com .

ek

Or, you can install Google Sheets Add-ons to find extra info online and directly import it into your spreadsheet.
We’ll look at add-ons more in chapter 6, but for now, here are some of the best add-ons to search Twitter,
Wikipedia, maps and other datasets:

« Wikipedia Tools: search Wikipedia, find synonyms for words, find categories, and import links and
facts directly from Wikipedia.

« Knoema Data Finder: look up data and statistics about the world—including population and GDP—and
insert them into your spreadsheet.

« Twitter Archiver: save Tweets to a spreadsheet, search Twitter, and research hashtags inside Google
Sheets.

« Geocode by Awesome Table: turn addresses into latitude and longitude values, then can display those
locations on a map in your spreadsheet.

+ Advanced Find and Replace: search for text, formulas, and notes in specific parts of your spreadsheet—
and replace them in only those sections if needed.

Gather Data Elsewhere and Import it to Your Spreadsheet
Want to gather new info over time, and have it added to your spreadsheet? Spreadsheet integrations could
bring in ideas from the news, notes, and notifications.

As you’re researching your article ideas, you could favorite relevant tweets or add ideas to a project notebook,
then have Zapier add those as new rows in your outline spreadsheet. All you’ll have to do is organize the ideas
once you’re ready to write.

Zapier Integrations:

+ Log RSS feed updates as new rows in Google Sheets


https://zapier.com/learn/google-sheets/best-google-sheets-addons/
https://zapier.com/learn/google-sheets/best-google-sheets-addons/
https://chrome.google.com/webstore/detail/wikipedia-tools/aiilcelhmpllcgkhhpifagfehbddkdfp?hl=en
https://chrome.google.com/webstore/detail/knoema-data-finder/ojbponfhjmmkkaabnldenclfmhcgmnak
https://chrome.google.com/webstore/detail/twitter-archiver/pkanpfekacaojdncfgbjadedbggbbphi?hl=en
https://chrome.google.com/webstore/detail/geocode-by-awesome-table/cnhboknahecjdnlkjnlodacdjelippfg?hl=en
https://chrome.google.com/webstore/detail/advanced-find-and-replace/gdjlbafkoaciknlpkmiedbgnlfglcpmb?hl=en
https://zapier.com/app/min/1442/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
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+ Save Pocket tagged items to rows in a Google Sheets spreadsheet
+ Create new rows on Google Sheets for new notes on Evernote
» Save liked Tweets to a Google Spreadsheet

Add Data Quickly With a Form
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Another great way to gather research is with a form or survey. Google Sheets comes with a tool for that built
in, which we looked at in chapter 2: Google Forms. Just click Tools -> Create a Form, and a new tab will open
with a form editor where you can add questions to a quick form or survey.

Save and share the form, and Google Sheets will automatically save the responses back to a new sheet in your
original spreadsheet. Then, you can incorporate those responses into your research, right alongside everything
else you’ve pulled into your spreadsheet.

Be sure to jump back to chapter 2 for an in-depth guide to all of Google Forms’ features if you haven’t read
it already:.

Tip: Do more with your form—perhaps get notified when new entries are added, or automatically
email people who fill out your form—using Zapier’s Google Forms integrations.


https://zapier.com/app/min/5333/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/9987/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/191/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/zapbook/google-forms/review/
https://zapier.com/learn/google-sheets/how-to-use-google-forms/
http://zapier.com/zapbook/google-forms/
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Identify and Translate Text

] , =GOOGLETRANSLATE(ET,"th","™")
A B C D

1 A vaincre sans péril, on triomphe sans gloire mﬁ’lu.ﬂ' BHREREEE.
2 To win without risk is to triumph without glory ‘FGC'GGLETRANSLATE.(. ,Uth", ") | The book house of gold.
3 GOOGLETRANSLATE ( text, ~ X
4 [source_language], [target_languagel)
5 Example

GOOGLETRANSLATE( "hola”, "es", "en")
6

Summary
7 Translates text from one language into another
8 text
g The text to translate.
10 source_language - [optional]

The two-letter language code of the source language, e.g.
11 "en” for English or "ko" for Korean, or "auto” to auto-detect

the language.
12

target_language - [optional]
13 The two-letter language code of the target language.
14 Learn more about GOOGLETRANSLATE
15

Come across some text you can’t read in your research, or want to reference a quote in another language
and include a rough translation? Google Translate is built into Google Sheets, and can identify or translate
languages for you on the fly.

Identifying languages is simple. Just enter the text you can’t read in a cell, then use the =DETECTLANGUAGE (A1)
function, replacing A1 with your text cell. Google Translate will then tell you the two letter code of that
language: en for English, th for Thai, fr for french, and so on.

Then, to translate text, just enter the following formula:
=GOOGLETRANSLATE (A1, "auto", "en")

That will translate the text in cell A1 into English, after auto-detecting the language. You can replace auto
with the two-letter code for the language if you already know what language the text is in, or swap en for
any other language for other translations.
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Jx | =GOOGLEFINANCE(”AAPL”,”price”,DATE(2016,1,1),DATE(2016,4,19), "weekly")
A B C

8 |Date lCIose

9 1/8/2016 16:00:00 96.96
10 1/15/2016 16:00:00 97.13
11 1/22/2016 16:00:00 101.42
12 1/29/2016 16:00:00 97.34
13 2/5/2016 16:00:00 94.02
14 2/12/2016 16:00:00 93.99
15 2/19/2016 16:00:00 96.04
16 2/26/2016 16:00:00 96.91

Need to translate cryptic financial terms instead of languages? Google Finance’s integration into Sheets is
just what you need. Just enter =GO0GLEF INANCE () with your stock ticker, the item you wish to track, start and
end date, and daily or weekly for how you want the data summarized, and you’ll get a table of stock results
automatically. That might be helpful for your next article on the stock market.

Format Text Automatically

= o T s % .0 .00 123- - 1 - |B 7 5 A. &-H- =+ 4 |-
fi =PROPER(trim(A1)) %4 Reset
A B [0 D E ]
Spreadsheets For Writers HEEN
1 spreadsheets for writers preadsheets For Wiriters = :pg ™ Y EEEm
2 PROPER(trim(A1))
3 PROPER(text_to_capitalize) D
4 Example |
5 PROPER( "united states") ==| .EQH==
6 Summary ..........
Capitalizes each word in a specified string
? e e END DEEENE
4 Xt_to ze
8 The tex h will be returned with the first letter of each Custom...
g word in uppercase and all other letters in lowercase.

Learn more about PROPER

- o

Conditional formatting...

]

a9

Now that you’ve got an outline, notes, and research in your spreadsheet, it’s time to get things cleaned up.
You've likely used the formatting options in spreadsheets before—if not, they work the same as you’d expect
in most other office applications. Select the font, size, and weight you want for text, pick text and background
colors, center or left/right align text, and so on. Or, use the Conditional Formatting tool we’ve already looked
at to change colors and font style based on what’s in each cell in a spreadsheet.

One spreadsheet-specific formatting option to try is the Borders option. That lets you choose which—if any—
borders to show around cells, as well as what color and thickness the lines should be. Turn off all the borders,
and your spreadsheet will look like a plain document.
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Then, Google Sheets can help automatically clean up your text to make it look the way it should. Here are
some of the best Text functions you should use (and replace A1 with text you want to clean up, as usual):

« Clean(A1) to remove non-printable ASCII characters, useful for making imported HTML or XML look
better.

« Left(A1,5) or Right(A1,5) to return the first or last 5 (or any number you want) characters from a
string, respectively.

« Trim(A1) to remove any leading or trailing spaces.

« Upper(A1) to make all of the text uppercase.

« Lower (A1) to make all of the text lowercase.

« Proper(A1) to capitalize the first letter of each word.

+ Substitute(Al,"text_to_search_for","text_to_replace_with") to replace something in a string
with something else (say, to replace one word or remove all spaces).

You can also combine text functions. For example, in the image above, =Proper (Trim(A1)) both removes the
spaces from the end of the string and capitalizes the first letter of each word.

Tip: Want to format numbers and turn them into nice tables? Jump back to the Spreadsheets 101
tutorial in chapter 1 for that and other spreadsheet basics.

Combine Text from Cells

_ j’_{_- =CONCATENATE("https://zapier.com/blog/best-project-management-software/#", lower(A9))

A B Cc D E F G
5  Asana https://zapier.com/blog/best-project-management-softiware/#asana
6 Dapulse https://zapier.com/blog/best-project-management-software/#dapulse
7 Insightly hitns://zanier com/bloa/best-nroiect-mananement-software/#insightly
8 Toodledo ht_tps:!f_zapier.com,f_blogfb_esf—project—_manag... tware/#toodledo
9 Allthings ]-=CONCATENATE("httpS:;’fznpmr.com,”b]og_fbest—proj(?ct—'na!mgmrnnt-softnnarc—!#",lower( ))||
10

There’s another super handy Text function for combining text from multiple cells in a spreadsheet:
Concatenate. All it does is combine the text you enter or select form cells together into one cell. If you
want to add spaces, you’ll need to add them manually: concatenate just combines the exact text you give it.

Here’s how it’s handy: Say, for instance, you’'ve written an article and included anchor tags so readers can
jump to a specific section of the article from your index—perhaps using a lower case version of the app’s
name, without spaces, for the anchor tags. You want to make an index for that article, which means you need
a list of links with each of those anchor tags and your article’s URL.

Instead of writing each anchor in lowercase by hand, just paste your list of Anchors into a spreadsheet. Then,
add the following formula, substituting your link for URL and your anchor’s cell in the spreadsheet for A1:


https://zapier.com/learn/google-sheets/google-sheets-tutorial/
https://zapier.com/learn/google-sheets/google-sheets-tutorial/
https://www.w3.org/MarkUp/1995-archive/Elements/A.html
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=concatenate("URL",A1)
Or, if you need to make the anchor text lowercase and remove spaces, this function would do the trick:

=concatenate("URL", lower(substitute(A1," ","")))

Create Linked Text

=hyperlink( ,A10)

A B c D E F G

5 Asana https://zapier.cor Asana

6 Dapulse https://zapier.cor Dapulse

7 Insightly https://zapier.cor Insightly

8 Toodledo https://zapier.cor Toodledo

9 Allthings https://zapier.cor Allthings

e S ————

10 :_Microsoﬂ Word ] ttps://zapier.con|=hyperlink( ,A1?,-)|

11 HYPERLINK(url, [link_label])

12 Example

13 HYPERLINK("http://www.google.com/",
"Google™)

14
Summary

15 Creates a hyperlink inside a cell.

16 url

17 The full URL of the link location enclosed in quotation marks,
or a reference to a cell containing such a URL.

18
link_label - [optional]

19 The text to display in the cell as the link, enclosed in
quotation marks, or a reference to a cell containing such a

20 label.

21 Learn more about HYPERLINK

29 |

Once you’ve got the links, you might want to link the original anchor names with their new anchor links.
The Hyperlink function can do that for you. Just enter the following, with your link and text instead of B1
and A1, respectively:

=hyperlink(B1,A1)

That will make a new column with the original text linked to your new links—and it’d work equally well with
any list of plain text and links.

If you write in Markdown, you could instead use concatenate to add brackets and parenthesis with this
function, where again A1 is your plain text and B1 is your link:

=concatenate("[",A1,"](",B1,")")
Note: Concatenate could be used to add markdown header and list formats to your outline. See

Zapier’s Markdown guide for a refresher on formatting, then tweak the concatenate function
with the characters you need.


https://zapier.com/blog/beginner-ultimate-guide-markdown/
https://zapier.com/blog/beginner-ultimate-guide-markdown/

Chapter 4: Write Faster with Spreadsheets—10 Shortcuts for Composing Outlines, Research, HTML Tables and More 101

Want to only show the linked text, instead of three columns with plain text, plain link, and linked text? Just
select the text and link columns, right-click on the top header, and select Hide Columns. The text will still be
in your spreadsheet, and will still work in functions, but it’ll be out of sight to keep your spreadsheet clean.

A

Asana

Dapulse

Toodledo
Allthings

10  Microsoft Word

13
14
15
16

5
6
7 Insightly
8
9

r~ - D E

https://z Cut |(https://zapier.com/blog/bes
https://z  Copy ie](https://zapier.com/blog/be
https:/z Paste ly](https://zapier.com/blog/be
https:/z do](https://zapier.com/blog/b
https://z Paste speclal g ys](https://zapier.com/blog/be
https://z oft Word](https://zapier.com/

Insert 2 left

Insert 2 right

Delete columns A - B
Clear columns A-B

Hide columns A- B

Or, want to save only the new links, without the functions and original text? Just copy the original hyperlinks
you made, paste them in a new column, then click the paste icon that shows up and select Paste values only.

1 =HYPERLINK(

Display Images From a URL
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¥ Microsoft Project
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Manage team ner in a list, spreadsheet, or Gantt chart view. 5 users $49/mo. for 5 users

Work on p | project management toal,

Outline and plan projects with familiar B osoft Office tools. $33/mo.fuser

Spreadsheets aren’t just for numbers, and they’re not just for text either. They’re also great places to organize

images.

Most spreadsheet apps let you drag-and-drop images into your spreadsheet, perhaps to add a company logo
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to your financial statements. But Google Sheets also lets you import images directly from a link with its image
function.

We recently used this in the Zapier team to build a project management apps comparison tool. I added each
icon to Zapier’s site, and listed them in the spreadsheet—right after the anchor links ’'d made with the trick
in the previous step. Then, I added both a hyper1ink and image function, as below, to both import the image
and have it linked to the correct section of our article:

=hyperlink(A1,image(B1))

The image function also lets you set a mode, height, and width. The mode could let the image automatically
fit the height or width of the cell, or you could just set the size manually.

There’s only one problem with these online images: they only work in Google Sheets. They’re perfect if you
want to view the spreadsheet online or export it as a PDF, but if you save it in Excel format, the images won’t
be saved with it.

Insert image X
Upload Take a snapshot By URL | Your albums Google Drive Search
Go g|e T Bangkok Q

move - [P W o O
sled for commercial reuse with modifs on. Learmn more

Cancel

Alternately, if you want a full-sized image, just select Insert -> Image then upload a photo or search for one
in Google Images. You can then resize and position the image anywhere on your spreadsheet, as it’s not tied
to any specific cell. The image function is handy for pulling in a number of images at once and showing them
in a table; the Insert Image tool is better for adding full-sized images for a nicer looking report.

Tip: Want more advanced functions? Dig into the hundreds of other functions in Google Sheets
with the Google spreadsheets function list, which includes a filter to search for the exact function
you need.


https://zapier.com/learn/ultimate-guide-to-project-management/best-project-management-software/
https://support.google.com/docs/table/25273?hl=en
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Create HTML Tables For Your Blog Posts

& e~ T s % g 00 123-  Aral - W - B

fr | =CONCATENATE("<

NER <tr><td class="key"><a href="

=CONCATENATE( "< . key
alt=", gl - - 48"
<tr><td class="key"><a href="#insightly">Insightly</a></td><td><a href="#insightly"><img src="https.//zapier.cachefly.net/storage/servi 26f7fcbd9435ef4 je06ffcbb.126x128.png
<tr><td class="key"><a href="#toodledo">Toodledo</a></td><td><a href="#toodledo"><img src="https://zapier.cachefly. gelservices/Sa0ffd530a44250099925759ab84ebe3. 128x128

<tr=<td class="key"><a href="#allthings">Alithings</a></td><td><a href="#allthings™><img src="https:/izapier.cachefly.net/storage/services/146665368a01397677ec1c1befa08715.128x128.p

© @~ ® s W

<ir=<td class="key"><a href="Bwrike">Wrike</a></td><td><a href="#wrike"><img src="hitps.//zapier.cachefly.net/storage/services/43d623cccd 30dabfd2acb07a25104a59.128x 128 png™ alt="
<tr><td class="key"><a href="#pagico">Pagico</a></td><td><a href="#pagico"><img src="https//zapier.cachefly.net/storage/services/c2i802d61e98b745cb40107alb17b644 128x128.png" :

- a

<tr=><id class="key ><a href="#microsoft">Microsoft Project</a></ld><td><a href="#microsoft"><img src="https./izapier.cachefly.net/storage/photos/7216/0a08faec296¢31e4a124¢226053.pr

It’s time to bring everything you’ve learned together. Let’s turn your outline or list of ideas into an HTML
table that you can add to your finished blog post—complete with anchor links to the correct sections of your
article.

Just set up your spreadsheet with each thing you want to include in the table (like text, links, and images),
then kick off a concatenate function. For example, in our Project Management app roundup, we include a
table with each app’s name, icon, description, and price. Here’s the table we started with—column D was
made using the Format tools mentioned above:

J
A B c D E F G

1 Category Name lcon Article Link Quick Description Free for: Pricing from:

2 Task Lists

3 Asana hitps:/izapier.cac #asana Manage team to-dos with updates and progress graphs to keep everythi 15 users $5/mo.fuser

4 Dapulse hitps:/izapier.cac #idapulse Visualize each task’s progress with labels that show the results of each task's workflow.  $25/mo. for 5 users
5 Insightly hitps:/izapier.cac #insightly Focus on contacts and projects together in one app. 2 users $12imo.fuser

6 Toodledo https://zapier.cac #toodledo Outline everything your team needs to do in task lists with custom fields. = private tasks  $14.99/yr./user

7 Allthings https:/izapier.cac #allthings Write down tasks in simple lists, add extra data with custom fields, then = users, 5 projec $9.95/mo./user

&  Gantt Charts

9 Wrike https:/izapier.cac #wrike Manage team and perscnal tasks together in a list, spreadsheet, or Gan 5 users $49/mo. for 5 users
10 Pagico hitps:/izapier.cac #pagico ‘Work on personal and team tasks in a professional project management tool. $50/user

1 Microsoft Project hitps://zapier.cac #microsoft Outline and plan projects with familiar Microsoft Office tools. $33/mo.Juser

12 Sandglaz hitps:izapier.cac #sandglaz Plan scrum sprints in kanban-style lists for a simple way to prioritize tasks and plan the we $5/mo.juser

13 Ahal https://zapier.cac #aha Turn ideas into broad goals, detailed schedules, and individual releases 5 users with Star $59/mo juser

14 Runrun.it hitps:/zapier.cac #runrun Know when your projects will actually ship with automatically calculated delivery dates.  $10/mo fuser

To make that into an HTML table, you need the code to start out the table, then <tr> sections for each row of
the table. Here’s an example of the code we need for our article table:

<div class="table-container widen">
<table class="simple">

<tr>
<th>App</th>
<th style="color:#eee;">Icon:&nbsp; </th>
<th>Best to:</th>
<th>Free for:</th>
<th>Paid plans from:</th>

</tr>

<tr>


https://zapier.com/learn/ultimate-guide-to-project-management/best-project-management-software/
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12
13
14
15
16
17
18
19
20
21
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<td class="key"><a href="#asana">Asana</a></td>
<td><a href="#asana"><img src="https://zapier.cachefly.net/storage/
photos/e44c395f06f9bba8e44a1950c@b13943.png" alt="Asana" height="40"
width="40"></a></td>
<td>Manage team to-dos with updates and progress graphs to keep
everything on track.</td>
<td>15 users</td>
<td>$5/mo. /user</td>
</tr>
</table>
</div>

The first nine lines and last two can be entered manually, but adding the other lines for each app is time
consuming at best. Instead, you can use an (admittedly long) concatenate function to fill in the blanks and
add the HTML automatically:

=CONCATENATE (" <tr><td class=","""", "key",K"""", "><a
href=","""" D1,"""" ">" Bl "</a></td><td><a href=","""" D1,"""" "><img
sTe=", MMt G, et gle=t, it BYL UMY M height=", et vagn, e
width=", """ m4r "t vy </a></ed> <kd> " E1, " </td> <kd> " F1, " </td> <td> ", G, "<

/td></tr>")

Paste that into each row with an entry for your article, then copy all of the sections and add the correct
beginning and ending HTML sections. You’ll have a fully complete HTML table in seconds.

You could alternately just export the whole spreadsheet as an HTML table, using the File -> Download as
-> Web page tool in Google Sheets or with a tool like Tableizer. But using a spreadsheet function lets you
customize the table and make it look exactly like you want—and once you’ve made the correct function for
your table style, it’ll be just as quick.


http://tableizer.journalistopia.com
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Publish Your Spreadsheets

Publish to the web

Make your content visible to

nyone by publishing it to the web. You can link to or
embed your docume nore

Link

Entire Document 3 Web page %

v Published content & settings

Or, perhaps you’d rather publish your spreadsheet itself instead of turning it into a table. There’s a number
of ways you can do that in Google Sheets:

« Export: Click File -> Download as to download your spreadsheet in Excel, CSV, web page, or PDF
formats. The PDF option is a great way to share your writing, outline, and research with others, while
the spreadsheet options are best for backing up data to use in other spreadsheet tools.

+ Print: For a bit more formatting options—though no way to export links—click the printer icon. You
can then print the sheet on paper, or save it as a formatted PDF to Google Drive.

« Publish: Click File -> Publish to the Web to get a public link to your spreadsheet to share a plain HTML
page of your spreadsheet with others. Or, click the Embed tab, copy the code it includes and paste it
into your blog to embed a copy of the spreadsheet in your post instead of making an HTML table.

Each of those options only let you share a plain, static copy of your spreadsheet. If you want readers to be
able to sort and filter through your data, though, you’ll want to actually share the real spreadsheet.

For that, click the Share icon in the top right corner, and select Anyone with the link can view from the
sharing options. Then, share the link, and anyone can view the spreadsheet, and search through the data
without changing the original layout.

For a better way to help people find the items they need, add a Filtered View from Data -> Filter View. There,
you can set which part of the spreadsheet should be interactive. Readers can then click on a column, filter it
by name or text, and see only the results they want. You could even make filter views with preset filters that
only show specific data, as an easy way to sort through massive datasets.




Chapter 4: Write Faster with Spreadsheets—10 Shortcuts for Composing Outlines, Research, HTML Tables and More 106

Spreadsheets still aren’t exactly word processors, and you’ll still want a writing app for most of your writing
work. But for research, outlining, tables, and much more, a spreadsheet is a handy sidekick that can help you
do more, in far less time.

With tools like these—along with a Google Form and the tools you learned in chapters 1 and 3 to format
spreadsheets and pull in data automatically—you can build a wide range of apps on your own, without any
coding. So let’s do just that in chapter 5.

We'll take everything we’ve learned so far, pull in data with a Google Sheets add-on, and build an automated
business analytics dashboard with just a spreadsheet.

Enjoy? Read and share this chapter online: zpr.io/uBOM

Written by Zapier content marketer Matthew Guay.


https://zapier.com/learn/google-sheets/google-sheets-dashboard-tutorial/
https://zapier.com/learn/google-sheets/google-sheets-dashboard-tutorial/
http://zpr.io/uB9M
https://twitter.com/maguay

Chapter 5: How to Create a Custom Business
Analytics Dashboard with Google Sheets

==

Data means little on its own. Open a spreadsheet packed with numbers, and it’s difficult to tell what’s
improving and where you should focus your efforts.

That’s one of the things that makes reporting on numbers—your site traffic, store sales, or sign-up growth—so
frustrating. You have to find the data, figure out how to make sense of it, and then write about what the data
shows.

Wouldn'’t it be better if you could make a dashboard that automatically turns your numbers into clear,
actionable insights?

With a spreadsheet and some data integrations, you can build the custom dashboard of your dreams. Let’s
pull your spreadsheet skills together with the Google Analytics add-on for Google Sheets, and learn how to
turn your spreadsheet into the data app you’ve always wanted to build.

The Tools to Build a Customizable Dashboard

There are two things you need to make a reporting dashboard: a spreadsheet app, and a source of data to use
in the report.

There’s a wide range of spreadsheet apps, but Google Sheets is the best tool for this job as it’s online, and can
pull in data from web apps like Google Analytics automatically.

Tip: If you’re new to spreadsheets, don’t worry. Just jump back to the Google Sheets 101 tutorial
in chapter 1 of this book for a quick walk through of spreadsheet basics.

107


https://zapier.com/learn/google-sheets/google-sheets-tutorial/
https://zapier.com/blog/best-spreadsheet-excel-alternative/
https://zapier.com/learn/google-sheets/google-sheets-tutorial/
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Then, you need the metrics to track in your dashboard. We’ll use Google Analytics data to show our blog
traffic statistics in a dashboard. But you could import any data you want into your spreadsheet and use these
steps to turn it into a dashboard. Just copy in data from your apps, use built-in functions like =finance() to
import financial data, or use Zapier integrations to log subscribers, sales, shares and more to your dashboard
spreadsheet automatically.

Zapier Integrations:

« Save new Eventbrite attendees to a Google Sheets spreadsheet

+ Save new MailChimp subscribers to a Google Sheets spreadsheet
« Add new rows on Google Sheets for new PayPal sales

« Save Twitter mentions to a Google Sheets spreadsheet

Tip: Explore more Zapier Google Sheets Integrations to add data from your favorite apps—social
networks like Twitter, email marketing tools like MailChim, and more—to your dashboard as
well.

Decide What to Include in the Dashboard

Now it’s time to start building your dashboard. The first step is to determine which metrics matter most.

Anything could be tracked. You can easily set up a report that tracks your new Twitter followers or the number
of incoming customer support tickets. But these numbers are meaningless if you don’t have a reason to track
them.

So to get started, consider how your performance is measured. For a blog to be considered a success, there are
a handful of core metrics that could be tracked:

+ Users: How many people come to your blog?

+ Sessions: How many times do they visit your blog?

+ Bounce Rate: Do they leave right after visiting your blog, or do they stick around?

+ Organic Traffic: How much of your traffic comes directly from organic search results?
+ Month over Month Growth: How is your site traffic growing month over month?

These are the basic metrics you will want to keep an eye on—and the ones we’ll include in our dashboard in
this tutorial.

Your team might have different metrics that are more important for your company: sales, signup rates,
conversion rates from ad campaigns, and more. If so, decide which of those are most important, then add
sections to the dashboard to track them as well.


https://zapier.com/app/min/550/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/1892/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/61/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/135/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/zapbook/google-sheets/
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Get Data For Your Dashboard

Now, we need data for each of those metrics, so we can turn it into a report. And, to make things automatic,
we need to data to be automatically added and updated in our spreadsheet.

That’s easy to do for website analytics, with the Google Analytics Spreadsheet Add-On. Once connected to
your account, it will automatically import live data about your website into your spreadsheet.

If you need to import other data, here’s some other options:

+ The Zapier Google Sheets integrations above could automatically add data about subscribers, sales, and
more to your spreadsheet

+ The Google Sheets import functions can import RSS feeds, website and XML data, and info from other
spreadsheets—something you can learn more about in the Spreadsheet CRM tutorial from chapter 3 of
this book.

« Pre-built Google Sheets add-ons can pull in data from a wide range of sources, including public
databases, marketing and ads tools, and more. Skip to chapter 6 to find details on some of the best
Google Sheets add-ons, or explore the Google Add-ons Store to find more

+ Use Google Apps Script to create custom add-ons for Google Sheets and import data automatically from
other sources. Jump ahead to the guide to Google Apps Scripts in Chapter 7 to get started building your
own add-ons, if you want.

Build a Reporting Dashboard in Google Sheets

It’s time for the fun part: actually building our dashboard!

Let’s get started. The first thing to do is install the Google Analytics plugin for Google Sheets if you haven’t
already. We’ll need this to create our report.


https://chrome.google.com/webstore/detail/google-analytics/fefimfimnhjjkomigakinmjileehfopp
https://zapier.com/zapbook/google-sheets
https://zapier.com/learn/google-sheets/spreadsheet-crm/
https://zapier.com/learn/google-sheets/best-google-sheets-addons/
https://zapier.com/learn/google-sheets/best-google-sheets-addons/
https://docs.google.com/spreadsheets/create?addon_store
https://zapier.com/learn/google-sheets/google-apps-script-tutorial/
https://chrome.google.com/webstore/detail/google-analytics/fefimfimnhjjkomigakinmjileehfopp
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Google Sheets Add-ons

Check out the store for many more

Google Analytics
" g : ; i 185 H
Yoo (484) google-analytics-add-ons | 165,904 users

& w5 % o 00128 Aral - W - B I SA. B-H-FF- E-L1-5 coBHm
A B c 0 E E
LB Browser Statistics
2 Last Run On 31052014 22.36:59
3 View {Profile) Name Goagle Store
4 Tatal Results Found 82 .
5 Tatal Results Returned 5 Top Five Browsers
& Contains Sampled Data o
7 Chigers
CI Totals For All Results
a gawlsits Frefex
10 A1858
. Iitiersal Exjrisenr
LB Results Breakdown
Andeod Browsar
13 gabrowser gavisits
14 Chrome 19314
15 Firefox EBE Satwi
16 Intemet Explorer 5166 M n . 100
1w Ardroid Browser 3668
13 Safari 3650
12

With that installed, open a new Google Sheet, click Add-ons in the menu, and select the Google Analytics
plugin. There are a few options for reports, and for this dashboard we’ll start with Create new report.

= Untitled spreadsheet |
File Edit View Insert Format Data Tools Add-ons Help All changes saved in Drive

& e~ P s % o 00 123- Adal Google Analytics = L% coBMY- Z-

j‘ Get add-ons... Run reports
H
5 A ° ¢ Manage add-ons... Schedule reports : ’
2 Help
3
4
5

That will open a new Report pane on the right side of your spreadsheet. Here we’ll name our report and select
which Google Analytics account, profile, and property to run the report from. I'm going to use my personal
blog for this report—you should select the site which you need to create a traffic report about.
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=] Blogging-Dashboard || Jesse bouman@gmail.com ~
File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments m

1) Name Your Report

oo T s % o0 00123 Ada e L & . H- SR

A B c D E F G H J

L 1 e
!

2) Select Account Information

BoumanBlog 2

1

2

3

4

s Account
)

7

8 Property

@ http:/www.boumanblog.com +
11 View (Profile)

12 www.boumanblog.com +

3) Choose Metrics and Dimensions
Metrics.
17 Search metrics.

18 Metrics Reference
Dimensions.

Search dimensions.

- Dimensions Reference

Now, choose which metrics to track with this report. In the input box below your account info, click the box
to see a list of metrics, then choose the ones you’ve selected earlier and click Create Report.

esse bouman@gmail.com -

= Blogging-Dashboard ||
File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments m

& e~ P 5 % o0 00123+ Adal - 10 - B I 5 A. . B~ E-l |- Mo~ Croate a new report x

fx Related Products

Related Product Quantity

; - Ceommares

3 Revenue per User

4 User

:
g Ecommerce

7
8
9

Refunds

x Users | x Sessions | | x Bounce Rate

Click to get a list of metrics to

10 x Avg. Session Duration
choose from for your report.
11 » Organic Sea

Dimensions

Metrics Referonce

5 Search dir

1% Dimensions Reference

L [Run report when you have desired metrics.] e m Cancal

1f you have quéstions about using this add-on, check out
21 the developer guide for more detailed instructions.

The extension will then add a new “Report Configuration” sheet to your spreadsheet, and it’ll automatically
populate with your site analytics data. This is where we’ll get the data for your dashboard.
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Blogging-Dashboard Jesse.bouman@gmail com
= gging [ :

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments Share

S AP s % o5 0g 1230 | Adw - iz -~ MBlr = A. | %.H- §'+'—1" co Y - X -

f\ Configuration Options

A B c o E F G

!
2 Report Name 1
3 Type core
4 View (Profile) ID / ids ga:11758068
5 Start Date
8  End Date
7 Last N Days 7

ga:users

ga:sessions
8 ga:bounceRate

ga:avgSessionDuration

Metrics ga:organicSearches

9 Dimensions
10 Sort
1 Filters
12 Segment

13 Sampling Level

14 Start Index

15 Max Results =
16 Soreadsheet URL S &

+ = Report Configuration Sheet! -

By default, the spreadsheet will show data from the past seven days—but you can change that by changing
the number in column B7 beside Last N Days, or removing it and adding start and end dates. I typically find
that data from the past 30 days—and comparing that to the two previous 30 day periods—gives the best feel
for month-over-month growth.

Note: Don’t forget to delete the cell for the last 7-days. Otherwise, no matter the dates you add
in, your data will be off.

To add the days in a way we can easily edit them, let’s add a new sheet to our spreadsheet for dates. This
will help us get dynamic information for our report—using the past two months in this tutorial, but you could
enter any date you want.

First, add a sheet, then add the Start and End date for this month and the previous month, as in the screenshot
below. You can then update the dates in the future when you want for new reports, or use Google Sheets’
today or date functions to automatically grab the current date or month for the report if you’d like.
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Blogging-Dashboard | | jesse.bouman@gmail.com +
All changes saved in Drive Commaents
& e o~ T s % 0 00123 Adal + 10 - B 7 5 A. . H- E-L-|b- coBWY-Z-
.f\ =D 3
A B c o E F [ H 1 d ® L M
1 This Month
2 Start End
s oenoe
4 2//2016
8 Stant End :]
7 1286 1/31/2016
8
9

i [Select your date and it will be added to your Report Configuation. ]

Now, go back to your Report Configuration Sheet and select your Start Date cell. Enter an = sign, then go
back to the Dates Sheet you just created and select the first date for this current month. Press the Enter key,
and it will automatically populate into your Report Configuration. Now repeat this step for the end date.

After you’ve set the beginning and end dates for your current month, copy and paste the report so we have
one for the previous month’s traffic. You can do this as many times as you’d like, depending on how far back
you want to track your traffic for this report. For this tutorial, let’s go back three months—so we’ll copy the
data and add it into two more columns. Remember to add the correct dates to each one, and give them a
unique name in Row 2.

EE| Blogging-Dashboard | | jesse bouman@gmail com
All changes saved in Drive Comments

- =l - By -X-

I
|~

& e~ s % .o .00 123- Adal - 1 - B I S A. ®.H-

k| =

A B [+ o E F G

T e

Previous Month Blog

Report Name Current Blog Metrics Metrics
3 Type core core
4 View (Profile) ID / ids ga: 11758069 ga:11758069
5 Start Date 21172018 1172016
6  EndDate 2/29/2016
7 LastN Days 7 7
gausers ga:users
gasessions ga:sessions
8 ga:bounceRate ga:bounceRate
ga: \Duration ga: ionDuration
Metries ga i o ga i o
9  Dimensions
10 Sort
11 Filters
12 Segment

Copy the first report and paste it into

13 Sampling Level
a second column for your second report.

14 Start Index
15 Max Results

+ = Report Configuration ~ | Dates ~ Sheet! ~

Now that you have the dates for your three reports, it’s time to run the report. In the top menu in Google
Sheets, select Add-ons -> Google Analytics -> Run Report.
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Blogging-Dashboard |

File Edit WView Insert Format Data Tools Add-ons Help All changes saved in Drive

& e AT s %0 00123 Adal Google Analytics  » Create new report 1 -9 coB MY - Z -

S Get add-ons... I Run reports I
=
A 8 Schedule reports

Manage add-ons..
iy -ocfauriion Options
Help
2

Previous Mon/
Report Name Current Blog Metrics Metrics

Im

The Google Analytics extension will automatically add three new sheets. Each of them is a report based on
the metrics and timeframe that you chose—one for each month, with the title you added to their respective
rows in the configuration sheet.

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive Comments

Blogging-Dashboard | | jesse.bouman@gmail.com ~

B AT § % o0 00123 | Aral |12 -(|BjZ & A &0 -BH- - co B Y- I~

f+  Current Month Blog Metrics

A B c D E F G H
LB Current Month Blog Metrics
2 Last Run On 212412016 21:00:57
3 View (Profile) Name www.boumanblog.com
4 Total Results Found 1
5 Total Results Returned 1
[ Contains Sampled Data No
7
8
9

(LI Totals For All Results

11 ga:users gasessions ga:bounceRate ga:avgSessionDuration gaorganicSearches

12 204 216 0.912037037 31.16203704 152

13

.
15 ga:users ga:sessions ga:bounceRate ga:avgSessionDuration gaorganicSearches

16 204 216 0.912037037 31.16203704 152

After running the report, three new Sheets will be created
with the traffic data from your chosen dates.

1 (D

Report Configuration 'I Current Month Blog Metrics ‘ Prior Month Blog Metrics ~ | Next Prior Month Blog Metrics ~ | Dates ~  Sheet! ~

+
1]

It’s time to take this Google Analytics data, and turn it into a dashboard. For that, select the original Sheet1
sheet, click the arrow on the right, and rename it to Dashboard. You might also want to drag it to the left, so
it’s the first tab you see when you open this spreadsheet.

Now, let’s add data and more to the dashboard. You can make this as simple or fancy as you’d like—but we’ll
keep it bare bones for now, and you can add style later.

Start by typing in the metrics you want to display on the dashboard. Then, we’ll populate it with data just as
we did with the date field previously. Select the cell for that month’s data, press =, then navigate to the Sheet
where the corresponding information is, select the cell, and press enter. Repeat that for each cell to pull in the
proper data for your report.
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Once this is finished, you’ll have a plain dashboard with your site traffic data for the past three months. You
can add some quick formatting to make things look nicer, perhaps with background colors for each month
and number formatting to make the values stand out.
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That’s still a bit hard to read, so we’ll turn these metrics into charts that will let you see what growth—or
not—you’ve had over the past three months.

Just highlight the cells that you want to represent visually—perhaps the 3 months of data for Users, first—then
click Insert -> Charts in the top menu.
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A

Google Sheets will show you the chart options. Select which one you’d prefer to represent your data—T’ll
choose a line volume chart for this data.
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That’ll place the chart at a random spot, often on top of your data. Just click and drag on the chart to move it
to the place you want, or drag the squares at the corner to resize it. And if you selected the wrong data, click
the pencil icon to edit the data, labels, or chart style.

f; Time Frame

Jesse.bouman@gmall.com ~

Blogging-Dashboard ]

File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive

& e~ T s % 0 0g 123+ Anal - 1 - |B|Z S5A. ®-BH-BH- =-4-|+-

co B v-Z-

A B [+ D E F G H J K L
~ Blogging Metrics
3
4
5 [Time Frame Current Month [EFGPMBRIM Next Prior Month
& Us - ®
r Users vs. Time Frame V4
8 Se
9 |Ti 0 — Users
0 O \
1 Ti 200
12 B
13 . After you insert your chart, you can adjust the size
" E‘ 200 and location of it in your dashboard.
15
16
17 100
18
18 o
20 Current Month Prior Month Next Prior Month
21
an Time Frame z
+ = wportConfiguration ~ = Current Month Blog Metrics ~ | Prior Month Blog Metrics ~ | Next Prior Month Blog Metrics -~ | Dates ~ | Dashboard 4 » Sum: 875 = Explor
Now, repeat this process for each metric and arrange the charts as you please. I’'ve arranged the charts in a
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grid on the right, for a quick way to see the stats at a glance.
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Our dashboard now has our core metrics on the left and visual charts on the right. Let’s add our monthly
growth to the dashboard, and format everything automatically with conditional formatting.

In the blank area below our core metrics, add labels for the monthly growth numbers.
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In Cells A15 and A18, let’s add conditional formatting. That way, when we create our formula for monthly
growth, the spreadsheet will know how to format the cell.
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First, select cell A15, then select Format -> Conditional Formatting in the top menu. That will open a pane on
the right where we will set up our conditional formatting criteria.
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We’re going to set two conditions for Cells A15 and A18. If the value of these cells is less than 0, it will display
red. If the value is greater than 0, it will appear green. Now we’ll be able to see if the traffic is growing just
by checking the colors.

To populate the cell, just add in a simple formula. In A15, type: =Sum(, then click the cell with the current
month’s users, then type - and click the cell with the previous month’s users and press Enter. This will give
you the difference between the two months, and it’ll automatically show the correct color thanks to the
conditional formatting.
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Repeat this process of creating a conditional format for cell A18 and populate the cell with data from Prior
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Month and Next Prior Month.
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You can repeat this process as many times as you’d like, depending on what metrics you want to track monthly
growth. For now, we’re just going to track monthly users.

If the total change in your metrics, month-to-month, is not enough, then you can add the percentage change
in the cell next to it with this formula: =(Value1l - Value2) / Value2. You could even add conditional
formatting again to see the percentage difference month-to-month easily.
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Congratulations! You have just created a site analytics reporting dashboard in Google Sheets without any

engineering manpower—one that you can easily tweak to show exactly the stats you want.
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Add Additional Metrics to Your Dashboard

You’ve built a great basic dashboard, one that’ll help you track the most important metrics for most sites. But
what if your team wants to see more? The Google Analytics add-on can pull in more data, so let’s add more
dimensions to our dashboard to see a breakdown of how new users found our site.

To do that, we need to go back to the Report Configuration tab. This is where we set the metrics we want
to track—and it’s where we’ll add the new metrics to our dashboard. Click Add-ons -> Google Analytics ->
Create Report again, and choose your account, property, and profile just like we did in the first step.
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As you can see at the bottom of the report is an option labeled “Dimensions” We originally ignored this
option, but we’re going to use it for this next report. Dimensions gives us an extra layer of information for
our metrics—a breakdown of where the raw metric comes from.

Let’s take a look at where our new users come from, so we can see if most people discover our site via Google
Search or social networks. In the “Metrics” field, add New Users. Then below that in Dimensions, add the
Source field.
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Click Create Report, then set the dates for the three month period of time we’ve been monitoring as before.
Once that’s done, go back to Add-Ons in the menu and run the report again.
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That’ll create one more sheet in your spreadsheet: “New Users Sources.” It’ll include the data we requested,
with the total users broken down by which source brought them to our site.

Let’s add this data to our reporting dashboard. Because there is so much more data with this report than
previous reports, we’ll only look at the top 10 traffic sources for new users on the dashboard. If you ever want
to dig deeper into the smaller sources, just switch back to the New Users Sources tab.

We’ll first need to format the source data to look nice on our dashboard. Select the data in the ga:source
column of the Results Breakdown, then cut it and paste it in the column directly to the right of ga: newUsers.
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Alternately, you could copy the data by selecting the cell on the right, pressing = and then selecting the correct
ga:source item you want, then pressing Enter—and you could hide the ga:source column to clean up the

spreadsheet.
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Now, let’s sort the columns to see the sites that sent the most visitors. Highlight both of the columns, then
select Data -> Sort Range, column B, Z -> A in the menu. Your column will now show the source with the
most new users at the top.
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Now that we have our New Users sorted, we’ll select the top ten sources and turn them into a chart. Just
select the top ten sites and their users, click the Chart option in the menu, and choose the pie chart graph to

visualize the data.
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Something’s off here: the chart isn’t in our main reporting dashboard. To rectify this, just select the pie chart
and copy it—just press CMD+C or Ctr1+C.

Then, open the main reporting dashboard tab, paste the new graph and move it where you’d like. Now your
dashboard shows where your new users are coming from, at a glance.

If you ever decide to rerun the report with new dates, just replicate these steps except for the final paste. The
chart in your reporting dashboard will automatically update based on the chart you have in your report.
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One last thing: we could make the dashboard look less like a spreadsheet, by getting rid of the gridlines in
between your charts and graphs. To do this, simply uncheck the gridlines option under the View menu.
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The great thing about creating a reporting dashboard in Google Sheets is that you can customize it however
you’d like. You could change the typeface or colors, tweak the graph styles, and pull in more metrics as you
need.

Now, all that’s left is to share your data, or turn it into a presentation for your next board meeting. If you
want to share the data for others to view in a spreadsheet, just click the Share button in the top right and add
your colleagues’ emails to invite them to view and/or edit the spreadsheet.

Or, you could download the spreadsheet in Excel or PDF formats, or publish it to the web where you could
embed it in a blog post or internal report. For more info on publishing options, jump back to the end of the
Google Sheets 101 tutorial in chapter 1.

Beyond Google Analytics: How to Pull Data from Any App into
Your Dashboard

There are so many different metrics your team could be tracking, often spread across dozens of tools. Your
sales are in one app, your email subscribers are in another, and your site performance details might be hidden
inside your internal tools.

You’ll find Google Sheets add-ons for some of those tools. For everything else, Zapier’s 600+ app integrations
can help. It can automatically copy new form entries, event attendees, emails, Twitter mentions, PayPal sales
and much more into your spreadsheet. And if you have internal apps with few integrations, Zapier’s Webhooks
or MySQL integrations might be able to pull that data into your spreadsheet, too.

Here are some of the most popular ways that people add data to spreadsheets with Zapier (or check out the
full list of Google Sheets integrations on Zapier for more ideas).

Zapier Integrations:


https://zapier.com/learn/google-sheets/google-sheets-tutorial/#download
https://zapier.com/
https://zapier.com/zapbook/google-sheets
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+ Save new Typeform entries to a Google Sheets spreadsheet

« Save new Eventbrite attendees to a Google Sheets spreadsheet

+ Save Gmail emails matching certain traits to a Google Spreadsheet
« Save Twitter mentions to a Google Sheets spreadsheet

+ Add new rows on Google Sheets for new PayPal sales

« Add Data to a Spreadsheet from a Webhook

All you need to do is use Zapier to connect your app to a new sheet in your Dashboard spreadsheet. From
there, you can use that app’s data in your reports.

To get started, add a new sheet to your spreadsheet for the data from your app. Add a column for each item
you want to track in the report; here, I've added columns for any new email subscriber’s email address, the
date they signed up, and the form they signed up with.

= Reviews Subscribers [ ]

File Edit View Insert Format Data Tools Add-ons Help All changes saved in Drive

& e~ ~ P 0§ % 0 .00123- Aral - 10 - B I 5 A. ¥-H-

A B c D E F

—_

Email Signup Date Signup Form

~N OO O A~ W N

Now, in the Zapier dashboard, create a new Zap and select the app with your data as the Trigger. I use a
Wufoo form for my emails, and selected it here. Be sure to select the correct form or any other options your
Trigger app may have.


https://zapier.com/app/min/111/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/550/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/2618/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/135/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/61/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/1035/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
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Dashboard — Choose Trigger . YOURZAPIS @ OFF

Name your Zap...

TRIGGER @
@ 1. Set up this step L

@ Wwufoo Select Wufoo Trigger
4 Choose Trigger

New Ent
° s
ACTION
f 2. Set up this step hd
@ Get Help Response Time: ~2

Then, select Google Sheets as the Action app, and choose the Create Spreadsheet Row Action. Select your
Google Sheets account, the dashboard spreadsheet, and the new sheet you created for this app’s data. Then,
click the + icon beside each row, and select the correct data from your original app.

Dashboard — Set Up Create Spreadsheet Row Template 3 YOUR ZAP IS [ ON .
Add Reviews Subscriber to Spreadsheet
Q TRIGGER
B
1. New Entry b
Set up Goagle Sheets Spreadsheet Row

B spreadsheet (required)

o ACTION Reviews Subscribers ~

2. Create Spreadsheet Row ~

B Google Sheets B worksheet (required)
4 Create Spreadsheet Row Sheetl

& Zapier Sheets

= Edit Template B emails (option:

A Test this Step @ siep 1 Fieldt

X Delete

Continue
B Get Help Respor

Test and turn on your Zap, and whenever a new item is added to your app—like a new subscriber or sale—
it’ll be added to your Google Sheets spreadsheet automatically. You can then add up the totals with simple
=count() or =sum() functions and add them to your dashboard with graphs as above.
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Or, if you want to automatically count the total number of subscribers, sales, or anything else—and are
comfortable writing some code—here’s a tutorial on using Zapier’s Code integration to count the total.
Then, use the Update Spreadsheet Row action in Google Sheets to update the number on your dashboard
automatically whenever a new sale or subscriber comes in.

Create Your Own Spreadsheet Dashboards

No matter what data you need to track, Google Sheets can turn it into an easy-to-skim report. The traditional
spreadsheet cells and formulas make it easy to arrange and format data, while modern integrations let you
copy stats, sales, subscribers and more into your account automatically. And with a bit of tweaking, you’ll
have that data turned into a professional-looking dashboard with your team’s most important numbers in
one place.

Now it’s your turn: Figure out what data you want to track beyond basic Google Analytics stats, and add it
to your spreadsheet. Use these steps to build your own simple dashboards from that data, and figure out how
to update that data whenever you need—perhaps just by changing dates, or with Zapier integrations.

Then, the next time your manager asks for stats, you’ll know exactly where to check. You’ll never have to
cram a report together in PowerPoint again.

To get that extra data for more detailed dashboards—and to format it automatically so you don’t have to spend
so much time on your spreadsheet, you’ll need more Google Sheets add-ons. There’s hundreds of add-ons in
the store, so we’ve tested and found 50 of the best Google Sheets add-ons to help you get the most out of
Google Sheets.

You'll find that in chapter 6, along with tips on how to manage your add-ons and make sure Google Sheets
has just the features you need most.

Enjoy? Read and share this chapter online: zpr.io/uB9b

Written by freelance writer Jesse Bouman.


https://zapier.com/blog/zapier-code/#store
https://zapier.com/learn/google-sheets/best-google-sheets-addons/
http://zpr.io/uB9b
https://twitter.com/JesseBouman

Chapter 6: 50 Google Sheets Add-Ons to
Supercharge Your Spreadsheets

Spreadsheets are amazing, powerful tools. They can do anything—almost anything, at least. But wouldn’t it
be great if they could do that one extra thing you’ve always wanted—if they could remove extra rows or look
up research data or translate text automatically?

For years, Excel has been one of the most popular spreadsheets, partly for its own features but partly for
the extra tools you can add to it. It’s like the App Store: When there’s something else you want Excel to do,
chances are there’s an app for that.

Now the same is true for Google Sheets, the free online spreadsheet tool that’s so easy to use. With the
Sheets” Add-ons Gallery, you can add reports, analytics, data analysis, and even email scheduling tools to
your spreadsheets in a couple clicks.

Here’s how—along with some of the very best add-ons to get you started.

128


https://zapier.com/zapbook/google-sheets/review
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Getting Started with Google Sheets Add-Ons

Add-ons

Order

eit41=0 “ ???

Solve: 3z +4y=10 x=3 Google Analytics Lab Scheduler
6r—3y=12 <3 c

Google Analytics Lab Scheduler
Power Tools
One-c acks:

YetAnotherMailMerge

3 giMath) for Sheets

& -~ Vima.

!‘g Remove A :
= Duplicates 4.

Add-ons, extensions, plugins: they’re what make the most popular software great. Google Chrome, Adobe
Photoshop, Microsoft Word, Sublime Text, and more are great programs on their own, but extendability is
what makes them platforms. You come for the great browser or photo editing tools, but stay for the countless
extensions that help you get things done more easily.

Google Sheets—and the rest of the Google Docs suite—were originally known as simpler, less powerful
alternatives to Microsoft Office. But over time, Google relentlessly added features to make up the difference,
and opened the Add-ons Store in each of their apps in 2014. Today,there are hundreds of add-ons for each of
the Google Docs apps, and it only takes a couple clicks to install them.

To get started with Google Sheets Add-ons, just open a new or existing spreadsheet in your browser, select
the Add-ons menu in the top right, and click Get Add-ons. That’ll open the Sheets Add-ons store, where you
can search through over 250 add-ons or sort them by category.

Installing add-ons is easy. Just click the Free button that appears when you hover over an add-on, then accept
the permissions. After a moment, click the Add-ons menu again to see your new add-on along with any others
you’ve installed. Just click the add-on to run it—typically add-ons will open in a sidebar, or with a pop-over
window over your spreadsheet.


https://drive.googleblog.com/2014/03/add-ons.html
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Need to clean up your add-ons? Just click Manage Add-ons in the menu, then select the Manage button beside
any of your add-ons to disable it in this document or remove it from your account.
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One thing to note is that you can only reasonably install around 20 add-ons, depending on your screen
resolution and size, as the other add-ons and add-on options will end up hidden at the bottom of your menu.
On my 13” Retina Display MacBook at standard resolution, 22 add-ons plus the options are all that can fit in
a full-screen window, as in the screenshot below.
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Most Google Sheets add-ons are installed inside Google Sheets, so they’ll work in any browser—install one in
Chrome at the office, and it’ll still work on Safari at home. A few add-ons are designed for the Google Chrome
browser, though, so they’ll only work when you’re using Chrome. And no add-ons work on the Google Sheets
mobile apps, so you’ll have to use them from your laptop or desktop instead.

Now that you know how to give your spreadsheets superpowers, here are the best add-ons for Google Sheets
to help you gather data, format text, crunch numbers, share your creations, and more.

Note: Most Google Sheets add-ons are free, so each tool listed here is free unless otherwise noted.

The Best Google Add-ons for:
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Need to quickly add contact info, customer feedback, and more to a spreadsheet? A form is the simplest way
to do that—and Google Sheets comes with one built-in. Google’s free form tool, Google Forms, lets you create
simple forms and share them with anyone. And it’s just a click away in Google Sheets.

Just click Tools -> Create a Form in Google Sheets, and the Google Forms editor will open with a new
form that’s automatically connected to your spreadsheet. Add the fields you want, share the form with your
colleagues or followers, and the results will show up in your spreadsheet automatically.

Tip: Google Forms looks simple, but is packed with hidden features. Jump back to Chapter 2 for
an in-depth guide to Google Forms.

Then, here are some extra add-ons to help manage your form results:

copyDown

to add formulas to form responses

Formula responses are just plain text and numbers by default. To calculate values, reformat text, or use any
other functions, you’ll need to add them in later. Or you can use copyDown to automatically copy formulas
to new rows.

Just add the formulas to a top row in the spreadsheet worksheet where your form results will be added—row
2 by default—and turn on copyDown. Then, as results are added to your spreadsheet, it’ll copy those formulas
down to each new row, calculating values, evaluating results, and more automatically.


https://zapier.com/zapbook/google-forms/review/
https://zapier.com/learn/google-sheets/how-to-use-google-forms/
https://chrome.google.com/webstore/detail/copydown/lipbbdpmkcbplmfnbholpabinnnkbbda
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Flubaroo

to grade results from a form

Building a quiz in your form? Flubaroo can grade multiple choice options automatically, and give you a graph
and chart of the scores, averages, and more. It can even email those who filled out your form with their grades
and the questions they missed.

Flubaroo is designed for classrooms, but it can equally be a great tool to check your team’s knowledge or
make a quick interactive game in a spreadsheet.

Advanced Summary

to create a report from your form data

You could create your own charts and reports from your form data, or Advanced Summary could do that for
you automatically. Just run the add-on on your results sheet, and it’ll let you filter results, visualize them in
charts and word clouds, and save the data as a new view in your spreadsheet. Or save that page as a PDF for
a quick survey report.

rowCall

to sort entries into their own sheet

Want to organize your form entries by the person who added them, the category of feedback they gave, the
location they visited, or any other common data? rowCall can do that for you. It creates a new sheet for each
unique type of response and sorts the data into the appropriate sheet automatically, so you never have to
search through and filter form data again.

Want to use another form with your spreadsheet instead of Google Forms? Let Zapier help. Our app integration
tool connects to the most popular form and survey apps—including Typeform, Wufoo, Gravity Forms, and
more—and can copy your new form results to a Google Sheets spreadsheet automatically.

Check Zapier’s roundup of the best form apps for more form builder options, then check out Zapier’s form
integrations that can help you connect your form to spreadsheets (and more). Or use some of these pre-made
integrations to get started quickly:

Zapier Integrations:

« Save new Typeform entries to a Google Sheets spreadsheet

« Save new Wufoo entries to a Google Sheets spreadsheet

+ Save new Gravity Forms submissions to a Google Sheets spreadsheet
+ Save new SurveyMonkey responses as Google Sheets rows


https://chrome.google.com/webstore/detail/flubaroo/mjkbmijfpphoabkogbdmdkolcnaenaia?utm_source=permalink
https://chrome.google.com/webstore/detail/advanced-summary-by-aweso/acjijfibfkinmiggeggndoeolggfahhl
https://chrome.google.com/webstore/detail/rowcall/plcnijepgekkpmeiiekmakkjbbnaiano?hl=en
https://zapier.com/learn/ultimate-guide-to-forms-and-surveys/best-online-form-builder-software/
https://zapier.com/learn/ultimate-guide-to-forms-and-surveys/form-software-automation/
https://zapier.com/learn/ultimate-guide-to-forms-and-surveys/form-software-automation/
https://zapier.com/app/min/111/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/2/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/13/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/1943/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
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Data Gathering

Spreadsheets are a great way to sort through your survey results and financial data—but how do you get your
data into the spreadsheet if you’re not using a form?

With many apps, you can export your data as a .csv file and open it in Google Sheets. Or, with these
extensions, you could pull in data automatically.

Wolfram|Alpha for Sheets

to find data about the world around you
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Want Siri inside your spreadsheets? Wolfram|Alpha powers some of Siri’s best answers, answering data about
population, finance, nutrition, and more. Add it to your spreadsheet, and you can answer most questions in
seconds.

Just install WolframAlpha for Sheets, and type in the items you want to calculate. Then click the Compute
Selection with Wolfram|Alpha option in the Add-ons menu, and after a few seconds your text will be replaced
with the answer. Or you can search the Wolfram|Alpha sidebar for an answer and insert the data or a graph
directly into your spreadsheet.

Import.io

to turn any website into a spreadsheet


https://chrome.google.com/webstore/detail/wolframalpha-for-sheets/mompponoljifabejjfemcjpkdmliolno

Add or manage URLs
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Found data on a website that you want to import to a spreadsheet—perhaps a list of prices, news articles, or
anything else in a table or list? Import.io can turn that into a spreadsheet.

Just enter a link to the site, and Import.io will turn it into a table. You can edit the columns to pull in any data
you want, then export it to Google Sheets or download as a spreadsheet. Or you can use their bulk extractor
spreadsheet template to import data from websites directly inside Google Sheets.

Import.io Price: Free for up to 10k queries per month; from $249/month for paid plans starting at 50k queries
per month

Supermetrics

to import ad, finance, and social data


https://www.import.io/
http://support.import.io/knowledgebase/articles/617097-export-to-google-sheets
https://www.import.io/post/updated-bulk-extract-data-using-google-sheets/
https://www.import.io/post/updated-bulk-extract-data-using-google-sheets/
https://www.import.io/standard-plans/
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Supermetrics is a powerful tool to import your business data into Google Sheets. It connects to analytics tools
like Google Analytics and Moz, social networks including Facebook, Twitter, and YouTube, payment services
like Stripe, along with ads services, databases, and more.

To import data, select the connection and query type, add filters to only watch for specific data, and then
choose the fields you want added to your spreadsheet. Supermetrics will then pull in your data and can refresh
it on a schedule to keep your spreadsheet up to date. It can even email you a PDF copy of your spreadsheets
whenever the data is refreshed, so you’ll never have to make reports by hand again.

Supermetrics Price: Free Google Analytics integration with up to 100 queries per month; from $49/month
for one of the paid plans, which add more queries per day and other features

Blockspring

to import and analyze data with APIs


https://supermetrics.com/product/supermetrics-for-google-drive/
http://supermetrics.com/product/supermetrics-for-google-drive/
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5 BOOAUOPTCW http:/fwww.amaz [{"Description”
6 545162076 http:/fwww.amaz [{"Description”:
7  BOOD2HLM4ED  hitp:iwww.amaz [{"Description”
8 BOOSFILQRO hitp:fiwww.amaz [{"Description”
9 545790352 http:fiwww.amaz [{"Description™
10 BOO27T1HTLI http:/fwww.amaz ({"Description™
1 BOOTTX54GO  hitp:/fwww.amaz [{"Description™

1 ["J.K. Rowling",". Hardcover

“Technical Details”, Amazon Video
T J.K. Rowling Paperback

“"Technical Details", Amazon Video

“TJ. K. Rowling  Paperback

i Echnical Detaus".l Amazon Video

"Technical Details™, Toy

T J.K. Rowling Hardcover

‘"Technical Details”, Amazon Video

"Technical Details™, Toy

9781338099133 9781338099133 Spet

9780439708180 ["0038332166576","0(

9780545162074 ["978054516207 Slp

658978578498 658978578498
9780545790352 ["978054579035 lllus!

BB5402760666 ["0B85402760666","01
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Blockspring Console b4

Blocks Add Block

Amazon General ltem Vv
Search
Sheat3 5.

Schedule

None 2]

Trial ends in 14 days. Upgrade

Request an ARl | @ Help

Want to find pricing data from Amazon, extract data from an article, or research company stats? Blockspring
is a powerful add-on that can do that and more. It connects your spreadsheets to a wide variety of web APIs

to import and analyze data manually or on a schedule.

You’ll need to install the add-on, create a Blockspring account, and connect it to the services you want. Some,
like Buffer, let you connect in a click; others, like Amazon, require you to copy API keys or authentication
details. Once that’s done, you can create workflows to look up data, use machine learning tools like BigML
or Alchemy API to find patterns in your data, or write your own custom scripts with R and Python.

It’s a bit more complicated to set up than most Sheets add-ons, but its powerful tools can well be worth the

hassle.

Blockspring Price: Free 14-day trial; $10/month for up to 100k requests to connected services per month

Citable

to turn Google Sheets into a bookmarks tool


https://www.blockspring.com
https://open.blockspring.com/tags/421-bigml
https://open.blockspring.com/tags/304
https://www.blockspring.com/docs
https://open.blockspring.com/settings/billing/upgrade
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® 3t How to Back Up Everything Fr. x Matt

C' & https://zapier.com/blog/backup-everything/ w 4 1 O D@ ES N e

of your files and folders for 30
days, so you can save previous
variations from total
destruction.

Recover Files from Dropbox

b+ ¢ » Alfre Just open Dropbox online, and
click the trash can icon to show
deleted files. From there, you
can download the files or move
them to a folder to un-delete
them.
How to Back Up Everything From A...

Matthew Guay /June 21, 201... hitps=/zapier.comvblog/

software

Bookmarks v Save

Deleted a file from Dropbox? No worries. Dropbox saves versions of your files
and folders for 30 days, so you can save previous variations from total

destruction.

Spreadsheets are the perfect place to gather your research, and Citable makes that even simpler. Install the
Chrome extension, then when you find something you want to save, just select it and click the Citable button.

Citable will copy that text, along with the link, site and author info, and any tags you add, and save them to
a Google Sheets spreadsheet. You can then export all of your notes in Bibtext format to import into Zotero or
other citation apps to quickly create a bibliography for your next research.

Wikipedia Tools

to find facts from Wikipedia

Speed up your research with the Wikipedia Tools add-on, which adds a bundle of new Wikipedia functions to
your spreadsheet. Then, using functions like =WIKIDATAFACTS( ), you can import info, translations, synonyms,
categories, and more into your spreadsheet.

Related: Want to import info from RSS feeds? Check out the Google Sheets import tools from
chapter 4 for built-in options for that and more.

Knoema Data Finder

to find global statistics

Need detailed statistics on population, crime statistics, exports, land use, and other academic topics? Knoema
Data Finder gives you a sidebar to search through and import data on these and dozens of other topics from
governments and industry sources around the globe. Just search for what you’re looking for, then click the
result that looks closest, and Knoema will insert a table of the data into your spreadsheet.


https://chrome.google.com/webstore/detail/citable/jfiabcklnnhkmkcdjjpmgghiimjkaeio/
https://www.zotero.org/
https://chrome.google.com/webstore/detail/wikipedia-tools/aiilcelhmpllcgkhhpifagfehbddkdfp?hl=en
https://zapier.com/learn/google-sheets/spreadsheets-for-writers/#import
https://chrome.google.com/webstore/detail/knoema-data-finder/ojbponfhjmmkkaabnldenclfmhcgmnak
https://chrome.google.com/webstore/detail/knoema-data-finder/ojbponfhjmmkkaabnldenclfmhcgmnak
https://knoema.com/atlas/topics
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Twitter Archiver

to search Twitter over time

Want to search Twitter for a topic or hashtag, and save those results to a spreadsheet? Twitter Archiver is
a simple add-on for just that. Enter simple or advanced search queries, and watch for locations, hashtags,
languages, or mentions. Twitter Archiver will find all the Tweets it can from Twitter’s history, then will
update your spreadsheet with new Tweets every hour for free, or every 10-15 minutes with a paid account.

Twitter Archiver Price: Free for core features; $39.99 for the Premium version, which adds support and
automatic refresh every 10-15 minutes

Google Analytics

to analyze your website statistics

Google Analytics is a free and powerful way to learn about your site visitors, but its interface can be confusing
and cluttered. For a simpler way to see just the data you need—and turn it into reports—the Google Analytics
Sheets add-on can pull in any analytics data you want and save it to spreadsheet tables. You’ll need to manually
refresh it when you want new data, but that’s perfect if you want to compare data over time and already do
that in a spreadsheet on a regular basis.

Tip: Jump back to chapter 5 to learn how to build a custom analytics dashboard with the Google
Analytics add-on.

Email Hunter

to find email addresses using a spreadsheet

Want to email everyone at a specific company, or desperately searching for an address for that one person
you need to contact? Email Hunter’s Sheets add-on can do that work right from a spreadsheet.

Just create an account and add your API key to the add-on, then enter a domain in its sidebar. Email Hunter
will then fill your spreadsheet with every email it can find for that company, ranked by how confident it is
that this email address is valid.

Email Hunter Price: Free for 150 requests per month; from $49/month for paid plans starting at 1k requests
per month.

Text Tools

Now that your spreadsheet is filled with data, what are you going to do with it? Numbers can be calculated
and graphed, but text can be harder to manipulate in a spreadsheet. Here are some helpful tools to translate,
analyze, and map your text in a spreadsheet.


https://chrome.google.com/webstore/detail/twitter-archiver/pkanpfekacaojdncfgbjadedbggbbphi
https://gumroad.com/l/GA05
https://chrome.google.com/webstore/detail/google-analytics/fefimfimnhjjkomigakinmjileehfopp
https://chrome.google.com/webstore/detail/google-analytics/fefimfimnhjjkomigakinmjileehfopp
https://zapier.com/learn/google-sheets/google-sheets-dashboard-tutorial/
https://zapier.com/learn/google-sheets/google-sheets-dashboard-tutorial/
https://emailhunter.co/sheets
https://emailhunter.co/pricing
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AYLIEN Text Analysis

to learn more about your text

& e ~ T s % o0 00 123- Adal - W - B I 5 A. $-H- R B Text Analysis b4

fx | This year has been a complicated one

A 4» D E F G Analysis type

1 Avaincre sans péril, on triomphe sans gloire Subjectivity Subjectivity Confidence Polarity Polarity Confidence Sentiment Analysis =

2 To win without risk is to triumph without glory unknown 0 neutral 0.8470003092

3 This is a great day! positive 0.9091515562 ldentify positive/negative sentiment w:hm any
Joc: nt, pe Le: Aore

4 I'm feeling terible negative 0.9960139745 document, web page or tweet. Learn More

5 | This year has been a complicated one | neutral 04411800673 Options

6

7 Language

8 English

= Mode: *) Tweet Document

10

1 ¥/ Insert column headers

-

Need to summarize text, analyze its sentiment, find concepts and individual entities in text, get suggested
hashtags, and more? The AYLIEN Text Analysis add-on offers a full suite of tools to help you figure out what
your data means and how to use it more effectively.

It’s one of the add-ons that’s best paired with another add-on. Say you’ve imported bulk data from a website
and want to summarize it, or have pulled in your team’s Tweets and want to find their sentiment and figure
out the best hashtags to use. Text Analysis can give you those insights from your imported text in seconds.

Text Analysis Price: 1,000 queries for free; from $10 for 1,000 more query credits

Translate My Sheet

to translate an entire spreadsheet

& e ~ P s % 0_ .00, 123~  Aral - 10 - B I 5 A. - B-EH - more - Translate My Sheet

Jf\ adant
’ > ‘ ’ : F @ TRANSLATE

1 Helig! e |
2 Whatis your name? ﬁmiamb’? M Y
3 Whattime is it? fafaaniudonl?
4 Where do you live? ﬁrumﬁ'rmgjﬁ'luu?
: SHEET.
6  Sunday Funiing
7 Monday Fudund
8 Tuesday Tugans
8  Wednesday Tuns Source Language Target Language
11 Friday Fugnd
12 Saturday _'i'um‘l'f i)
13 - @ Full sheet
ik ’ © Selecled range



http://aylien.com/text-analysis-addon/
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Found some foreign language data you need translated? Translate My Sheet can do that in a second. Install
the add-on, then either choose the source and target languages or have it auto detect the source. It can then
translate your whole sheet or a selection automatically, with the new text showing up in seconds.

Tip: Want to translate individual cells? Just use the built-in =GO0GLETRANSLATE() function to
identify languages, translate to a specific language, or detect the language and then translate.

Geocode by Awesome Table

to find location data from addresses

=TT R At ) m ) S e Here -

Full Address
3 B = = = = = = Current sheet
1 C/ Rosa de los V SIS0
Jessy ROUX jessy.roux@dem 11190 Benalup  Spain Full Address Latitude Longitude
]
2 Ctra. Bailén-Motr Ctra. Bailén-Mot - Address column
Joe BERTRAND joe.berfrand@de 23210 Guarroma Spain 23210 Guarromé " 7.4319427 -3.607798 Full Address v
3 Enxertos, 40 Enxertos, 40 Are your addr  in multiple columns?
Terry DUBOIS  terry.dubois@der 37542 Navasfria: Spain 37542 Navasfria 40.2972153 -6.8210319
i Visitacion de la E Visitacidn de la E Map
Timothée LAURE timothée.laurent; 37716 La Hoya Spain 37716 La Hoya & 40.4071921 -5.6987269
- Salzillo, 45 Salzillo, 45 Mow that your addresses have been
’ Gaél LEFEBVRE gaéllefebvre@d 32611 Rids Spain 32611 Rids Spail 41.9734629 -7.3192542 geoccoded, you can easily create an
8 54, Rue de Verd. 54, Rue de Verd: Awesome map.
Camille ROBER™ camille.robert@c 40000 MONT-DE France 40000 MONT-DE 43.893485 -0.459782
- 84, Chemin des | 84, Chemin des CREATE MAP
Alix THOMAS  alix thomas@der 73100 AIX-LES-E France 73100 AIX-LES- 45.7037858 5.887068
8 62, rue du Gue J 62, rue du Gue J
Lou BONNET  lou.bonnet@den 86100 CHATELL France 86100 CHATELL 46.816487 0.548146 Geocoded
o 9, Place du Jeu ¢ 9, Place du Jeu «
José FOURNIEF josé foumnier@de 94800 VILLEJUIl France 94800 VILLEJUI 48792716 2.359279 14 out of 14 addresses
10 57, place Mauric: 57, place Mauric
Alex MARTIN  alexmartin@der 08000 CHARLE\ France 08000 CHARLEY 49.762085 4726096
6 Peachfield Roz 6 Peachfield Roe
" CHAPEL CROSS CHAPEL CROS!
Charlie DURANL charlie.durand@ TN21 2Y2 England TN21 2¥YZ Engla 523555177 -1.1743197
42 Ockham Roac 42 Ockham Roar
12 EAST ORCHARIL EAST ORCHARI
Claude MOREAI claude.moreau@ SP7 8RD England SPT 8RD Englar 523555177 -1.1743187 = Tab

Need precise GPS coordinates for addresses in your spreadsheet? Geocode by Awesome Table is the tool for
you.

Just run it on a spreadsheet containing addresses, and it’ll crunch their locations for you. If your address is
spread across columns, you can tell Geocode which part of the address is in each column and it’ll merge them
into a full address. The add-on finds the latitude and longitude of each address, adds them to new columns,
and offers to make a Google Maps map inside its companion app, Awesome Table. There, you can customize
labels and sort through the addresses in a table.

Mapping Sheets

to create customized maps


https://chrome.google.com/webstore/detail/translate-my-sheet/ikbffjfknllcipddomhgdhcedikhiaga?hl=en
https://chrome.google.com/webstore/detail/geocode-by-awesome-table/cnhboknahecjdnlkjnlodacdjelippfg
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Mapping Sheets is a handy tool to make customized Google Maps maps that show general locations alongside
specific addresses. Just enter location names and addresses—or their general area, perhaps a city or country
name. Add categories or other filter data as well, if you’d like.

Mapping Sheets can then turn that into a Google Maps map, where you can filter down addresses based on
location or categories from your spreadsheet. Those maps are built from . json files stored in a xsMapping
folder in Google Drive. Make that folder public, then you can share the links Mapping Sheets gives you with

anyone.

Note: Mapping Sheets works best in Google Chrome, and we couldn’t get test maps to load in
Safari. Additionally, it can have trouble running if you’re currently logged into multiple Google

accounts.

to turn your data into template documents

autoCrat


https://chrome.google.com/webstore/detail/mapping-sheets/ddfdjfkaipgeahdjeemdojbpcglcncif
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$ % .0 00 123-  Arial - 10 - B 7 5 A & - H- E-1l |- coBH WY -
| |
AutoCrat |
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AutoCrat Demo Job
W
3. Map source data to template
Merge tab  AutoCrat Demo Merge Sheet Header row 1 ° First data row 2 &
Image << Image URL >> image URL Image URL
image width <<Image Width>>
image height <<lmage Height>>
Standard << Image description >> maps to Image description
column
e M sl Al LI el 1A
Help Guide Cancel SAVE Back “

Want to turn your data into beautiful documents? autoCrat is the add-on for you.

Add your data to a spreadsheet, then create your own autoCrat template document in Google Docs, with
<<tags>> that reference columns in your spreadsheet. You can use any of Google Docs’ font and formatting
options, and even add image blocks.

Then, create an autoCrat job in your spreadsheet, make sure it’s mapped the spreadsheet fields to your
document correctly, and set conditions to have it only run when specific columns are filled or have certain
data in them. Choose whether you want the finished document saved as a Google Doc or PDF, and add email
info to send when the document is finished.

autoCrat will then automatically turn your spreadsheet data into finished documents, either with the data
you’ve already entered or as new data is added. It even adds a link to the finished document for each row in
your spreadsheet, so you can re-open them again easily later.

Sudoku Sheets

to make sudoku games in your spreadsheets


https://chrome.google.com/webstore/detail/autocrat/ppgnklghfnlijoafjjkpoakpjjpdkgdj
https://docs.google.com/document/d/1WTGSSlH6gwUHpipusPKLIsgfFUamDbFbJ7JaoG6-ZBo/edit
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Want a break from your work? Sudoku Sheets can auto generate an easy, medium, or hard sudoku game in
your spreadsheet or let you design your own puzzle. It can validate entries as you add them, and if you get
stuck it can solve the puzzle automatically—even puzzles you’ve designed yourself.

Formatting

With all the new data in your spreadsheet, chances are things are looking a bit messy. These tools will help
you get rid of blank rows and columns, find and replace text better than Sheets’ default tools, and turn your
sheets into beautiful tables.

Power Tools

to format and clean up your spreadsheets


https://chrome.google.com/webstore/detail/sudoku-sheets/eagolleeideiojopioiiaadjkneafmen?hl=en
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3 Tutorial Screenshot Tools, Tips and Shortcuts 317/2016  Publ
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Search through Google Sheets’ Add-ons, and one name will stand out in particular: AbleBits. They’re best
known for their Excel, Outlook, and Word add-ins, and put the same focus and care into their newer Google

Sheets add-ons.

If you just need a tool to clean up one thing in your spreadsheet—perhaps with better find and replace or to
merge sheets and remove duplicates—you can use one of their individual add-ons for that. Or just install Power
Tools, their all-in-one add-on that lets you cleanup data, reformat it, split or combine sheets and columns,
customize formulas in bulk, and more. You can choose a new function each time, or run recent or favorite
tools again for an easy way to do the same cleanups again. It’s one of the most polished and powerful add-ons

we tried in this roundup, one improves most of Google Sheets in one tool.

Or, if you want their individual Google Sheets tools, here are some of the individual add-ons that are built

into Power Tools:

+ Merge Sheets to combine data from multiple sheets.
+ Merge Values to merge data in columns, rows, or ranges.

« Remove Duplicates to remove or mark duplicates from multiple sheets.

« Split Names to break name parts into multiple columns.

« Random Generator to fill a spreadsheet with random passwords, dates, names, or other sample data.

+ Advanced Find and Replace to search through values, links, and notes, and save the results to a new

table.
« Find Fuzzy Matches to find all items that are similar to your query.

Note: Power Tools are currently free, though the add-on is expected to cost in the future.

Table Styles

to add color and style to spreadsheets


https://www.ablebits.com/google-sheets-add-ons/power-tools/index.php
https://www.ablebits.com/google-sheets-add-ons/power-tools/index.php
https://www.ablebits.com/google-sheets-addons.php
https://chrome.google.com/webstore/detail/merge-sheets/gdmgbiccnalapanbededmeiadjfbfhkl?utm_source=ablebits
https://chrome.google.com/webstore/detail/merge-values/lhikboagplgbemjnkgoahbphfgieaiek?utm_source=ablebits
https://chrome.google.com/webstore/detail/remove-duplicates/bckmhokpcdnhhjldhhfpebhdfipmlbog?utm_source=ablebits
https://chrome.google.com/webstore/detail/split-names/omjobieogknhhlogiaeofbdpipihaanb?utm_source=ablebits
https://chrome.google.com/webstore/detail/random-generator/jbmegemikfiklkooomkedgngifmimhmk?utm_source=ablebits
https://chrome.google.com/webstore/detail/advanced-find-and-replace/gdjlbafkoaciknlpkmiedbgnlfglcpmb?utm_source=ablebits
https://chrome.google.com/webstore/detail/find-fuzzy-matches/cadkkijbhldndjaflcbapfllpolajpcp?utm_source=ablebits
https://www.ablebits.com/forums/topic/25635-power-tools-pro-licence/
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Applying your default color, fonts, and other design elements to new spreadsheets each time is tedious. Table
Styles can save you the hassle. Just add your favorite formatting to a spreadsheet, select the formatted area,
then click Table Styles -> Create style from selection in the Add-ons menu.

You can then customize the style, save it, and add it to new spreadsheets with a click. Table Styles can save
up to three styles for now; a new Pro version will be offered in the near future for extra style options.

Awesome Table

to turn your data into visual tables


https://chrome.google.com/webstore/detail/table-styles/miephfllckffagckloelhmnbefefbldl
https://chrome.google.com/webstore/detail/table-styles/miephfllckffagckloelhmnbefefbldl
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Sorting and filtering data in a spreadsheet is easy enough, especially with pivot tables, but it’s not exactly
pretty. Awesome Table gives you a custom interface to browse your spreadsheet data in table, maps, cards,
and gantt chart visualizations.

You can customize the view, choosing the number of rows and columns, and setting other view options. Then
you can share your Awesome Table design or use it to sort through and filter data with drop-downs and
dynamic sliders. It’s like a custom app just for viewing your spreadsheet data.

Add Rows & Columns

to add extra space to a sheet

- e $ % o 00 123 Arial 10 B 7 £ A P e 1 - |= co H [ ¥ 3
A B c D E F G

1 Month Category Post Title Date Status Price Budget
2 March $300
3 Tutorial Screenshot Tools, Tips and Shortcuts 3/17/2016 Published $100
4 Productivity How to Pick Project Management Software 3/22/2016 Published 580
5 Roundup Best Qutline Apps 32472016 To Update $60
& Tutorial Infusionsoft Ey ¥2016 Published $110
7 Tutorial Manage Multip X 2016 Draft $30
¢ Mumber of rows above Total: _
g April Internal Welcoming Bu ] ¥2016 Published
10 Roundup The Best Proje ¥2016 Published

Tutorial How to Manag| Ok Y2016 Published
12 Tutorial Spreadsheets fi ¥2016 Draft
13 Internal Zapier Tips | #2016 Draft

» o

© & ~


https://sites.google.com/site/scriptsexamples/available-web-apps/awesome-tables
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Tired of clicking Insert 1 Below over and over to add space to your spreadsheet? Add Rows & Columns can
help. It adds a menu to your spreadsheet where you can select to add rows or columns before or after your
currently selected cell.

Enter the number of rows or columns you want to add, and a second later your data with have extra breathing
room.

Crop Sheet

to crop a sheet automatically

Want your spreadsheet to show only the data you need? Crop Sheet is the simplest way to clean it up. Just
click Add-ons -> Crop Sheet -> Crop to Data, and Crop Sheet will remove all blank cells and rows, leaving
just your data in a compact spreadsheet. Or you can have it crop to a selection to get rid of data you don’t
need, too.

Remove Blank Rows

to cleanup a spreadsheet

Remove Blank Rows gives you a few more options than other add-ons for cleaning up your spreadsheet. It can
remove or hide blank rows, watching either for rows that are fully blank or those where just specific columns
are blank. If some cells includes spaces, you can choose to treat them as blank. And you can delete empty
rows and columns across all of your sheets or unhide hidden rows that do have data.

Remove Blank Rows Price: Current features free; $10 for the upcoming Premium upgrade, which adds
advanced tools

Insert and Delete Cells

to add blank cells instead of full rows and columns

Sometimes you just need to shift some data down your spreadsheet, without adding full new rows and
columns. Insert and Delete Cells can do just that, adding cells below or to the right of your existing selection.
Or it can clean up in the same way, removing that number of cells up or to the left of your selection.

Number Crunching

Spreadsheets are designed for math, and some of Google Sheets’ best add-ons make it better at statistics,
finance, predictions, and more. These add-ons can help you make better graphs and figure out what your
numbers mean.

Solver

to calculate and model your data


https://chrome.google.com/webstore/detail/add-rows-columns/bepdpnejbnandmmikaedhbmphflnbnmn
https://chrome.google.com/webstore/detail/crop-sheet/aojcceglbipehndciapjedoomockgagl
https://chrome.google.com/webstore/detail/remove-blank-rows-and-mor/gmidogdphchbiehdmbigdbcopkpjpnio
https://sites.google.com/site/swgapsp/products/remove-blank-rows-in-google-spreadsheet-sheet#TOC-How-long-is-the-free-trial-and-how-much-will-it-cost-
https://chrome.google.com/webstore/detail/insert-and-delete-cells/fnpojobhpldojabbdcoajjmboaallcmk?hl=en
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7
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1
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13
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The Solver set of add-ons have been a mainstay of statistics and analytics work for years, typically with their
Excel add-ons. Each of those tools are now available for Google Sheets, with XLMinder for statistical analysis,
Solver for linear programming and solution optimization, and Risk Solver to perform risk analysis with Monte
Carlo simulations.

Just install the add-ons, tell it how to model your data, and Solver will run the calculations on their servers
and send the data back to your Google Sheets spreadsheet. Most calculations will run in the free add-on, with
up to 1k Monte Carlo trials, and you can contact their team for paid options beyond that.

g(Math)

to plot math functions


https://chrome.google.com/webstore/detail/xlminer-analysis-toolpak/aolkkmkpomhckcckjbmnibeakmhdmflj
https://chrome.google.com/webstore/detail/solver/iennicjichkeiajiflbcmaaohildohpb
https://chrome.google.com/webstore/detail/risk-solver/adplhaemogmadjoincpagfcmmigkinpp
http://www.solver.com/solver-addon-google-sheets-help-and-support
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Spreadsheet graphs are designed typically to compare sets of numbers in bar and pie graphs—not for graphing
mathematical formulas. g(Math) adds this often-needed feature, with tools to both write formulas with LaTeX
formatting and plot them on an x|y axis.

It also includes a quiz tool to make personalized quizzes for students and grade them together inside your
spreadsheet. That makes g(Math) a perfect add-on for students and teachers alike.

BigML
to create predictions from data

&5 -~ ~ 7 5 % 0 00 123-  Aral - 10 - B I 5i, $. - H-EH - wMore - BigML x
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A B (=] o E F G H I 1

Iris* model

1 Sepal length sepal width petal length patal width species confidence
species
14 ] 3 16 0.2 1. setosa
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17 52 34 14 0.2 I setosa
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. ¥ J T Iris-setosa . : =
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29 6.3 33 4.7 16
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34 59 3 4.2 1.5 1. versicalor

35 6 22 4 1 1. versicolor - matthewg... at blg@ Lagout


https://chrome.google.com/webstore/detail/gmath-for-sheets/ghgaamjabigfohnmniiffhbfmkecanmi
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BigML brings machine learning to your spreadsheet, letting you fill gaps in your data in with predicted text
from your broader datasets. You’ll first add your data models to BigML, then install the add-on for Google
Sheets and connect it with your API key. Then run predictions on your spreadsheet data based on that model,
and it can predict missing values along with a confidence value.

It’s a powerful way to fill in scores, categories, and other broad data based on similarities in your data sets.

BigML Price: Free for 2 parallel tasks; from $30/month for paid plans with unlimited tasks starting at 64MB
each

DukeDeploy

to analyze data with R or Python

Want to code your own R or Python data models and use them with your spreadsheets? DukeDeploy is the
add-on you need. Create a model with your data, deploy it to DukeDeploy, then install the Google Sheets
add-on and run it against your datasets or add it to cells with the new =duke_predict() function. It can then
quickly make predictions from your data, calculating anything your models predict.

DukeDeploy Price: Free for 1 task per minute; from €0.20 per task with a paid plan

Sharing and Publishing

Now that you’ve gather data, organized and formatted it, and crunched your numbers, it’s time to share your
spreadsheets with the world. You could just save it as a PDF or hit Share—or you could turn it into an app or
add the data to your site with these tools.

MarkdownTableMaker

to make a Markdown table from a spreadsheet

& o~ T § % .0 .00 123-  Arial - 0 -~ B I 5 A. &-H-Ed- Mo - MarkdownTableMaker b4
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https://bigml.com/tools/bigml-gas
https://bigml.com/tools/bigml-gas
https://chrome.google.com/webstore/detail/dukedeploy/beeoblfimbohfhllocbgnajnijkomefj
http://www.dukeanalytics.com/docs.html
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If you typically write with Markdown formatting, MarkdownTableMaker is a handy tool. It can convert a
section of your spreadsheet—or the whole sheet—into a Markdown formatted table.

It makes the first row the header, and only includes the plain text—no formatting, links, or images are included.
If those are needed, just write your spreadsheet cells with Markdown-style links and formatting first.

AppSheet

to turn your spreadsheet into an app

AppSheet y Myapps Sampleapps Account Support More info »
i Info Tables Column Structure Slices
A Preview other device sizes
Data p—
= n ECommerce Store Q
& Ux
RowNumbe e
i Behavior
Users
= B‘ Buy Url
@& Manage
Blue Beauty Kum...  Turquoise and BI...
4 rgl -
Share it!
. ;
é ) Ep‘ DESCRIPTION LongText
Deploy it!
S - Seattle Seahawks... Deep Red and Sil...
Copy app (& e Price
Q, Learn| Ask i
'- - ~ - fast
Share Showcase Sync
@‘ Text

AppSheet makes building a new mobile app as simple as adding your data to a spreadsheet. Just list all of your
data—contacts, products, inventory, property, or anything else you need to track in an app—to a spreadsheet,
and connect it to AppSheet.

There, you can customize the columns that are displayed, pull in images from Dropbox and other file storage
apps, chart locations on maps, and tweak its design to fit your branding. You can even add forms to gather
text, images, and signatures on the go for a full mobile data collection tool built around your spreadsheet.

AppSheet Price: Free to develop apps; once published, from $1/month per user for paid plans for unlimited
apps and core features

Sheetsu

to build an API from your spreadsheet


https://zapier.com/blog/beginner-ultimate-guide-markdown/
https://chrome.google.com/webstore/detail/markdowntablemaker/cofkbgfmijanlcdooemafafokhhaeold?hl=en
http://www.appsheet.com/apps-from-google-sheets-and-forms
https://zapier.com/zapbook/dropbox/review
https://zapier.com/learn/ultimate-guide-to-forms-and-surveys/best-data-collection-apps/
https://www.appsheet.com/Pricing
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M Save name
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Want to build your a custom app from your spreadsheet or connect it to other apps with an API? Sheetsu can
do just that. Just enter a Google Sheets spreadsheet link, and it’ll turn your spreadsheet into an API.

You can set your API permissions to allow GET, POST, DELETE, and/or PUT/PATCH to view or add data to your
spreadsheet through the APIL That way, your apps can either get new items you add to your spreadsheet
automatically, or they can dynamically update and add new entries to your spreadsheet.

Sheetsu Price: Free for 1 API and 300 requests per month; from $8/month for paid plans, which add more
APIs and requests per month

Tip: Learn more about APIs with Zapier’s free eBook, An Introduction to APIs.

Export Sheet Data

to turn your sheet into XML or JSON data

Want to import your spreadsheet data into an app that doesn’t support .csv files? Export Sheet Data is the
tool you need. It’ll turn your data into XML or JSON files, for a simple way to create structured data without
having to hand-edit code.

This comes in handy if you want to import your spreadsheet to your wiki in JSON format or need to import
your data into a database that doesn’t support .cvs.


https://sheetsu.com
https://sheetsu.com/pricing
https://zapier.com/learn/apis/
https://chrome.google.com/webstore/detail/export-sheet-data/bfdcopkbamihhchdnjghdknibmcnfplk?hl=en
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Email and Communication

Spreadsheets are also a great tool for sending personalized messages to an entire email list or managing your
outreach. Google Sheets can handle your mass email needs—with these add-ons.

Yet Another Mail Merge

to import contacts and send template messages

= ﬁ Yet Another Mail Merge DOCUMENTATION FEATURE REQUESTS matthew.guay @zapier.com

Bilberry and Apple Orange mood

[T) UsE THIS TEMPLATE [T uSE THIS TEMPLATE

PPY NEW YEAR

Happy New Year Happy New Year 2016

IE] USE THIS TEMPLATE ra USE THIS TEMPLATE

Yet Another Mail Merge is a one-stop-shop to send emails based on templates to your contacts. It can first
import contacts from Google Contacts or Salesforce into your spreadsheet. Then you’ll need an email template
in Gmail, which you can either make from one of Yet Another Mail Merge’s pre-made graphical templates or
can hand-design using <<fields>> to merge in names and other info.

Save that template as a draft email in Gmail, then run Yet Another Mail Merge, and it can send personalized
emails to everyone on your spreadsheet. Have it send you a test message to make sure everything looks perfect,
schedule message sending for later, and track opens and clicks in one place.

Yet Another Mail Merge Price: Free for 50 emails per day; from $24/year for paid plans, which add scheduled
delivery and sending up to 400 emails per day

Note: Don’t delete your template draft email from Gmail, as Yet Another Mail Merge will need
that draft again every time you send emails from your spreadsheet.

Gmail Scheduler

to use a spreadsheet to schedule emails


https://chrome.google.com/webstore/detail/yet-another-mail-merge/mgmgmhkohaenhokbdnlpcljckbhpbmef
https://zapier.com/zapbook/google-contacts/review
https://zapier.com/zapbook/salesforce/review
https://sites.google.com/site/scriptsexamples/available-web-apps/mail-merge/pricing
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Gmail Scheduler does exactly what it says: schedule your Gmail emails. Write your emails in Gmail—complete
with the recipient and any formatting or attachments you want—and save them as drafts.

Then open a Google Sheets spreadsheet and open the Gmail Scheduler add-on. Choose the draft email from
the drop-down, pick a time for it to be sent, and click Schedule. It then logs the time and other details about
scheduled messages to the spreadsheet so you can look back to see what’s been sent.

Gmail Scheduler Price: Free for core features; $29.99 for the Premium version to send emails on a schedule

or write recurring emails.

Mail Merge with Attachments

File

Edit View Insert F

Select File Attachment(s)

*.pdf

Oba
- Name

Daily

l 9 160401_Contently_Ebook_Methodology_FINAL v2.pdf

& “rieq

6 Gro

U iual = timelog.pdf

8 eve

§ A

= Mcll O  AutoCrat 3.0 Help

10 Roeal

LL Sche

12 O  [32216] CloudConvert
O  How Zapier Writes Books

Cancel

Comments

Last modified

May 31,2016

Apr 27,2016

Jun 17,2016

Mar 23, 2016

Aug 12,2015



http://www.labnol.org/internet/schedule-gmail-send-later/24867/
https://gumroad.com/l/GA09
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Need to send files to a number of recipients? Mail Merge with Attachments lets you send any file in Google
Drive as an email attachment from within your spreadsheet. Import your Google Contacts—or list your own
emails—then select a file from Google Drive that you want to send to the list. You can even select different
files for each recipient, if you want.

Then, write a template plain text or HTML email—or choose an existing draft message in Gmail—and Mail
Merge will send the messages along with your file attachments. It even includes a companion HTML editor
to help you create an email template, if you’d like.

Mail Merge Price: Free for 50 emails per day; $29.99 for the Premium version to track and send 100 emails
per day with Gmail accounts or 1.5k emails per day with a paid Google Apps account

formMule

to send conditional emails

Insed formMule - Email merge utility

Set # of email template(s) and send conditions

How many unique email templates do you want to use?

2 S

Send conditions can be NULL, NOT NULL or a number or text value. Mo quotation marks needed
Email template Send Condition

Orange if Company — = Zapier

Blue if  Company = = Microsoft

Back Save template settings

Need to vary your email for different types of recipients? formMule’s the email add-on you need. You can add
up to 15 template emails, with conditions for which one to send—perhaps to send a different email to those
who’ve purchased different products from your company.

Templates can be HTML or plain text and can include any of your spreadsheet fields for personalization.
There’s even a language field to automatically translate the email, if you want, and a scheduler to send emails
automatically when a form is filled out or on a timed schedule.

And, as a bonus, it also adds new =RANGETOTABLE() functions to Google Sheets which can turn your
spreadsheet data into an HTML table in a click. That’s much simpler than merging cells and hand-coding
HTML tables from your spreadsheets.


https://chrome.google.com/webstore/detail/mail-merge-with-attachmen/nifmcbjailaccmombpjjpijjbfoicppp?hl=en
http://ctrlq.org/html-mail/
https://gum.co/GA01
http://cloudlab.newvisions.org/add-ons/formmule
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Build Your Own Google Sheets Add-ons

Still haven’t found the spreadsheet tool you’ve been looking for? Don’t worry. With just a bit more work, you
can build your own Google Sheets add-ons, either with some code or with pre-made Zapier integrations.

Here’s how:

With Google Apps Script

Untitled project
File Edit View Run Publish Resources Help

[ . o 0 o P &  myFunction
B Code.gs * Code.gs
function createHeaders()
var ss = SpreadsheetApp.getActiveSpreadsheet();

var sheet = ss.getSheets()[e];

Freezes the first row

.setFrozenRows(1);

» of cells

var range et.getRange("A1:F1");

£/ Call the setValues method on range and pass in our values
range.setValues(values);

If you’ve ever written JavaScript code—or have a some time to learn the basics of code—you can create your
own full-featured Google Sheets add-ons, and even publish them to the Google Sheets Add-Ons Gallery if
you’d like. All you need is the Script Editor, tucked away in the Tools menu in Google Sheets.

There, you can write JavaScript-based scripts to add custom menus, sidebars, and functions to Google Sheets.
For a quick guide to getting started, jump to chapter 7 for Zapier’s Google Apps Script Tutorial with step-
by-step instructions on adding header rows, organizing contacts, and sending automated emails from Google
Sheets with your own handwritten scripts. Or use Google’s own Scripts Guide, which teaches you how to
build a quick add-on for customized spreadsheet forms. And if you have existing Excel VBA macros you
want to use in Google Sheets, this guide from Bruce Mcpherson will help you learn how to convert them.

Want to share your new extension with others? You can simply share the script code or publish the add-on to
Google Apps to share it-with just your team or with any Google Sheets user.

With Zapier

For a simpler option, use an app integration tool like Zapier to build connections to your favorite apps and do
work in your spreadsheets automatically. Zapier can watch your Google Sheets account for new spreadsheets,
worksheets, or new and updated rows. It can also search spreadsheets for existing data, as well as add and
update rows in a spreadsheet. Zapier can then copy data to and from your spreadsheet and the other apps you
use for a seamless workflow.


https://zapier.com/learn/google-sheets/google-apps-script-tutorial/
https://developers.google.com/apps-script/
http://ramblings.mcpher.com/Home/excelquirks/gooscript
https://developers.google.com/apps-script/add-ons/publish
https://developers.google.com/apps-script/add-ons/publish
https://zapier.com/
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Here are some of the most popular Google Sheets integrations.

Zapier Integrations:

+ Create Google Calendar events from new Google Sheets spreadsheet rows
« Create Trello cards from new Google Sheets spreadsheet rows

« Send a Gmail email for new Google Sheet spreadsheet rows

« Save Twitter mentions to a Google Sheets spreadsheet

+ Post a new message to Slack whenever a Google Sheets row is updated

Or check out Zapier’s Google Sheets Integrations page for other popular options.
You can also create a custom integration for Google Sheets and your other favorite apps and services.
Say you want to save eBay sales from PayPal to a Google Sheets spreadsheet, and then print out an invoice

from that data with Google Cloud Print. You could do all that with a Zapier integration.

Dashboard — SetUp Filter Options F e YOURZAP IS @) OFF

Sales Records

@ TRIGGER

& s
' 1. Successful Sale v N

Set up Filter by Zapier Only continue if...
+
Only continue if... (required
FILTER vl W Exist N
2. Only continue if... b
AND

.o + OR

ACTION

3. Date / Time hd < Refresh Fields
¢

ACTION

B Get Help

Start out with a PayPal Successful Sale trigger, and add a filter to watch for eBay sales. Perhaps add a Formatter
action to convert the date from05:53:24 Jun 1, 2016 PST to an easier-to-read format like Wednesday, June
1st, 2016.


https://zapier.com/app/min/138/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/124/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/133/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/135/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/1538/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/zapbook/google-sheets
https://zapier.com/help/formatter/
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Dashboard — Set Up Create Spreadsheet Row Template 8 YOUR ZAPIS @ OFF
P step 1 Payer Email o
ACTION
, buyerid (sptiona
3. Date/ Time i B buyer
P siep 1 PayeriD Zo
+
B fee
ACTION ;_G
b
4. Create Spreadsheet Row v Q fee

() P Successful Sale

+
Mc Fee
ACTION
Payment Fee
= 5. Submit Print jJob A
Raw lpn Body
@ Only continue if...
+ Complete step 2 to insert fields from Only continue if....
(G) = patesTime
B Get Help

Iél |

Now, let’s save that sale data to your spreadsheet. Just make a new Google Sheets spreadsheet for your sales,
and add columns for your customers’ name and email, the item they ordered, PayPal’s fees, and anything else
you’d like to track. Then, add a Google Sheets Create Spreadsheet Row action to the Zap, clicking the + icon
beside each spreadsheet row to add the correct data from PayPal.

Dashboard — Set Up Submit Print job Template F e YOURZAP IS @) OFF
ACTION 2 . S il = F L S oy
Set up Google Cloud Print print job
= 3. Date / Time v
= Content (required)
+
ACTION
=] 4. Submit Print Job -~
& Google Cloud Print Dear P Step 1 FirstName P Step 1 LastName | Zo
4 Submit Print Job
Thank you for purchasing | Step 1 Item Name1  from our store on
& Google Cloud Print Account ...
= Set Up Template Q
@ P successful Sale v
X Delete O Only continue if... v
@ Date / Time o
+ Payment Date
Missing choices? Re-test step 3.
W GetHelp Resy

Then, setup your printer with Google Cloud Print, and add a Cloud Print action to your Zap. Type in the text
you want to print out in your shipping invoice, and click the + icon on the right to add items from your sale
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to the text.

Repeat those steps for anything else you’d your Google Sheets integration to do, and within minutes you’ll
have your spreadsheet connected to your favorite apps, formatting text and sorting data the way you want.

How to Work Offline in Google Sheets

i=j| [Testsheet I

File Edit View RO il Data Tools Form Help
e~ ~ T $ % .0_ .00 123- SourceCo.. - 12 - B 7
Order
A B c D
1 |Order lName Precise Category
2 1 Google Sheets Spreadsheets
3 2 Trello Project Management

For all of the great features add-ons bring to Google Sheets, there’s still one tiny thing where it still has a
disadvantage to Excel: working offline. As a web app, Google Sheets runs in your browser and only works
when you’re offline.

That is, unless you install the Google Sheets Chrome extension, which comes pre-installed with most copies
of Chrome. Once it’s installed, you’ll need to enable offline mode for it to work.

While you’re online, just open your Google Drive settings (under the gear icon at the top right of the page),
and check the box beside Sync Google Docs, Sheets, Slides & Drawings files to this computer.


https://chrome.google.com/webstore/detail/google-sheets/felcaaldnbdncclmgdcncolpebgiejap?utm_source=chrome-ntp-icon
https://drive.google.com/drive/settings
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Settings

1G0T SU U Used
Upgrade storage
General

Natifications
Convert uploads Convert uploaded files 1o Google Docs editor format

Manage Apps

Languaga Change language settings

~ Sync Google Docs, Sheets, Slides & Drawings files 1o this computer so that you can

edit offline
Mot recemmended on public o shared computers. Leam mare

Density Comfortable =
Create a Google Photos folder Automatically put your Google Photos into a folder in My Drive

Privacy & Terms

Give it a few minutes, then open the spreadsheet you need to work on and it should continue to be editable
when you’re offline. In fact, you can open Google Drive while offline just by entering drive.google.com in
Chrome’s address bar, then select any of your recent documents to open and edit them.

There’s only one catch for both Sheets offline: All add-ons are disabled while offline. So, you can edit and
view your documents and spreadsheets, but will need to wait until you’re back online to use add-ons to format
text, gather data, and more.

Tip: A similar trick works on Google Sheets” mobile apps, too. Just install the Google Sheets app
on your iOS or Android device, open its settings, and select Make recent files available offline to
view or edit them when you’re not connected to the internet.

Go Make Google Sheets Your Own!

Spreadsheets aren’t just meant to be good tools for a wide range of tasks—they’re often the best tool for certain
types of tasks. Take a few minutes to install versatile and powerful Google Sheets add-ons to make it your
perfect digital sidekick.

Or, maybe it’s time to build your own add-ons instead. You’ll learn how to do that with Google sheets in the
next chapter, with detailed tutorials on how to format spreadsheets, create contacts, and send emails right
from your spreadsheet with custom code that works the way you want.

Enjoy? Read and share this chapter online: zpr.io/uB9F

Written by Zapier content marketer Matthew Guay.


http://zpr.io/uB9F
https://twitter.com/maguay

Chapter 7: Automate Google Sheets—An
Introduction to Google Apps Script

Google has built some of the most effective productivity tools on the planet. With Gmail, Hangouts, Chrome,
Docs, Sheets, and more, odds are you use Google products for at least some of your work. There’s also a good
chance, though, you’re missing out on one of Google’s most powerful tool: Google Apps Script.

Apps Script lets you build powerful add-ons for Google Apps with snippets of JavaScript code. Take a few
minutes to code a script, and you can mold apps like Gmail, Google Sheets, and Google Drive into custom
tools for your business. A script could, for example, automatically send email thank-yous with Gmail and a
Google spreadsheet, or automatically add new people from a spreadsheet to Google Contacts. (Don’t worry:
We’ll cover both of those examples in-depth.)

To start, let’s cover the basics of Apps Script and how you can start using it—even if you’re not a developer
or have only limited JavaScript experience.

Tip: If you're new to Apps Script, be sure to check out Google’s documentation in addition to
this guide. Google does a terrific job of laying the groundwork, so it’s a great place to start. Then
come back here to build your own add-ons.

Getting Started with Google Apps Script

There are two main types of scripts you can use with Google Apps: standalone and bound scripts.
1. Standalone scripts
Standalone scripts are not attached to any particular app in your Google account. Instead, think of them as

macros that perform system-wide functions.
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https://developers.google.com/apps-script/
https://developers.google.com/apps-script/
https://developers.google.com/apps-script/guides/standalone
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A standalone script could search your Google Drive for all items with the name ‘untitled’ (the default name
Google gives to files when the name isn’t specified), for example, as a handy way to keep your Google Drive
clutter-free.

You’ll see standalone scripts alongside your other Google Drive files, and each file contains JavaScript for
your particular function.

2. Bound scripts

Bound scripts extend the functionality of a certain file in one of your Google apps. They perform specific
actions directly to that particular file.

For example, you could create a script bound to a specific Google Sheet that checks for and removes duplicate
rOws.

Insert Format Tools Table Add-ons Help  Last edit was 12 minutes ago

100% - Normal text - Arl

[}
]
(il
i
]
i

Do more with Docs
Looking for even more Docs
features? Get a few add-ons.

Get add-ons...

Google lets you publish both standalone and bound scripts for others to use. In fact, the “Add-ons” menu in a
Google Docs document includes dozens of scripts—to translate your document, format tables, add formulas
and more—that have been converted into extensions and shared by others.

This chapter’s tutorials will focus on bound scripts—the most common ones in the Google Docs Add-ons
menu. First, let’s get our feet wet by building a simple bound script that fills in header values in a spreadsheet
automatically.

Building your First Script

To get started, visit sheets.google.com and create a new sheet. Under the “Tools” menu in your new sheet,
click the option for “Script editor...”


https://developers.google.com/apps-script/reference/drive/drive-app#searchFiles(String)
https://developers.google.com/apps-script/guides/bound
https://developers.google.com/apps-script/articles/removing_duplicates?hl=en
https://developers.google.com/apps-script/articles/removing_duplicates?hl=en
https://docs.google.com/document/create?addon_store
https://sheets.google.com
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= Untitled spreadsheet |
File Edit View Insert Format Data Tools Add-ons Help  All changes saved in Drive
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That’ll open a new tab with a blank script file: the Script Editor. It’s an easy way to create both standalone
and bound scripts without leaving Google Apps.

In this case, since we opened a new sheet first and then opened the Script Editor, we’re creating a bound script;
when we run it, the script will only affect the new file we opened. By contrast, standalone scripts are created
by visiting script.google.com directly.

When we open the Script Editor from within a Google document for the first time, it automatically creates a
new “Untitled project” for us. Let’s change that to something a bit more descriptive, like “Create Headers.”

Create Headers
File Edit View Run Publish Resources Help

ol ﬂO P @  myFunction -

B Codegs Code.gs
function myFunction() {

}

oW =

Now, it’s time to write a bit of code. On a basic level, Apps Scripts are a combination of JavaScript functions—
blocks of code designed to perform a certain task. Often there’s functions you can copy and use on your own
with minimal editing, which is what we’ll use here.

Google has given us a starting block that looks like this:

function myFunction() {

This will be the framework for our first function. Just like our project title, we want our function name to
describe what the code is actually doing. Let’s change the function name from myFunction to createHeaders,
since this script will be creating column headers for us.
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function createHeaders() {

Now, we need to put some code inside those culty braces (the { } characters you’ll notice after the function
name) that will make this function do what we want. To get this code, let’s head over to the documentation
for Google Sheets. This documentation tells you exactly how you can manipulate Google Sheets with Apps
Script.

If you scroll down, you’ll notice a method called setFrozenRows that we can use. If we’re setting up column
headers in the top row of the spreadsheet, it would be helpful to freeze that row so it’s always available, no
matter how far we scroll down. Google provides the following example:

var ss = SpreadsheetApp.getActiveSpreadsheet();
var sheet = ss.getSheets()[0];

// Freezes the first row
sheet .setFrozenRows(1);

Let’s copy that code and use it in our function:

function createHeaders() {
var ss = SpreadsheetApp.getActiveSpreadsheet();
var sheet = ss.getSheets()[Q];

// Freezes the first row
sheet .setFrozenRows(1);

Click the disk icon in the toolbar or press the Save keyboard shortcut (Command+S on a Mac or Ctrl+S on
Windows) to save the project. Now, it’s time to run the function. In the toolbar, you should see a play icon
just to the left of a menu item with the function name we set (createHeaders). For now, we only have one
function to run. However, if you had multiple functions in your code project, you could individually select
the function you want to run.


https://developers.google.com/apps-script/reference/spreadsheet/sheet
https://developers.google.com/apps-script/reference/spreadsheet/sheet
https://developers.google.com/apps-script/reference/spreadsheet/sheet#setFrozenRows(Integer)
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function createHeaders() {
var ss = SpreadsheetApp.getActiveSpreadsheet();
var sheet = ss.getSheets()[e];

1

2

3

4

5 // Freezes the first row
6 sheet.setFrozenRows(1);
8

Click the play icon to run the function. You’ll be prompted with some authorization dialogue, but once you
authorize the script to run, jump back to your Google Sheet. The first row should be frozen!

= Untitled spreadsheet |
File Edit View Insert Format Data Tools Add-ons Help Al changes saved in Drive
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Now, we need to extend our function to actually set the values of the header row. To do that, let’s go back to
the Google Sheets documentation to find some more code.

We need some way to set the values for a particular range of cells. On the left-hand side of the Google Sheets
documentation, under “Classes”, you’ll notice we have a Range class.

Clicking on that reveals a selection of methods we can use on a specific range of cells. If you scroll down a
bit, you’ll find setValues(values), which inserts a set of values into a range; that seems to match what we
need! Here’s a portion of the example provided:


https://developers.google.com/apps-script/reference/spreadsheet/
https://developers.google.com/apps-script/reference/spreadsheet/range
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var ss = SpreadsheetApp.getActiveSpreadsheet();
var sheet = ss.getSheets()/0];

// The size of the two-dimensional array must match the size of the range.
var values = [

[ "2.000", "1,000,000", "$2.99" ]
1;

var range = sheet.getRange("B2:D2");
range.setValues(values);

For a non-engineer, that’s a lot of code! Here’s the part we’re most interested in:

var values = [
[ "2.000", "1,000,000", "$2.99" ]
1

var range = sheet.getRange(“B2:D27);
range.setValues(values);

This might look a bit foreign if you’re not familiar with JavaScript, but in short, the code creates two variables.

« Values, set by var values = stores the values 2.000, 1,000,000, and $2.99.
* Range, set by var range = stores the range of cells B2 to D2 based on the sheet we’re working with.

From there, we can call the setvValues method on the range variable we set and give it the values variable. This
tells our function to assign our Values (2.000, 1,000,000, and $2.99) to the cells defined in Range (B2 through
D2).

Instead of adding random numbers to our spreadsheet, let’s say we wanted to create a contact list. We might
want the following headers:

« First Name

« Last Name

+ Email

« Phone Number

« Company

«+ Notes (Where did we meet this person? Is there anything special we need to remember?)

These would be our ‘values’. Since there are six different values, our ‘range’ needs to be six cells wide (like
A1:F1). We also want to use the first row of the spreadsheet.

After updating example code and changing the range and values, add it to your createHeaders() function.
You should end up with something like this (the // denotes a comment, so you can make inline notes about
what your code is supposed to do):
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function createHeaders() {
var ss = SpreadsheetApp.getActiveSpreadsheet();
var sheet = ss.getSheets()/0];

// Freezes the first row
sheet .setFrozenRows(1);

// Set the values we want for headers

var values = [
["First Name", "Last Name", "Email", "Phone Number", "Company",
"Notes" |

1;

// Set the range of cells
var range = sheet.getRange("A1:F1");

// Call the setValues method on range and pass in our values
range.setValues(values);

If we run the function again and flip back over to our spreadsheet, we should see the values set in the header
row
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Exploring the Power of Google Apps

Typing in the header values for a Google Sheet isn’t that much work, so that script isn’t the most valuable
unless you setup a lot of new spreadsheets. But, Google Apps Script can do so much more. Here are two
additional examples to play around with.
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Example 1: Automatically Add Contacts From a Google Sheet

Let’s say we had a contacts spreadsheet set up like the example above, with columns for first name, last name,
and more, as an easy way to keep track of everyone we met at networking events and conferences. We can
actually use Apps Script to automatically turn these rows into Google Contacts so we can connect with them

again later.

Here’s the basic spreadsheet setup:

—
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First Name Last Name Email Phone Number Company Notes

John Doe John@mycompany.com 333-333-3333 My Company  Met John at a conference on JavaScript. He works at My Company as the Lead Developer.

Now, we could use a function like this to add the contacts to Google Contacts:

function createContact() {
var alreadyAdded = "Already added";
var sheet = SpreadsheetApp.getActiveSheet();
var startRow = 2; // First row of data to process
var numRows = 2; // Number of rows to process

// Fetch the range of cells A2:G3
var dataRange = sheet.getRange(startRow, 1, numRows, 8)

// Fetch values for each row in the Range.
var data = dataRange.getValues();

for (var i = Q; i < data.length; ++i) {

var row = data[i];

var firstName = row[Q]

var lastName = row[1]

var emailAddress = row[2]

var phone = row|

3]
var company = row([4]
var notes = row[5]

[
var addedAlready = row[6];
if (addedAlready != alreadyAdded) {
// Create contact in Google Contacts

var contact = ContactsApp.createContact(firstName, lastName, emailAddress);

// Add values to new contact

Tim Smith Tim@notmyemail.com 444-444-4444  Not My Email Met Tim through Tony and had lunch at Panera Bread. He's working on software to prevent email spam. Already added
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contact.addCompany (company, "");
contact.addPhone(ContactsApp.Field.WORK_PHONE, phone);
contact.setNotes(notes);
sheet.getRange(startRow + i, 7).setValue(alreadyAdded);
¥
}
)

While the code above looks much more complex, we're actually doing many of the same things we did in the
original example.

First, we define a range of cells using dataRange. Then, we look at each one of those cells and grab the
associated value for each property (first name, last name, etc).

Now, we can use some methods provided by the Google Contacts documentation to create a contact and give
it the right values. In this example, we also have a check in place to make sure a contact isn’t added twice; for
that, we use alreadyAdded. When you run this code, you should get some contacts added automatically from
your spreadsheet!

Contacts Az @

ZapierTest(2) # W

4 g Jeremey DuVall
John Doe John@mycompany.cam 3333333333 My Company
All contacts Tim Smith Tim@notmyemail com 444-424-2424 Not My Email
Frequently contacted
Groups
Zapier Test
New group
Circles

Find duplicates

More

Add Contacts from Google Sheets to a CRM using Zapier Instead

Google Apps Script helps you automate processes within a specific tool and create connections between your
Google apps. But if you want to avoid JavaScript troubleshooting, or send data from Google Sheets to a non-
Google app, try Zapier. It can automatically pick up new information in a spreadsheet and transfer it to any
of 500 apps—no code required.

For example, you can build the same automation that we covered above, hooking Google Sheets up to Google
Contacts, or connect it to your favorite CRM app instead.

Zapier Integrations:

« Create Google Contacts from new Google Sheets rows
+ Add new Google Sheets rows as Highrise contacts


https://developers.google.com/apps-script/reference/contacts/
https://zapier.com/learn/ultimate-guide-to-crm-apps/best-crm-app/
https://zapier.com/app/min/1951/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/2834/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
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+ Add leads to Salesforce from new rows on Google Sheets
+ Create or update HubSpot contacts from new Google Sheets rows
+ Add new Google Sheets rows to Infusionsoft as contacts

Tip: Explore more ways to use Google Sheets with Zapier, or jump back to chapter 3 to how to
turn Google Sheets into a customized CRM.

Example 2: Automating Email Outreach

Let’s say you put on a massive event that was a huge success. You want to thank everyone individually, but
with over 200 guests you don’t have the time to email each of them. With Google Apps Script, Google Sheets,
and Gmail, though, you can automatically send out emails with custom messages for each person!

To set this up, we’ll want a spreadsheet with each contact’s first name and email address like this:
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1 First Name Email Message Email Sent

2 |Joe joe@notanemail.com

3 Ruth ruth@notanemail.com

4 Tim tim@naotanemail.com

5 Tom tom@notanemail.com
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Then, we can use a function like this to make the emails:

function sendEmails() {
var sheet = SpreadsheetApp.getActiveSheet();
var startRow = 2; // First row of data to process
var numRows = 4; // Number of rows to process

// Fetch the range of cells A2:D5

var dataRange = sheet.getRange(startRow, 1, numRows, 4)

// Fetch values for each row in the Range.
var data = dataRange.getValues();
var emailSent = "Email Sent";
for (var i = @; i < data.length; i++) {
var row = data[i];
var firstName = row[Q];
var emailAddress = row[1];
var isEmailSent = row[3];

if (isEmailSent != emailSent) {


https://zapier.com/app/min/930/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/4654/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/2230/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/zapbook/google-sheets/
https://zapier.com/learn/google-sheets/spreadsheet-crm/
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var message = "Hi " + firstName + "! Great seeing you last night.
Looking forward to connecting soon!";

var subject = "Great seeing you last night!";
MailApp.sendEmail(emailAddress, subject, message);
sheet.getRange(startRow + i, 3).setValue(message);
sheet.getRange(startRow + i, 4).setValue(emailSent);

This function starts off similar to the others by grabbing a range of cells in the dataRange variable. For each
row, it grabs the first name from the first column (the firstName variable) and the email address from the
second column (the emailAddress variable). Then, it builds a customized message in the message variable.

Once your script has a recipient, subject line, and message to work with, it taps into Gmail to send your
message. In the Apps Script documentation for Gmail, you’ll find the sendEmail class, which accepts the
variables emailAddress (your recipient’s email address), sub ject (the email’s subject line), and message (your
custom message).

The sendEmail class builds your email, and sends it to the appropriate address. Finally, this script adds the
customized message to your spreadsheet, and sets the value of the fourth column to “Email Sent,” to ensure
we don’t send duplicate emails.

(] More 1-40f 4
£ Prima a  Soci ® i
ry 2a Social W Promotions +
me Great seeing you last night! - Hi Tom| Great seeing you last night. Looking forward to connecting soon!
me Great seeing you last night! - Hi Tim! Great seeing you last night. Looking forward to connecting soon!
me Great seeing you last night! - Hi Ruth! Great seeing you last night. Looking forward to connecting soon!
me Great seeing you last night! - Hi Joe! Great seeing you last night. Looking forward to connecting soon!

In the example above, I changed the test emails in the spreadsheet to my actual email, which is why all of
the emails arrived in the same inbox. When you run this script on your own spreadsheet, though, it’ll send
emails to each of the contacts you’'ve added to the spreadsheet.

Use Zapier to Send Emails via Google Sheets

If you use a different email service provider, or you just don’t want to build new JavaScript blocks for each
batch of follow-ups, try using these Zaps to connect Google Sheets to the email app of your choice.

Zapier Integrations:

+ Send a Gmail email for new Google Sheet spreadsheet rows
« Send Office 365 emails from new rows in Google Sheets


https://developers.google.com/apps-script/reference/gmail/gmail-app
https://developers.google.com/apps-script/reference/gmail/gmail-app#sendEmail(String,String,String)
https://zapier.com/app/min/133/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/4982/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
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+ Send Mandrill emails when new rows are added to Google Sheets
+ Send new Google Sheets rows through SMTP emails
+ Send SendGrid emails from new Google Sheets rows

What else can you do with Google Apps Script?

Your imagination is the only limit on what you can achieve with Google Apps Script. Here are some of my
favorite examples:

Jame Todd Rubin created a writing tracker script you can copy from GitHub.

+ Google has an example script that generates a monthly report of your Gmail activity (daily usage, emails
received, etc).

« Gmail Snooze allows you to move emails out of your inbox for a specified period of time thanks to an
Apps. Then, they’ll reappear in your inbox so you can deal with them when appropriate.

« Amit Agarwal made a website monitor with Google Docs so you’ll immediately receive alerts if your

site goes offline.

There’s hundreds of other things you can do with Google Apps Scripts—your imagination’s the limit. The best
way to get started is to review the documentation and start tinkering away. As you get more familiar with
the methods and attributes available to you, you’ll start to realize just how much is possible—often without
writing any extra code.

Or, if you don’t want to mess with JavaScript, let Zapier do the heavy lifting for you. With dozens of Google
Sheets automations that pass data between your apps, Zapier transforms the examples we covered above into
a few simple clicks, making each integration painless.

You've done it: if you’ve followed along with this entire book, you’ve learned spreadsheet basics, built a CRM
and business dashboard, learned about Google Sheets’ hidden text tools and best add-ons, and now have
learned to code your own add-ons with Google Apps Script.

Where can you go from here? In the closing chapter, we’ll take a quick look at some of Zapier’s best resources
to help you organize your files, gather data, and more—along with the best Google Sheets resources to find
the spreadsheet tools you need in seconds.

Enjoy? Read and share this chapter online: zpr.io/uB95

Written by freelance writer Jeremey DuVall.


https://zapier.com/app/min/2893/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/4760/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
https://zapier.com/app/min/4783/start?embedded=true&utm_source=widget&utm_medium=embed&utm_campaign=Widget&referrer=None
http://www.jamierubin.net/2013/07/11/my-google-writing-tracker-scripts-now-available-on-github/
https://github.com/jamietr1/google-docs-writing-tracker/blob/master/README.md
https://developers.google.com/apps-script/articles/gmail-stats
http://googleappsdeveloper.blogspot.in/2011/07/gmail-snooze-with-apps-script.html
http://www.labnol.org/internet/website-uptime-monitor/21060/
https://zapier.com/zapbook/google-sheets/
https://zapier.com/zapbook/google-sheets/
https://zapier.com/learn/google-sheets/google-sheets-tutorial/
https://zapier.com/learn/google-sheets/spreadsheet-crm/
https://zapier.com/learn/google-sheets/google-sheets-dashboard-tutorial/
https://zapier.com/learn/google-sheets/spreadsheets-for-writers/
https://zapier.com/learn/google-sheets/best-google-sheets-addons/
http://zpr.io/uB95
https://twitter.com/JeremeyD

Chapter 8: Extra Resources to Manage Your
Spreadsheets

If you've read each tutorial in The Ultimate Guide to Google Sheets, you're ready to do almost anything you
want with your spreadsheets. But sometimes, you’ll still want a little extra advice and help.

For that, here are some of the best resources to help you continue learning about spreadsheets and use them
alongside other apps for a powerful business workflow.

Google Sheets’ Getting Started Guide

Go g|e Search Google Docs editors Help =0

Docs editors Help DOCSEDITORS 3] HELP FORUM

Get started with Google Sheets

Create a spreadsheet
Edit and format a spreadsheet
Use the Google Sheets app for Android

Use the Google Sheets app for iPhone & iPad

Share this: @ n n

£2016 Google - Privacy Policy - Terms of Service English 3

It’s simple and basic, but it’s the official Google Sheets documentation, and it’ll answer any questions you
have about your spreadsheets and other Google Docs tools.

Best of all, it’s built into Google Sheets. If you ever get stuck in your spreadsheets, just click Help -> Sheets
Help to open a floating pane with this documentation right inside your spreadsheets.
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https://zapier.com/learn/google-sheets
https://support.google.com/docs/topic/20322?hl=en&ref_topic=2811806
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Google Sheets’ Functions List

Operator

Google spreadsheets function list

Google spreadsheets function list Ao

CONCAT
Google Spreadsheets supports cell formulas typically found in most desktop spreadsheet packages. These formulas can

be used to create fi i that ip data and strings and numbers. DIVIDE

Here's a list of all the functions available in each category. When using them, don't forget to add quotation marks around
all i made of alp! i that aren't referring to cells or columns.

Narrow by... 2

F h a few key 5 ...
S

ARRAY CONSTRAIN(input Constrains an array resultto
Array ARRAY_CONSTRAIN _range, num_rows, a specified size. Learn more
num_cols) ]

MINUS

MULTIPLY
Calculates the frequency

FREQUENCY (data, distribution of a one-column

classes) array into specified classes. POW
Learn more £

NE
FREQUENCY

UMINUS
Given partial data about an
exponential growth trend,
fits an ideal exponential UPLUS
growth trend and/cr
predicts further values.
Learn more 4

UNARY_PERCENT
GROWTH(known_data_y,
known_data_x,

new_data_x, b)

Given partial data about a

Looking for a specific function you can’t quite remember? This is the tool for you. It’s a complete list of every
function in Google Sheets, complete with a search field and filters to drill down and find the type of function
you need.

Each function includes its own documentation page, too, with examples to help you start using the function
quickly.


https://support.google.com/docs/table/25273?hl=en
https://support.google.com/docs/table/25273?hl=en
https://support.google.com/docs/table/25273?hl=en
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Google Sheets’ Add-ons Guide

0 Google Apps Script i= All Products O

HOME GUIDES REFERENCE SAMPLES SUPPORT SEND FEEDBACK

Ovenven Quickstart: Add-on for Google Forms

Set itup
Try it out
5-Minute Quickstarts Complete the steps described in the rest of this page, and in about ten minutes you'll have created a publish
Add-on for Google Docs Google Forms add-on that uses triggers to send an email when a user responds to the form, To see L s
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Macros and Custom Functions add-ons store,
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Want to build more advanced add-ons? Google has Apps Script guides to help you build Forms and Sheets
add-ons like the ones you built in chapter 7.

The first tutorials help you get customized notifications from Google Forms, read data from a spreadsheet,
and build custom menu items in Google Sheets.


https://developers.google.com/apps-script/reference/spreadsheet
https://developers.google.com/apps-script/reference/spreadsheet
https://developers.google.com/apps-script/guides/sheets
https://developers.google.com/apps-script/quickstart/macros
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Find Alternate Spreadsheet Apps
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Want to try out some other spreadsheet apps—either for more features than Google Sheets offers, or for better
ways to make stylish sheets?

We’ve tried out the best spreadsheet apps available today, with a mix of web and native tools that you can
use to crunch numbers. There’s even an online version of VisiCalc, to see where it all started.


https://zapier.com/blog/best-spreadsheet-excel-alternative/
https://zapier.com/blog/best-spreadsheet-excel-alternative/
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Create Templates for Your Most-Used Spreadsheets

178

Tired of re-typing the same things over and over? This tutorial will teach you how to make templates for

anything you need, with sections on templated documents, spreadsheets, projects, and much more.
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Effectively Organize Your Files and Folders
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Now that you’re making spreadsheets for everything, you’ll need to keep them organized. In this Zapier guide,
you’ll learn the best strategies for organizing your files and folders.

Whether you’re storing your spreadsheets on your computer or just need to keep track of them in Google
Drive, the tips here will make sure you never lose a spreadsheet—or any other file—again.


https://zapier.com/blog/how-to-make-document-template/
https://zapier.com/blog/how-to-make-document-template/
https://zapier.com/blog/how-to-make-document-template/
https://zapier.com/blog/organize-files-folders/
https://zapier.com/blog/organize-files-folders/
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Back up All Your Files

) All files I
‘ Drive . .
Microsoft Powerpoint and 3 other formats

Files and folders
® |nclude all files and folders in Drive
Select files and folders

File formats
Documents Microsoft Word v
Drawings JPEG Image -
Forms Microsoft Excel -
Presentations Microsoft Powerpoint v
Spreadsheets  Microsoft Excel v

You’ll also want to make sure you have a backup of all your spreadsheets and other files, to make sure you
never lose anything important. In our backup guide, you’ll learn how to export all of your files from Google
Drive and other web apps, and how to create a full online backup of everything from your apps and devices.


https://zapier.com/blog/backup-everything/
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Learn how to Build Great Forms and Surveys

THE ULTIMATE GUIDE TO

Forms &

Surveys

#§ TAPIERCOM/LEARM zap?er

Ready to dig into another book? Our Ultimate Guide to Forms and Surveys will help you get the most out of
Google Forms by teaching you how to create effective forms, write unbiased questions in surveys, and use
forms to build apps for your business.

Or, check out the other books in the Zapier Learning Center for quick ways to learn about email marketing,
CRMs, remote work, and much more.

Thanks for reading!


https://zapier.com/learn/ultimate-guide-to-forms-and-surveys/
https://zapier.com/learn/ultimate-guide-to-forms-and-surveys/
https://zapier.com/learn
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